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Form No. 008-42104-00

WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials.
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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ASAP 2020 Chemi Manual Conventions
1.  GENERAL INFORMATION

Manual Conventions

This manual uses the following conventions:

Indicates important information pertinent to the subject matter.

Provides information that helps you to prevent actions that may cause 
personal injury.

Provides information that helps you to prevent actions that may damage 
the analyzer.

Blue words Indicate a link to additional information about the subject matter.
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Equipment Description ASAP 2020 Chemi
Equipment Description

The ASAP 2020 Chemi System consists of an analyzer and a computer, which enables you to 
enter analysis and report options.

The ASAP 2020 Chemi System analyzer contains two sample preparation ports and one anal-
ysis port. In-line cold traps are located between the vacuum pump and the manifold in both the 
analysis and the degas systems. 

The analysis furnace resides on an elevator. A removable shield to enclose the furnace is also 
included for safety purposes.

Gas Requirements

Analyses performed by the ASAP 2020 Chemi System analyzer require compressed gases. 
Gas bottles or an outlet from a central source should be located as near as possible to the 
analyzer.

Appropriate regulators that have been leak-checked and specially cleaned are required. Pres-
sure relief valves should be set to no more than 30 psig (200 kPag). Gas regulators are 
available from Micromeritics.

All gases should be of a purity of 99.999% or better.
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ASAP 2020 Chemi Equipment Description
Analysis Software

The ASAP 2020 Chemi analysis program is designed to operate in a Windows environment, 
providing a user-friendly interface for performing analyses and generating reports.

The ASAP 2020 Chemi System software monitors and controls the analyzer. It enables you to 
perform automatic analyses with just a few keystrokes, and collects and reports analysis data. 
You can choose from a variety of reports, which can be printed automatically after an analysis 
or stored and printed later.

The report system included in the software allows you to manipulate and customize reports in 
a variety of ways. Refer to Onscreen Reports, page 7-9 for details on the options available for 
reports. You can also zoom in on portions of the graphs or shift the axes to examine fine 
details. Scalable graphs can be copied to the clipboard and pasted into other applications.

To make it easier for you to obtain information, an electronic copy of the operator’s manual is 
included on the Help menu. This enables you to access information in just a couple of mouse 
clicks. 
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Specifications ASAP 2020 Chemi
Specifications

The ASAP 2020 Chemi System has been designed and tested to meet the specifications pro-
vided below.

Characteristic Specification

—————— PRESSURE MEASUREMENT ——————

Range: 0 to 950 mmHg

Resolution:

1000-mmHg Transducer 0.001 mmHg (Analysis system)
1 mmHg (Degas system)

   10-mmHg Transducer* 0.00001 mmHg

   1-mmHg Transducer**
   (optional for high stability)

0.000001 mmHg

Accuracy (Analysis system only):

   Includes nonlinearity, hysteresis, and nonrepeatability. Transducer manufacturer’s 
   specifications. 

   1000-mmHg Range
   10-mmHg Range*
   1-mmHg Range**
     

Within 0.15% of reading
Within 0.15% of reading
Within 0.12% of reading 

—————— VACUUM SYSTEM ——————

Vacuum Pump: Mechanical, two-stage, for analysis; optional for 
degas. Ultimate vacuum 5 x 10-3 mmHg. Dry 
pumps available for systems equipped with 
optional High Vacuum pump.

High Vacuum Pump
(if installed):

Less than 3.8 x 10-9 mmHg 

Ultimate vacuum measured by pump 
manufacturer according to Pneurop Standard 
5608.

Vacuum Pump Exhaust: Analysis: a 12.5-mm (1/2-in.) fitting is provided 
for the analysis pump to allow connection to a 
fume hood.
Degas:  An oil mist filter is provided.

* High Vacuum systems
**Micropore systems
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Characteristic Specification

—————— MANIFOLD TEMPERATURE TRANSDUCER ——————

Type: Platinum resistance device (RTD) 

Accuracy: + 0.02 ºC (by keyboard entry)

—————— DEGAS SYSTEM ——————

Temperature Range: Ambient to 450 ºC

Selection: 1 ºC increments

Accuracy: Within + 10 ºC of set point at thermocouple

Backfill Gas: User-selectable, typically helium or nitrogen

—————— SYSTEM CAPACITY ——————

Sample Preparation: 2 degas ports (optional)

Analysis: 1 sample port 

Total Operating Capacity: Up to two analysis units can be controlled 
independently by one computer

—————— SAMPLE TEMPERATURE CONTROL SYSTEM ——————

Temperature Range: 10º above ambient to 1100 ºC

Rate Selection: Heat ramp rate controllable from 0.1 to 100 ºC per 
minute to 600 ºC, 20 ºC per minute to 800 ºC, 
10 ºC per minute to 1000 ºC, 5 ºC per minute to 
1100 ºC.

Temperature Selection: 1 ºC increments

Accuracy: + 1 ºC of reading

Stability: + 0.1 ºC for 10 ºC above ambient to 50 ºC;
+ 0.6 ºC above 50 ºC  

—————— SAMPLE TUBE SIZE ——————

FlowthruTM sample tube stems are 1/2-in. (12.5-mm) OD with exhaust path for flow-
through preparation. Standard flowthru tubes are quartz for use up to 1100 ºC.
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Characteristic Specification

—————— ENVIRONMENT ——————

Temperature: 10 to 30 ºC storing or shipping; 
-10 to 55 ºc storing or shipping

Humidity 20 to 80% relative, noncondensing

—————— ELECTRICAL ——————

Voltage: 100, 115, 230 VAC +10%

Frequency: 50/60 Hz

Power: 700 VA, operating

—————— GASES ——————

Recommended: Helium for free-space measurement and flowing 
preparation. Oxygen and hydrogen for flowing 
preparation. Hydrogen, carbon monoxide, and 
others for analysis.

—————— PHYSICAL ——————

Height 99 cm (39 in.)

Width: 85 cm (33.5 in.)

Depth: 61 cm (24 in.)

Weight: 115 kg (250 lbs)

—————— COMPUTER ——————

Minimum requirements: Pentium 333 MHz computer (or equivalent)
CD-ROM drive
128 megabytes of main memory
1-gigabyte hard drive
SVGA monitor (800 x 600 minimum resolution)
Windows® 7, Windows XP Professional, and 
Windows 2000
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2.  INSTALLATION

This chapter contains instructions for the following:

• Unpacking and inspecting the equipment
• Installing the analyzer
• Installing the analysis program

Initially, your ASAP 2020 Chemi analyzer will be installed and verified for operation by an 
authorized Micromeritics service representative or a representative of a Micromeritics distrib-
utor. If your analyzer is moved to a different location in your laboratory, use the instructions 
provided in this chapter for reinstallation. 

Unpacking and Inspecting the Equipment

When you receive the shipping cartons, carefully compare the packing list with the equipment 
actually received while checking for equipment damaged during shipment. Be sure to sift 
through all packing materials before declaring equipment missing.

Lifting the Analyzer

The ASAP 2020 Chemi analyzer weighs 115 kg (250 lbs) and requires the use of two people to 
lift it from its shipping carton. One person should not attempt to lift the analyzer. With one per-
son on each side of the analyzer, lift it upright from its shipping carton. Place the analyzer on a 
table top of sufficient space.

Equipment Damage or Loss During Shipment

When equipment is damaged or lost in transit, you are required to make note of the damage or 
loss on the freight bill. The carrier, not the shipper, is responsible for all damage or loss. In the 
event of equipment damage or loss during shipment, contact the carrier of the equipment 
immediately.

Save the shipping cartons if equipment or parts have been damaged or lost. The 
inspector or claim investigator must examine the cartons prior to completion of the 
inspection report.

Use proper lifting techniques to prevent back injury.
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Equipment Return

Micromeritics strives to ensure that all items arrive safely and in working order. Occasionally, 
due to circumstances beyond our control, equipment is received which is not in working con-
dition. When it is necessary to return equipment (damaged either during shipment or while in 
use) to Micromeritics for repair or replacement, use the following procedure:

1. Pack the instrument in its original shipping carton if possible. If the original carton is 
unavailable, for a nominal fee, Micromeritics can provide another carton for your use.

2. Tag or identify the defective equipment, noting the defect and circumstances, if any, under 
which the defect is observed.

3. Referencing the sales order or purchase order, identify the date that the equipment was 
received.

4. Notify the Micromeritics Service Department of the defect and request shipping 
instructions. The service department will assign a Returned Materials Authorization 
(RMA) number. Write the RMA number on the outside of the shipping carton.

Failure to package your instrument properly may result in shipping damage.
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Setting Up the Analyzer

The ASAP 2020 Chemisorption System should be installed correctly and tested to ensure it is 
operating properly before actual analyses are attempted. Setup and checkout procedures are 
described in this section.

Installing the Vacuum Pumps

Two vacuum pumps are required for operating the ASAP 2020 analyzer; one for degas opera-
tions and one for analysis. A recessed cavity is provided on the rear side of the analyzer for 
placement of the vacuum pumps. The analysis pump (facing the rear of the analyzer) is on the 
left side and the degas pump on the right side. 

Two types of vacuum pumps are available, the oil-based vacuum pump and the dry vacuum 
pump. Typically the dry vacuum pump is used when a mass spectrometer is attached to the 
analyzer and for chemisorption analyses.

Oil-Based Systems

1. Remove the vacuum pump from its shipping carton. 

2. Prepare the alumina and oil vapor trap (refer to Replacing the Alumina in the Oil Vapor 
Trap, page 9-11), then install the trap onto the intake port of the vacuum pump.

Oil vapor traps reduce the amount of oil vapor that collects in the hoses leading to the 
instrument. 

3. Add fluid to the vacuum pump (refer to Inspecting and Changing Vacuum Pump Oil, 
page 9-8).

4. Install the vacuum pump exhaust filter (refer to Replacing the Vacuum Pump Exhaust 
Filter, page 9-6).

5. Place the vacuum pump onto its drip tray and slide into the right side of the vacuum pump 
cavity. Be sure the power cord is facing outward; do not connect the power cord to a 
power source at this time.

6. Connect the flexible tubing from the analyzer to the connector on the topside of the pump. 
The following illustration shows orientation of the vacuum pump and its components 
attached to the flexible tubing of the analyzer.
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Dry Systems

1. Remove the vacuum pump from its shipping carton. 

2. Slide the vacuum pump into the left side of the vacuum pump cavity. Be sure the power 
cord is facing outward; do not connect the cord to a power source at this time.

3. Connect the flexible tubing from the analyzer to the connector on the topside of the pump.

Hose Fitting

Flexible Tubing

Centering Ring

Oil Vapor Trap

Clamp

Centering Ring

Intake port

Clamp

The gases used are diluted substantially upon being released from the vacuum 
pumps. However, it may be desirable in some locations to provide a fume hood for 
added protection from hazardous gases and vapors released into the work area. For 
piping to the fume hood, use the supplied fittings and tubing to connect to the vacuum 
pump. Reference the following diagram.
2-4                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020 Chemi Setting Up the Analyzer
Remove outlet supplied 
with vacuum pump. Replace 
with items shown.

004-25059-00

004-28998-02

004-25069-00

350-32801-00
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Verifying Line Voltage Selection

Verify the line voltage as follows:

1. Slide the safety gate to the right.

2. Slide the voltage selection switch to the voltage position to suit the available power 
supply.

3. Slide the safety gate to the left.

Selecting the Computer Power Input

The power input selection on the computer must be set to match the input power source. The 
computer operates with either 100-120 VAC or 200-240 VAC at 50 or 60 Hz. Refer to the 
instruction manual supplied with your computer for instructions on selecting power input.

Do not connect the analyzer to the power source until the proper voltage selection is 
made. Doing so could result in electrical shock and/or damage to the assembly.

Safety gate

Do not connect the computer power cord to a power source until the proper voltage 
selection is made. Doing so could result in electrical shock and/or damage to the 
computer.
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Installing the Chemisorption Assembly and Furnace

The Chemi Port assembly consist of the following components:

• An exhaust solenoid valve with an O-ring fitting for the sample tube
• A cooling fan to prevent the valve and O-rings from overheating
• A sample temperature thermocouple

1. Locate the two bracket mounting holes on the elevator panel.

2. Insert the screws on the bracket into the mounting holes. Then turn the screws clockwise; 
tighten with a flat-blade screwdriver.

Bracket Mounting holes

Valve Fan connector

Sample Thermocouple connector

Gas Flow Meter connector

Chemisorption Port Assembly

Bracket Attachment screws
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3. Attach the fan cable to the Valve/Fan connector.

4. Attach the sample thermocouple cable to the Sample Thermocouple connector.

5. Attach the gas flow tubing to the Gas Flow Meter connector.

To Valve/Fan connector

To Sample Thermocouple 
connector

To Gas Flow Meter 
connector
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Attaching the Furnace

Attach the furnace as follows:

1. Place and center the furnace on the elevator.

2. Insert the furnace power cable into the Power connector; twist to lock into place.

3. Connect the furnace thermocouple plug to the Thermocouple connector.

4. Connect the cooling gas tube to the Cooling Gas connector.

5. A supply of dry, clean, house/compressed air should be available to attach to the furnace 
for cooling. The air pressure should be well regulated and adjustable at pressures less than 
20 psig at the outlet.

Make sure the supply gas is set at 5 psig (35 kPag). If the pressure is below 3 psig (20 
kPag) or above 10 psig (70 kPag), the furnace controller may not be able to control the 
stability of ramping, or may be unable to cool the furnace within a reasonable amount of 
time.

6. Connect a hose from the house/compressed air supply to the furnace cooling gas inlet 
located on the side panel of the analyzer. 

Cooling Gas connector

Thermocouple connector

Power connector

Do not allow the pressure to exceed 20 psig (140 kPag). Pressures higher than 20 psig 
may cause the internal tubing fittings to fail.
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Installing the Cold Trap Tubes

The glass cold trap tubes are supplied with the accessories. Install them as follows:

1. Loosen the nut and O-ring.

2. Slide the glass tube up around the metal tube and secure it with the O-ring and nut. 

3. Repeat for the second cold trap port.

Connecting Cables and Power Cords

All cables must be connected securely to their respective connectors for proper operation of 
the analyzer and its peripheral equipment.

1. Connect the keyboard cable, the monitor cable, and the mouse cable into their respective 
connectors on the rear panel of the computer. Refer to the manual provided with your 
computer if you are unsure of connector locations.

2. Plug one end of the printer cable into the connector on the rear panel of the printer. Plug 
the other end of the printer cable into the connector labeled LPT1 (may be labeled 
PARALLEL) on the rear panel of the computer.

3. Plug one end of the instrument communications cable into the connector labeled RS232 
on the right side of the analyzer. Plug the other end into the communications port on the 
computer.

O-ring

Nut

Glass tube

Refer to the instruction manuals supplied with the computer, video monitor, and 
printer for their respective voltage requirements.

Some monitors and printers shipped from the United States must be connected to a 
100-120 VAC power source. Connecting this equipment to a 200-240 VAC power 
source could result in electrical shock and/or damage to the equipment.
2-10                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020 Chemi Setting Up the Analyzer
4. Insert one end of the analyzer power cord into the input power connector on the right side 
of the analyzer and the other end into an appropriate power source.

5. Plug all other power cords, including the vacuum pumps, into an appropriate power 
source.

Connecting the Gas Supply and Tubing

Delivery tubes for connecting the gases used with the ASAP 2020 Chemi system are supplied 
with the instrument. If the gases you are using are incompatible with brass and copper, substi-
tute compatible tubing and fittings. Stainless-steel tubes with fittings are available from 
Micromeritics. A regulator is required for each gas bottle connected to the analyzer. Appropri-
ate regulators are available from Micromeritics. Refer to Ordering Information, page 10-1 for 
part numbers.

The quality of the gas regulators used with the ASAP 2020 Chemi System must be comparable 
to that used for semiconductor manufacturing and gas chromatography. Regulators must avoid 
or minimize exposing the gas to lubricants and elastomers. Lubrication and elastomers from 
low-quality regulators may contaminate the gas stream and cause problems such as catalyst 
poisoning. Low-quality regulators must be flushed with the gas to purge them of contaminants 
such as air, moisture, and lubricants. These regulators may be unsuitable for evacuation. High 
quality regulators which match local gas connections and meet safety regulations are usually 
available from chromatography gas suppliers and semiconductor gas suppliers. Regulators 
available from Micromeritics can be evacuated thoroughly to remove contamination. 

Connecting a Regulator to the Gas Bottle

1. Leave the gas bottle shut-off valve closed until instructed otherwise.

2. If the regulator has a 1/8-in. outlet, proceed to the next step. If the regulator has a 1/4-in. 
outlet, attach the reducer fitting to the outlet of the regulator shut-off valve.

Bottle Shut-Off 
Valve

Shut-Off Valve 
Nut Two-Stage Pressure 

Reducing Regulator

Gas Bottle

Brass Reducer 
Fitting

Copper Tubing

Regulator 
Shut-Off Valve

Pressure Control 
Knob
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3. Tighten the regulator shut-off valve.

4. Attach the copper delivery tubing to the regulator or reducer fitting.

5. Purge the regulator as follows:

a. Close the regulator shut-off valve by turning it fully clockwise. 

b. Turn the pressure regulator control knob fully counterclockwise.

c. Open the gas bottle valve by turning it counterclockwise, then close the gas bottle 
valve.

d. Observe the high pressure gauge. If the pressure decreases, tighten the nut connecting 
the regulator to the gas bottle. If the pressure is stable, proceed to Step e.

e. Turn each pressure regulator control knob clockwise until the outlet pressure gauge 
indicates 15 psig (103 kPag). Open each regulator shut-off valve by turning it 
counterclockwise briefly. Then close each valve.

The gases used for flowing preparation (usually hydrogen and oxygen) may require a 
pressure other than 15 psig. Start with 10 psig and monitor the gas flow rotameter 
during the flowing preparation to determine the adequate flow rate. Refer to Appendix 
H for the procedure on converting the required flow rate to standard cubic centimeters 
per minute (SCCM) of air. SCCM units are shown on the rotameter.

f. Make sure the gas bottle valve is completely closed.

6. Repeat steps 2 through 5 for each gas bottle to be attached to the analyzer.

7. Proceed to the next section to attach the other end(s) of the copper delivery tubing to the 
analyzer.

Do not overtighten the fittings. Doing so could collapse the brass fitting and cause a 
leak.

If you are using hazardous gases, ensure that the gas supply equipment is adequately 
vented to prevent purging the regulator and tubing into the lab atmosphere when 
performing the next step.
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Connecting the Gas Delivery Tubing to the Analyzer

The ASAP 2020 Chemi analyzer allows for connection of up to six chemisorption gases for 
chemi operations, up to six physisorption gases for physi operations, one degas backfill gas, 
and Helium for free-space measurements. Nitrogen or helium (or other suitable gas) can be 
used as the degas backfill gas.

Gas inlet connections are located on the right side panel of the analyzer labeled 1 through 6 for 
the Chemisorption gases, Degas for the backfill gas, and Helium.

A typical hook-up for chemisorption gases is as follows:

1 Hydrogen
2 Oxygen
3 Carbon monoxide
4 As desired
5 As desired
6 As desired
Degas Nitrogen 
Helium Helium

Attach the other end of the copper tubing (from the regulator) to the appropriate gas port on 
the back of the analyzer.

Chemi gas inlets

Be sure to specify which gas is attached to the ports you are using (refer to Specifying 
Gas Ports, page 2-30).
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Turning On the System

1. Place the ON/OFF switches for the computer, monitor, and any peripheral devices in the 
ON position.

2. Place the analyzer power switch in the ON position; verify that the green LED on the front 
panel is illuminated.

Turning Off the System

1. Select File > Exit or Close from the System menu.

If you exit the ASAP 2020 Chemi System program with analyses in progress, the analyses 
continue and data are collected. Reports that are queued under the Print Manager will 
print. If, however, a power failure occurs and a UPS is not attached, the data collected 
after exiting the ASAP 2020 Chemi System program are lost.

2. Place the computer, monitor, and printer ON/OFF switches in the OFF position.

3. Place the analyzer power switch in the OFF position.

Always make sure you exit the program before turning off the computer. Failure to do 
so could result in loss of data.
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Installing the Analysis Program

The ASAP 2020 Chemi program is also available as a standalone option so that you can install 
it on a computer other than the one controlling the analyzer. This allows you to create or edit 
sample and parameter files, as well as generate reports on completed sample files. Review the 
Micromeritics PROGRAM License Agreement for restrictions on the use of additional copies.

Initial Installation

The ASAP 2020 Chemi System program is supplied on a CD. Perform the following steps to 
install the program:

1. Turn on the analyzer.

2. Insert the program CD into your CD-ROM drive.

3. Select Start from the Status bar, then Run from the Start menu.

4. Enter the name of the drive designator, followed by setup; for example,

             e:setup

5. Click OK; the New Installation dialog is displayed.

Power Management features should be disabled so that the Micromeritics application 
can communicate properly with the instrument during operation. These features can 
be disabled in the computer Setup configuration; through Windows; or through a 
utility supplied by the computer manufacturer. 
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The Destination Folder group box displays the amount of current disk space, the amount 
of disk space required for the analysis program, and the directory into which the 
application will be installed. Click Browse to install the application into a different 
directory.

6. If you want to run the application from the desktop, select the checkbox just below the 
Destination Folder group box to add an icon.

7. The ASAP 2020 Chemi icon is added to the Micromeritics folder by default. If you prefer 
a different folder, enter or select one from the drop-down list.

You may cancel the installation at any time by selecting Exit. If you do so, you must 
start the installation program from the beginning to install the analysis program.
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8. Click Next; the Analyzer Configuration dialog is displayed.

9. In the Step 1 group box, click the radio button for the number of analyzers to be attached 
to this computer. If you are attaching multiple analyzers, it may be necessary to add 
additional serial ports to your computer. 

10. In the Step 2 group box, enter the serial number(s) for the analyzer(s) you are attaching to 
this computer.

11. Click Next; the Calibration File Installation dialog is displayed. Read the information in 
the dialog and proceed accordingly.

12. After the calibration files are installed, the Installation Complete dialog containing the 
Readme file is displayed.

13. Use the scroll bar if you want to read the contents of the file, then click Finish to close the 
dialog.

14. Remove the Setup CD and store in a safe place. The original Setup CD contains the 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you maintain your original Setup CD in a secure location in 
the event calibration files need to be reinstalled.

Choose 0 (zero) if you are installing this program for data manipulation on a computer 
other than the one controlling the analyzer, or if this is the destination computer in a 
Move operation.

If you selected 0 as the number of instruments to install, the Calibration dialog is not 
displayed.
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Using the Setup Program for Other Functions

After initial installation of the ASAP 2020 Chemi analysis program, the application setup pro-
gram can be used to:

• Upgrade software, page 2-20
• Add an analyzer, page 2-21
• Move an analyzer from one computer to another, page 2-22
• Remove an analyzer from the computer, page 2-25
• Change the analyzer setup, page 2-26
• Reinstall calibration files, page 2-27
• Uninstall the analysis program, page 2-28

To start the application setup program:

1. Ensure that the analysis program is not operating.

2. Insert the CD into your CD-ROM drive.

3. Select Start from the Windows Task bar.

4. Select Run from the Start menu.

5. Enter the drive designator of the CD-ROM drive, followed by setup. For example: 
e:setup.

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.

6. Click OK; the setup Welcome screen showing the options available is displayed.
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7. Select the operation to perform. Procedures for performing each operation are located in 
subsequent sections.

After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower 
section of the dialog.

8. After you have completed all operations, click Exit to close the dialog.

Indicates status of last 
operation performed.
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Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any sta-
tus files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program. Choose the software option; remember, only the applicable 
option will display; it will be one of the following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

2. Click Start File Installation; the application installs the software and redisplays the setup 
Welcome dialog. Click Exit to close the dialog.
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Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program. Select Add an analyzer, then click Next; the Setup analyzer 
dialog is displayed:

2. Enter the serial number of the analyzer being added, then the communications port to 
which it is to be connected.

3. Click Next; the Calibration Installation dialog is displayed.

4. Select the location of the calibration source files. If the calibration files are located in a 
directory other than the one displayed, click Browse to select the directory. Click Finish; 
a media change dialog is displayed.

5. Click OK to install the calibration files. A dialog containing the Readme file is displayed 
after the calibration files are installed.

6. Click Exit to close the dialog.
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Moving an Analyzer from one PC to another PC

You can move an analyzer, along with its status and calibration files, from one computer 
(Source PC) to another computer (Destination PC).

1. Install the analysis program on the destination computer (refer to Installing the Analysis 
Program, page 2-15). Be sure to select 0 as the number of instruments; all related 
instrument information will be transferred in the Move operation.

If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup 
Program for Other Functions, page 2-18.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click Next; 
the Move analyzer operation dialog is displayed.

This operation does not move sample or parameter files. To move these files, use a file 
management program such as Explorer or a backup/restore utility.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a floppy drive or a shared network drive. If this is not possible, select a 
local folder. After the files are placed there, use a folder transfer utility to copy this folder 
from the Source PC to the Destination PC.

Calibration files are not included in the moved files. These files must be copied and 
moved separately to the destination computer. The calibration files are located in a 
subdirectory (folder) of the Hardware directory. The subdirectory is named 202-(serial 
number).

7. Click Finish; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).
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10. Select Destination PC, then click Next; the following dialog is displayed.

11. In the Step 1 group box, enter the serial number of the analyzer being moved and the 
communications port to which it will be attached.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

13. Click Finish; the files are moved and the setup Welcome dialog is displayed.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the 
status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
2-18.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an 
analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
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Changing an Analyzer Setup

Change the analyzer setup as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
2-18.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change 
analyzer setup dialog is displayed.

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.
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Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
2-18.

2. From the Setup dialog, select Re-install calibration files for an analyzer, then click 
Next; the Re-install calibration files dialog is displayed.

3. Select the analyzer whose calibration files to reinstall from the drop-down list. If you have 
only one analyzer installed, a drop-down list is not included.

4. Insert the CD containing the calibration files; ensure that the CD drive is displayed as the 
calibration file source location. If not, click Browse and choose the CD drive.

5. Click Finish; the calibration files are reinstalled and the Welcome dialog is again 
displayed.

6. Click Exit to close the dialog.
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Uninstalling the Analysis Program

You can remove the ASAP 2020 Chemi analysis program as follows. When you perform this 
operation, the application removes the analysis program, status files, analyzer setup files, and 
resulting empty directories. It does not remove data files.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
2-18.

2. From the Setup dialog, select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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4. Choose one of the following:

• Automatic: click Next; the system uninstalls the analysis program automatically and 
the setup Welcome dialog redisplays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files to 
uninstall. After all files are selected and uninstalled, the setup Welcome dialog 
redisplays.

5. Click Exit to close the Welcome dialog.
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Specifying Gas Ports

After all gases have been attached to the analyzer, perform the following steps to specify gas 
ports:

1. Select Unit > Unit Configuration; the Unit Configuration dialog is displayed.

2. Click Gas; the Gas Configuration dialog is displayed.

3. Click on the down-arrow at each field for the ports to which gases are attached and choose 
the appropriate gas. The ports preceded with a P are for physisorption gases and the ones 
preceded with a C are for chemisorption gases.

4. Click Exit to close the dialog, and then again to close the Unit Configuration dialog.
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3.  USER INTERFACE

This chapter contains information to familiarize you with the hardware/software of the ASAP 
2020 Chemi system.

Controls, Indicators, and Connectors

Front Panel

Valve/Fan connector

Gas Flow meter

Gas Flow Meter inlet

Furnace Cooling Gas connector

Furnace Power connector

Furnace Circuit Breaker
Elevator

Vacuum Pump panel

Power Indicator light

High Vacuum Pump 
(inside)

Sample Thermocouple 
connector

Furnace Thermocouple 
connector

Power indicator light Illuminates when power is applied to the analyzer.

Valve/Fan connector Connects the sample exhaust valve (X), as well as the cooling 
fan. The cooling fan prevents overheating which could cause 
damage to the valve and/or O-rings; it is controlled by a 
thermostat and operates only when excessive heating occurs. 

Elevator For placement of the furnace.
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Vacuum pump panel Allows access to the vacuum pumps. Remove this panel 
when you need to service the pumps. 

You do not have to remove the panel to inspect the condition 
of the oil or the oil level (oil-sealed forepump). To 
accomplish either of these tasks, remove (or fold over to the 
right) the protective rubber mat from the work surface and lift 
off the metal cover; this will expose the vacuum pump sight 
window. 

Vacuum pump sight 
window

The vacuum pump sight windows enable you to inspect the 
oil levels in the degas and analysis pumps.

Gas flow meter Indicates the flow rate of gas passing through the sample 
tube. It is calibrated in cc/min STP for air; however, the flow 
rate indicated varies depending on the gas. Appendix H 
includes a chart of conversion factors for the flow rates of 
various gases.

Sample Thermocouple 
connector

Allows connection of the sample thermocouple.

Gas flow meter inlet Connects by a valve to the exhaust port of the sample tube to 
allow verification of the gas flow during the preparation 
steps.

Furnace Cooling Gas Allows connection of a compressed air supply for cooling the 
furnace.

Furnace thermocouple 
connector

Allows connection of the furnace thermocouple.

Furnace power connector Allows connection of the furnace power cord.

Furnace circuit breaker Protects the furnace in the event of a fault in the wiring. If the 
circuit breaker trips (pops out), call your Micromeritics 
service representative.
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The following components are located on the underside of the upper extension of the front 
panel.

High vacuum pump A high vacuum pump is used when dry evacuation methods 
are required. Connections, as well as an on/off (breaker) 
switch, are located on the front right side of the analyzer 
beneath the work surface. Remove (or fold over to the left) 
the rubber mat from the work surface and lift off the metal 
cover.

Indicator lights (located on the underside of the upper 
extension of the front panel) illuminate when the high 
vacuum pump is operating.

Degas ports Allow you to degas up to two samples. Each degassing port 
has connections for a heating mantle.

Heating mantle thermocouple Allows connection of a heating mantle thermocouple.

Heating mantle power 
connector

Allows connection of the heating mantle power cord.

Heating mantle breaker Protects the circuitry for the heating mantle in the event of a 
failure. If the circuit breaker trips (pops out), call your 
Micromeritics service representative.

High Vacuum Pump 
indicators

Degas Port

Cold Traps

Po Port

Sample Port
Heating Mantle Power connector

Four hangers are provided 
for placement of shields.

Heating Mantle 
Breaker Heating Mantle

Thermocouple connector
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Cold Traps Two cold traps are provided; one for the degassing operation 
and one for analysis.

High vacuum pump 
indicators

Illuminate when the high vacuum pump(s) is (are) operating 
at normal speed. The left indicator is for degas operations and 
the right one for analysis.

Sample port For installing the sample tube containing the material to 
analyze.

Po port For installing a Po (saturation pressure) tube when 
performing physisorption analyses. A Po tube is not used for  
chemisorption analyses.
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Side Panel

Degas Inlet Port

Helium Inlet Port

Gas Flow Meter Exhaust

Furnace Cooling Gas Inlet

RS232 Port

Voltage Selector Switch

Power Connector

On/Off Switch
Valve Circuit Breaker

Vapor Gas Port

Gas Inlet Ports

Vapor gas port For attaching the water vapor option, or connecting a vapor 
gas. Refer to Chapter 10 for ordering information on the 
water vapor option.

Gas inlet ports Allows connection of gases to the analyzer. The inlet ports 
are grouped in two sets of six. The group on the left is for 
physisorption operation and the group on the right for 
chemisorption operation. 

The chemisorption manifold is constructed of stainless steel 
and, therefore, allows use of mildly corrosive gases. The 
physisorption manifold is constructed of aluminum; do not 
attach corrosive gases to the physisorption ports.

Do not connect corrosive gases to the physisorption ports; doing so may cause 
damage to the block and gas inlet manifold.
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Degas inlet port Allows connection of the backfill gas used for degassing.

Helium inlet port Allows connection of Helium used for measuring the free 
space.

Furnace cooling gas inlet Admits the air supply for cooling the furnace.

Gas flow meter exhaust Allows connection to a fume hood for safe venting of 
preparation gases.

RS232 port For connecting the analyzer to a computer.

Valve circuit breaker Protects the circuitry for the valves in the event of a failure. If 
the circuit breaker trips (pops out), call your Micromeritics 
service representative.

On/Off switch For turning the analyzer on and off. This switch also serves as 
the main breaker for the analyzer; it switches off 
automatically in the event of an electrical fault.

Power connector For connecting the analyzer to the electrical supply.

Voltage selector switch For setting the analyzer to the correct incoming AC line 
voltage.
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Rear Panel

Vacuum Pump Recess

Vacuum pump recess Provides for placement of the vacuum pumps. Vacuum 
pumps can be serviced from the front of the instrument by 
removing the vacuum pump panel located on the lower left 
side of the front panel (see Front Panel described 
previously).
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Using the Software

Keyboard Shortcuts

Keyboard shortcuts can be used to activate some menu commands. Keyboard shortcuts (when 
applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in 
the menu command. For example, to access the File menu, press Alt + F, then press the under-
lined letter on the submenu. For example, Alt + F opens the File menu, then press O to access 
the File Selector for opening files.

Key(s) Function

F1 Access electronic copy of operator’s manual

F2 Open a sample information file

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file

Insert the current date (Select Dates dialog)

F4 Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile open windows

F7 Cascade open windows

F8 Start report

F9 Close all open reports

F10 Generate a Heat of Adsorption report

Alt + F4 Exit the ASAP 2020 Chemi program

Shift + F2 List statistics for sample information files

Shift + F3 List statistics for analysis conditions files

Shift + F5 List statistics report options files

Shift + F9 Access shortcut menu of (1) selected component on instrument 
schematic, or (2) onscreen reports
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File Status and Description

Status Description

All All sample information files in the specified directory and within the 
specified range of dates

Analyzing Sample information files that are currently being used with an analysis

Complete Sample information files that have been used with an analysis

Entered Sample information files that contain manually entered data

No Analysis Sample information files that have not been used in a degassing operation or 
an analysis

Prepared Sample information files that have been used in an automatic degassing 
operation and are ready for analysis

Preparing Sample information files that are currently being prepared for analysis
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File Name Conventions

For sample information files, a default file name (the next available sequence number) and a 
default extension are displayed when the Files list box is opened. For analysis conditions and 
report options, only a default extension is displayed with an asterisk (*.ANC, for example). 
The following table shows the file name extensions for the AutoChem 2950 HP analysis 
program.

File Type Extension

Sample Information SMP

Degas Conditions DEG

Analysis Conditions ANC

Report Options RPO

Export to disk (ASCII) ISO

Report to disk RPT

List to disk LST

The following types are available for reports saved from the Report 
window:

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the analyzer are accessed from the main menu bar. Brief descriptions of each 
menu are provided below; refer to the chapter given in parentheses for a detailed description of 
the options contained on that menu.

File Enables you to maintain system files.

Unit [n] Enables you to start an analysis, manually control the system, 
and perform calibrations.

This menu is not shown if the 2020 Chemi program is being 
used for offline data manipulation.

Reports Enables you to generate and close reports. Also provides 
sample copies of reports. 

Options Enables you to select data presentation formats, and enter 
system default values. 

Windows Enables you to arrange the windows on your screen. It also 
displays the names of all open files. 

Help Displays Help information. 
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4.  OPERATING PROCEDURES

This chapter contains general instructions for ASAP 2020 Chemi operating procedures. It does 
not contain detailed descriptions of the dialogs used to perform these procedures. Refer to 
Chapters 5 through 8 for dialog descriptions. Use the index or bookmark panel of the opera-
tor’s manual (accessed from the Help menu) to assist you in locating the appropriate dialog. 

Specifying Sample File Defaults

The ASAP 2020 Chemi System automatically generates sample information file names and 
assigns values to them based on the defaults specified in Sample Defaults on the Options 
menu. This feature makes it easy for you to apply the same conditions to many samples.

The system is shipped with a complete set of default values for sample information files as 
well as parameter files. Appendix E, Default Files and System Files beginning on page E-1 
lists the names of default files and a brief description of each. 

You can edit the system default values to create a default sample information file which meets 
your laboratory’s requirements. The defaults you specify are the ones you see when you create 
a new sample or parameter file. Therefore, it is best to specify (or enter) parameters that you 
plan to use most frequently. For example; specify defaults for your most commonly analyzed 
sample material. You can always edit parameters in the sample file when it is created. 

You can specify sample defaults in the Basic or Advanced format.

Basic Format

Perform the following steps to define defaults for a sample information file in the Basic for-
mat. 

Refer to Basic, page 8-6 for a detailed description of the fields on this dialog.

1. Select Options > Sample Defaults; the default Basic Sample Information dialog is 
displayed.

Select Options > Option Presentation and ensure that Basic is selected as the format.
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2. In the Sequence field, specify a default string. This is the number that is incrementally 
sequenced and displays in the File name field when you select File >Open > Sample 
information.

3. In the field on the right of the Sample line, enter a format for the sample identification. 
Be sure to include the $ symbol to have the sample file number included as part of the 
identification.

4. Enter a default value in the Mass field. An approximate value is sufficient; a more 
accurate sample mass can be entered in the sample file.

5. Select the down arrow to the right of the following fields to choose a default parameter 
file:

• Degas Conditions
• Analysis Conditions
• Report Options

6. Click Save, then Close.

You also can edit the word Sample. For example, you may prefer to use Material or 
Test.
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Advanced Format 

The Advanced Sample Defaults dialog resembles a set of index cards. You can move from one 
set of parameters to another by clicking the parameter tab or by using Next and Prev. The val-
ues you specify in the parameter portions of the sample file (Degas Conditions, Analysis 
Conditions, and Report Options) are saved as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample information; Yes to create the file; and the defaults you 
specify display for all parameters.

• Select File > Open > Analysis Conditions, enter a name, then Yes to create the file, 
and the defaults you specify in the Analysis Conditions portion of the Advanced 
Sample Defaults dialog display in the fields.

Refer to Advanced, page 8-9 for a detailed description of the fields on this dialog.

1. Select Options > Sample Defaults, the default Advanced Sample Defaults dialog is 
displayed.

2. In the Sequence field, specify a default string for the sample file number. This is the 
number that appears in the File name field when you select File > Open > Sample 
information.

3. In the right-side field of the Sample line, enter a format for the sample’s identification. 
Be sure to include the $ symbol if you want the sample file number (Sequence) included 
as part of the identification.

Select Options > Option Presentation and ensure that Advanced is selected as the 
format.
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4. Edit the Operator and Submitter lines. Or have them omitted entirely by selecting 
Omit.

5. If bar code information is not applicable, select Omit to omit this field from the sample 
information dialog. Or, if you prefer to use this line for some other type of information, 
edit the label. 

6. Enter a default value in the Mass field. An approximate value is sufficient; a more 
accurate mass can be entered at the time of analysis.

7. Choose to have data collected automatically or if you plan to enter the data. You can 
change this option at the time of analysis.

8. Click the Analysis Conditions tab. Choose the analysis conditions appropriate for your 
most commonly analyzed material

9. Click the Degas Conditions tab. Specify degassing criteria.

10. Click the Report Options tab. Choose reports, using Edit to specify details; then click 
Save. 

11. Click Close to close the dialog.

It is not necessary to click Save on each dialog. Clicking Save on any dialog after all 
defaults have been specified is sufficient. All dialog defaults will be saved.
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Creating Sample Information Files

A sample information file must be assigned to every sample that is analyzed. When you create 
a sample file, you can accept the default values specified using Sample Defaults, or you can 
edit them. You can create a sample information file using the Basic, Restricted, or Advanced 
format. 

Sample information files reside in a directory. The more files in a directory, the longer it may 
take to access a file. Therefore, it is a good practice to limit the number of files in a directory to 
approximately two hundred. You may create additional directories as needed. Refer to the 
operating system manual for more information.

Basic and Restricted Formats

Sample information files are created in the Basic and Restricted formats using predefined 
parameter files. 

Refer to Basic Format, page 5-8 for a description of the fields associated with creating a Basic 
or Restricted sample file.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

4. Accept the default identification or change it to an appropriate one. The dialog above 
shows the sample file number because the dollar ($) symbol was used in Sample 
Defaults.

5. Enter the sample’s mass (if different from the default value) in the Mass field.

Not available when using 
the restricted format.
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6. Using the down arrows to the right of each parameter field, select an appropriate file (or 
accept the defaults). You can review or edit the contents of these files by switching to the 
Advanced format.

7. Click Save, then Close.

Advanced Format

The Advanced format allows you to customize the parameters of a sample information file.

Refer to Advanced Format, page 5-6 for a description of the fields associated with creating a 
sample information file using the Advanced format.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

The defaults that appear in the fields are the ones specified in Sample Defaults. 

4. Accept the default identification in the Sample field or change it to an appropriate one. 
The above dialog shows the sample file number because the dollar ($) symbol was used 
in sample defaults.

You cannot switch to the Advanced format if you are using the Restricted format.

If you selected Omit beside the Operator and/or submitter fields when you specified 
Sample defaults, these fields will not display.
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5. Edit the Operator and/or Submitter fields as needed.

6. Enter bar code information (if used). This field will also accept input from a bar code 
reader (connected to a USB port on the computer).

7. Enter the sample’s mass (if different from the default value) in the Mass field.

8. Choose whether you want data automatically collected by the system or whether  to enter 
the data.

9. Click Save to save the information you entered.

10. The steps for completing the remaining parameters of the sample information file are 
explained in subsequent sections:

• Degas Conditions, page 4-8
• Analysis Conditions, page 4-9
• Report Options, page 4-11

Simply click on the tabs to open its associated dialog.

If a sample information file already exists containing the values to use in this file, you 
can click Replace All to copy those values into this one. You can still edit the values 
after they are loaded. 

Use the Comments window to record specifics of the analysis or its conditions. 
Anything you enter in this window is displayed in the report header.
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Defining Parameter Files

The following file types can exist as part of the sample information file or as an individual 
parameter file:

• Degas conditions
• Analysis conditions
• Report options

Having these files exist independently allows you to use them over and over again.

Several predefined parameter files are included with the ASAP 2020 Chemi program. 
Although these files may come close to the needs of your laboratory, to define additional ones. 
Or you can use a predefined file as a starting point. This can be done by creating a new file, 
then clicking Replace and choosing the file containing the values to use. You can edit the val-
ues after they have been copied into the new file. The file from which the values were copied 
remains intact and ready for the next use. 

To have parameter files display in the drop-down lists on the Basic and Restricted Sample 
Information dialogs, be sure to save them to the directory specified as the Parameter Files 
Directory (refer to Parameter Files Directory, page 8-16). 

Degas Conditions

Degas Conditions files contain degassing information for sample preparation. These files are 
applicable only if your are using the SmartVac for automatic degassing.

Refer to Degas Conditions, page 5-11 for a description of the fields on this dialog.

1. Select File > Open > Degas Conditions; the Open Degas Conditions File dialog is 
displayed.

2. Enter a name in the File name field, then click OK.
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3. Click Yes to create the file; the Degas Conditions dialog is displayed.

4. Enter a description in the Description field. Use an intuitive description, one that will be 
easily recognized when needed.

5. Specify conditions for the evacuation and heating phases of the degassing operation.

6. Click Save, then Close.

Analysis Conditions

Analysis conditions specify the data used to guide an analysis. An analysis conditions file may 
be assigned a unique name, and you can direct any sample to be analyzed according to the con-
ditions in any existing analysis conditions file. 

Refer to Analysis Conditions, page 5-13 for a description of the fields on this dialog.

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name in the File name field, then click OK.
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3. Click Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description in the Description field. Use an intuitive description, one that will 
help you identify the type of sample you plan to analyze using these analysis conditions.

5. Choose one:

6. Click Save, then Close.

If..... Then....

you plan to use this file 
for an analysis in which 
data are to be collected 
automatically:

In the Analysis Termination group box, choose post-analy-
sis conditions for the sample.

In the Available Tasks window, choose and define tasks as 
required.

you plan to use this file 
for manually entered data:

In the Manually Entered Analysis Data group box, enter 
the conditions.
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Report Options

Report options specify the types of reports generated from an analysis or manually entered 
data. They also help you customize details of reports such as axis scale, axis range, and col-
umn headings.

Tailor report options files to accommodate the requirements of your analyses. For example, 
generate a single-page report initially to verify particular characteristics of the sample; then 
create a more sophisticated report to present details. You can use report options files to gener-
ate reports at any time during or after an analysis. However, a report generated during an 
analysis only includes data collected up to the time of the report.

Refer to Report Options, page 5-26 for a description of the fields on this dialog.

1. Select File > Open > Report options; the Open Report Options File dialog is displayed.

2. Enter a name in the File name field, then click Save.

3. Click Yes to create the file; the Report Options dialog is displayed.

4. Enter a description in the Description field. Use an intuitive description, one that will be 
easily recognized when needed.

5. Select Show report title and enter the title to appear at the top of the report. Or deselect 
this option if you prefer not to have a report title.

6. To choose the files. Then be sure to access the graph options dialog and choose Overlay 
samples.

If your company logo exists as a bitmap or enhanced metafile, you can have it display 
in the report header by selecting Show graphic. Then click Browse to select the file. 
Use the Height and Width fields to specify the size.
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7. The reports that may be generated are listed in the window adjacent to the Edit button. 
Select reports by double-clicking on the report. A report is selected when it is preceded 
by a check mark. Reports are deselected in the same manner. 

You can edit some reports by highlighting the report and clicking Edit. 

8. Click Save, then Close.
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Preparing Samples

Care should be taken in preparing samples for analysis. The following guidelines help ensure 
accurate, reproducible results.

Cleaning and Labeling Sample Tubes

Sample tubes must be clean and dry before samples are added and weighed. The following 
procedures are recommended. Refer to the following table for a list of materials needed to 
clean and weigh samples properly.

Table 4-1.   Materials Required to Clean and Weigh Sample Tubes

1. Turn on the drying oven used for heating the sample tubes and set the temperature to 
110 ºC.

2. Check the reservoir of the ultrasonic cleaning unit to make sure it is clean.

3. Using 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water, fill the 
reservoir of the ultrasonic unit with enough water to cover the sample tubes. Make sure 
the detergent is dissolved before placing the sample tubes into the water. If too much 
detergent is used, it may be difficult to rinse from the sample tubes.

Supplied by Micromeritics Supplied by User

Sample tube
Quartz wool
Sample tube brush
Stopper and cap for sample tube
Sample tube rack
Sample weighing support
Cloth gloves
Reference material
Funnel
Sample data worksheet 
(copied from Appendix A of this manual)

Drying oven
Ultrasonic cleaning unit
Alconox Rubber gloves or lint-free cloth
Acetone or isopropyl alcohol
Safety glasses
Forceps
Insulating gloves
Waste container
Balance
Pipe cleaners
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4. Fill the sample tubes with warm water and place them in the reservoir of the ultrasonic 
cleaning unit. Turn on the ultrasonic cleaning unit for approximately fifteen minutes.

5. Using rubber gloves, remove the sample tubes from the reservoir.

6. Clean the interior of the sample tubes with the brush supplied with the ASAP 2020 Chemi 
System.

7. Rinse the sample tubes thoroughly with hot water. Then rinse them with isopropyl 
alcohol or acetone using a waste container to collect used solvent.

If isopropyl alcohol or acetone is not available, deionized water may be used to rinse 
the sample tubes.

Avoid touching clean sample tubes with your bare fingers. Skin oils weaken the quartz 
tubes when the tubes are heated.
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8. Using dry, compressed nitrogen or air, dry the interior of the sample tubes under a vent 
hood. Use a tubing extension long enough and small enough in diameter to fit inside the 
tubes.

9. Stand the sample tubes on the sample tube rack. Bake for two hours.

10. Remove the sample tubes from the oven and allow them to cool.

11. Using either rubber gloves or a lint-free cloth (but not bare hands), insert a piece of quartz 
wool into the sample tube. Push it gently to the bottom using a clean, dry stirring rod or 
piece of wire. Do not pack the wool, or you will inhibit gas flow.

12. Wipe the rubber stopper and cap with a lint-free cloth.

13. Label the sample tube, stopper, and cap for identification.

14. Fill the tube with the backfill gas. Use a tubing extension long enough and small enough 
in diameter to fit inside the tube. Insert the stoppers (and additional quartz wool, if 
required) quickly to avoid releasing the gas.

After the analysis, the sample tube contains the analysis gas or, if free space was 
measured, helium. If you want to backfill the sample tube following the analysis, avoid 
mixing gases and creating a potentially dangerous situation. Insert an evacuation task 
after the analysis task.

After loading a powder or sample made of fine particles into the sample tube, be 
prepared to insert another piece of quartz wool into the tube on top of the sample. This 
prevents particles from being drawn up into the instrument and contaminating the 
manifold.

To obtain the accurate mass of a degassed sample, the gas in both the empty sample 
tube and in the tube with the sample must be the same.
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Determining the Sample’s Mass

Analysis results are expressed in units of area per gram of sample (m2/g) or cubic centimeters 
per gram of sample (cm3/g); therefore, the true weight of the sample must be known. Carefully 
weigh each sample tube set and sample as described below.

1. Write the Sample Tube number on the Sample Data Worksheet. (A Sample Data 
Worksheet, which you may copy, is included in Appendix A, page A-3.)

2. Place the sample weighing support on the balance. Tare the balance and allow it to 
stabilize at zero (0).

3. Push a piece of quartz wool down inside the sample tube. If you are analyzing a powder 
or sample made of fine particles, put a second piece of quartz wool just inside the sample 
tube. Put the stopper and the cap on the sample tube.

4. Place the sample tube set (sample tube, stopper, cap, and quartz wool) on the sample 
support. Record the stabilized weight on the Sample Data Worksheet as Mass of empty 
sample tube. Remove the sample weighing support and sample tube set from the 
balance.

5. If you do not want the sample’s mass before degas or analysis, skip to step 7.

Place a sample container on the balance. Tare the balance and allow it to stabilize at zero 
(0).

6. Slowly add the sample to the sample container.

7. Remove the large rubber stopper from the sample tube. If you are analyzing a powder or 
sample made of fine particles, also remove the top portion of quartz wool from the tube.

Do not touch the sample (reference material) with bare hands while performing the 
next step. Oil from your fingers could affect the accuracy of results. 
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8. Using a funnel, pour sample from the container into the sample tube on top of the quartz 
wool remaining in the tube. If some sample clings to the inside of the sample tube above 
the last 3 in. (7.5 cm) of the tube, remove it using a pipe cleaner or lint-free wipe.

9. Insert the top portion of quartz wool (if used) into the tube and press it down.

10. Insert the large rubber stopper.

11. Weigh the sample tube set containing the sample and record its mass on the Sample Data 
Worksheet as Mass of sample tube plus sample (Before Degas).

12. Subtract the Mass of empty sample tube from the Mass of sample tube plus sample; 
record this value Mass of sample (Before degas).
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Degassing the Sample

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. 
The sample must be clean before an analysis is performed. The sample is heated and placed 
under vacuum to remove moisture and other contaminants. This process is called degassing 
the sample. Degassing the sample is easy and virtually automatic if you have the SmartVac 
installed on your ASAP 2020 Chemi analyzer.

The ASAP 2020 Chemisorption System performs all degassing and preparation steps with the 
sample loaded on the analysis port. You may degas a heavily contaminated sample on the 
degas ports prior to loading the sample on the analysis port; the analysis port can then be more 
productively used for flowing or static preparation, evacuation, or analysis. The following pro-
cedure describes degassing a sample on the degas ports.

1. While holding the degas port plug, remove the connector nut and plug from the degas 
port by turning the connector nut counterclockwise. 

2. Place the degas port connector nut, ferrule, and O-ring onto the sample tube set as shown 
in the following figure.
4-18                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020 Chemi Preparing Samples
3. Remove the large rubber stopper from the sample tube and attach the sample tube set to 
the degas port. Be sure to push the sample tube straight in to a full stop. 

Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up to the 
degas port and turning the connector nut clockwise. Tighten the nut securely by hand.

4. Make sure the exhaust tube of the sample tube has been capped.

5. Place a heating mantle over the end of the sample tube and secure the mantle in place 
with a mantle clip.

6. Insert the heating mantle thermocouple plug into the appropriate connector. Then insert 
the heating mantle power plug into its appropriate connector. Make sure both plugs are 
completely inserted.

Degas Port Fitting

O-ring (size 014)

Ferrule

Degas Port Connector Nut

Mounting the sample tube at an angle might break the tube and cause injury.

Never use a tool to tighten the nut; doing so may cause the sample tube to break.
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7. Select Unit > Degas > Start Degas; the Start Degas dialog is displayed.

8. Click Browse to the right of the Sample field to choose your degas file.

Repeat this step if you are degassing two samples.

9. Click Start to begin the degassing operation. 

10. After degassing has completed, transfer the sample tube to the analysis port to start the 
analysis (next section).

Observe the status bar of the degassing operation to determine when degassing is 
complete.
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Transferring the Degassed Sample to the Analysis Port

The sample tube must be removed from the degas port, weighed, and then placed onto the 
analysis port for analysis. 

1. Allow the sample tube to cool to room temperature (approximately 15 minutes). 

2. Holding the sample tube, loosen the port connector nut and remove the sample tube from 
the degas port. Insert a stopper immediately. Remove the connector nut, ferrule, and O-
ring from the sample tube stem.

3. Weigh the sample tube set. Enter the value on the Sample Data Worksheet as Mass of 
sample tube plus sample (After Degas). 

4. Subtract the Mass of empty sample tube (Before Degas) from the Mass of sample tube 
plus sample (After Degas) to determine the mass of the sample. Record this value as the 
Mass of sample (After Degas). 

5. Remove the stopper and cap and attach the sample tube to the analysis port, pushing it 
fully up. Secure it in place by screwing the connector nuts onto the analysis port 
connectors. Tighten the connector nuts by hand.

6. Insert the sample temperature thermocouple into the holder on the sample tube. 

7. Place the furnace onto the elevator.

8. Slide the insulator disk onto the sample tube. The insulator disk surrounds the sample 
tube when the furnace is raised, preventing heat loss and improving thermal 
stability.

9. Select Unit > Show Instrument Schematic to show the instrument schematic; if already 
displayed, proceed to the next step.

If the sample tube is not mounted to the analysis port immediately, either leave it on 
the degas port or remove it and insert the rubber stopper and cap into the sample tube 
openings.

Do not touch the sample tube or the heating mantle until they have reached room 
temperature. Touching the sample tube, heating mantle, or heating mantle clip could 
result in burns.

Thermocouple
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10. Select Unit > Enable Manual Control.

11. Select the furnace icon on the schematic; right-click and choose Raise. You may stop the 
elevator at any intermediate height by pressing the Spacebar.

Be sure the insulating disk seats properly on the top of the furnace.

Installing the Cold Trap Dewar

We recommend the following be observed when handling Dewars containing liquefied gases:

• Protect yourself by wearing 1) goggles (or a face shield), 2) an insulated or rubber 
apron, and 3) insulated gloves.

• When pouring liquefied gases from one container to another: 1) cool the receiving 
container gradually to minimize thermal shock, 2) pour the liquefied gas slowly to 
prevent splashing, and 3) vent the receiving container to the atmosphere.

• Use a plastic stirring rod when stirring substances in a Dewar containing liquefied 
gases (or other materials of extremely low temperature). Do not use a glass or metal 
stirring rod unless it is coated with some form of protective coating.

• Do not remove the mesh covering from the Dewar flask. 

• Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover 
over the Dewar’s opening. If an object of sufficient weight is accidentally dropped into 
the Dewar, shattering may occur.

Always handle Dewars with care. Any product incorporating a vacuum is a potential 
safety hazard and should be treated with caution. Always observe the precautions 
listed below. 
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Cold Trap Dewar

1. Fill the cold trap Dewar with a cryogen such as liquid nitrogen to about 5 cm (2 in.) from 
the top.

2. Hang the cold trap Dewar around the cold trap port as shown below.

3. Place the insulator/stopper over the Dewar opening as shown below.

Cryogens can cause frostbite injury. Wear safety glasses and insulating gloves when 
handling cryogens.

Cold Trap

Cold Trap Dewar
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Performing an Analysis

After the sample has been transferred to an analysis port and the elevator and furnace fully 
raised, you may begin automatic chemisorption preparation and analysis. The ASAP 2020 
Chemi allows you to perform single analyses or sequenced analyses.

Single Analysis

1. Select Unit > Sample Analysis; the Analysis dialog is displayed with the Start Analysis 
dialog positioned on top.

2. Choose the sample file to use with the current analysis and click OK; the Analysis dialog 
containing the parameters of the selected file is displayed. 

You cannot perform an analysis while calibration is in progress or if all calibration 
operations have not been performed.

Make sure the furnace is raised to its uppermost position. If it is not completely raised, 
hazardous conditions can result.

You can also accept the next sequenced number and create a new file. If you choose 
this method, however, you can only use the predefined files from the drop-down lists.
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3. Verify the sample’s mass; edit the value if required.

4. Click Start to begin the analysis. 

A graph will appear in the window when data begin to collect. After the analysis is 
complete, you can click Start on the final analysis window to begin another analysis. 

Sequenced Analyses

Performing several single analyses on the same sample can be tedious. The Analysis Sequence 
option on the Unit menu allows you to program the software to perform a sequence of analyses 
automatically.

1. Select Unit > Analysis Sequence to display the Analysis Sequence dialog.

2. Click Insert to display the Select Sequence File dialog.

Make sure you have created the sample information files required for the analyses 
before beginning this procedure. Refer to Creating Sample Information Files, page 4-5  
for step-by-step instructions on creating a sample file.

Make sure the furnace is raised to its uppermost position. If it is not all the way up, 
hazardous conditions can result.
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3. Choose a file from the Files list window, then click OK; the Analysis Sequence dialog  
appears again with the name of the sample information file displayed in the Sample File 
list box. 

Be sure to select files that have the No analysis (files that have not been used to perform 
an analysis) status for sequencing.

Repeat this step for as many analyses as required.

4. To generate reports automatically after each analysis, click Report Settings and select 
Report after analysis, then specify the report Destination. 

5. Click Start to begin the first analysis in the sequence. As soon as the analysis is started, 
the file name is removed from the sequence. 

If a calibration is in progress, you must wait for the calibration to complete before you 
can start the sequence.
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Listing File Statistics

You can generate a list of the following information on one or more files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status (sample information files only)

Perform the following steps to generate a list:

1. Select File > List > (file type); a dialog similar to the one shown below is displayed.

2. From the Files list window, choose the file(s). Tto include all files in the list, leave all 
files deselected.

3. At the Destination field, click on the down arrow and choose a destination for the list 
output. If you choose File as the destination, enter a name in the File name field (below 
the Destination field).

4. Click OK, a list for the requested file(s) is sent to the specified destination.

Not displayed for 
parameter files.
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Exporting Isotherm Data

The Export option on the File menu allows you to copy the isotherm data in the sample infor-
mation file and reformat it in ASCII text. If saved to a File, the data can be imported into 
applications, such as spreadsheets. Refer to Appendix D, Format of Exported Data, for 
record descriptions. 

1. Select File > Export; the Export Sample File dialog is displayed.

2. From the Files list window, select the file(s) to export. To choose multiple files, hold 
down Ctrl while making your selections.

3. Choose an output destination. If you choose File as the destination, the File name field 
(below the Destination field) is enabled so that you may enter a name (or you can accept 
the default). If you have selected multiple files, each file is exported as its file name with 
the extension .EXP.

4. Click OK; the file(s) is (are) exported to the specified destination.
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Generating Overlays

Use graph overlays to compare graphically the results for multiple samples. You may overlay 
the results of up to eight samples on top of a previously selected sample. 

Perform the following steps to overlay graphs:

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Select a sample on which you  to overlay graphs of other samples, then click OK; the 
Sample Information dialog is displayed.

3. Select the Report Options tab to display the Report Options dialog.

4. Make your selections.

5. Select the graph to overlay, then click Edit; a report options dialog  for that graph is 
displayed.

You cannot use the overlay function when using the Basic format; you must switch to 
the Advanced format to perform this operation.

Click to choose the Overlay 
Samples option.

Click to select the sample files 
containing the data to use in 
the overlay function.
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6. Select Overlay Samples; do any other editing.

7. Click OK to return to the Report Options dialog.

8. Click Overlays; the Graph Overlay Samples dialog is displayed.

9. Click Browse to the right of the Sample [n] field; the Plot Overlay Sample Selection 
dialog is displayed.

10. Select a sample, then click OK. You can choose up to eight samples in this manner.

11. After choosing the number of samples, click OK to return to the Report Options dialog.

12. Select Save to save the changes you have made. Even if you don’t save, all of the options 
regarding overlays and anything else are available as your reports are generated.

13. Select Reports > Start Report to display the Start Report screen; the name of your 
primary file is shown in the File name field.

Select this option.
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14. Select a destination for report output.

15. Click OK the reports containing the overlays you requested are printed to the requested 
destination.
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5.  FILE MENU

This chapter describes the file maintenance options used to create, edit, print, list, and export 
sample and parameter files.

Description

Listed below are brief descriptions of the commands on the File menu. Detailed descriptions 
follow this section.

Open Allows you to create a new sample or parameter file, or open 
an existing one. 

Save Saves the file in the active window. P

Save As Allows you to save the file in the active window under a new 
name. It can also be used to save a subset of a sample file as a 
parameter set. 

Close Closes the file in the active window.

Close All Closes all open files. 

Print Prints the contents of one or more files. 
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List Generates a list of certain information for specified sample or 
parameter files. 

Export Exports isotherm data from a sample information file in 
ASCII format..

Exit Exits the ASAP 2020 Chemi program. 
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Open

Open enables you to create a new sample or parameter file, or to edit an existing one

Select the file type; a dialog similar to the following is displayed:

File name For sample information files, this field contains the next 
sequenced file name (as specified in sample defaults) 
generated by the system. If this is a new file, you can use the 
name displayed or enter a different one.

For parameter files, the name displayed includes the wild 
card (*) and the default extension as follows:

*.DEG for degas conditions
*.ANC for analysis conditions
*.RPO for report options

If you are creating a new file, enter a name in the File name 
field. 

If you are opening an existing file, select the name from the 
Files window, then click OK.

Title bar displays the 
type of file you are 
opening or creating; in 
this example, a sample 
information file.
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Date Range Click this button to display files created within a certain 
range of dates.

Status Drop-down list of the types of sample files you can display 
in the Files window. All files of the type you choose, within 
the range of dates, and within the current directory are 
displayed. This option does not display for parameter files. 

Refer to , page 3-9 for a description of the file types.

Directories Displays the current directory (folder). You can navigate to a 
different directory by clicking in the Directories list window 
or by entering the directory in the File name field.

The more files in a directory, the longer it may take to access 
a file. Therefore, it is a good practice to limit the number of 
files in a directory to approximately 200.
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Sample Information

Sample information files contain data that guide the analysis. They consist of:

• sample information
• degas conditions
• analysis conditions
• report options
• collected (after analysis) or manually entered data

Parts of the sample information file can also exist as standalone parameter files. Having these 
files exist independently allows you to use them as many times as needed. For example, if you 
typically use the same analysis conditions for many of your analyses, you can create an analy-
sis conditions file containing the conditions. Then when you create your sample file, select 
that file for your analysis conditions; the values will be copied into the sample file. After it 
becomes part of the new sample file, you can edit it in any way needed. The file from which 
the values were copied remains intact and ready for the next use.

Sample information files reside in a folder, more commonly referred to as a directory. The 
more files in a directory, the longer it may take to access a file. Therefore, it is a good practice 
to limit the number of files in a directory to approximately 200. You may create additional 
directories as needed. Refer to the operating system manual for more information.

Sample information files can be created and presented in the Advanced, Basic, or Restricted 
format. 

• Advanced
Presents all parts of the sample information file in a tabbed dialog. Each tab opens its 
associated dialog, allowing you to edit conditions.

• Basic
Presents all parts of the sample information file as a single dialog. This format allows 
you to create quickly a sample information file using predefined parameter files. You 
can also switch to the Advanced format.

• Restricted
Identical to the Basic format except that you cannot switch to the Advanced format for 
editing. Certain functions also are disabled.
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Advanced Format

The Advanced format of a sample information file displays all parts of the sample file in a 
tabbed dialog. Quick-access tabs enable you to move quickly and easily among the parame-
ters; or you can use Prev and Next.

Your selection of the type of data (Automatically collected or Manually entered) on the 
Sample Information dialog determines whether the Collected Data or Entered Data tab 
appears. In the following example, the tab displays Collected Data because Automatically 
collected is selected as the type of data. 

Refer to Advanced Format, page 4-6 for step-by-step instructions for creating an Advanced 
sample information file.

The prompts for the Sample, Operator, Submitter, and Bar Code fields may be customized 
by selecting Options > Sample Defaults (refer to Sample Defaults, page 8-6).

Sample Contains the description of the current sample file. 

If this is a new file, this field contains the next sequenced file 
description based on the format specified in Sample 
Defaults.

You can enter a new description or edit the existing one.
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Operator
Submitter

Displays the operator and submitter names of the current 
sample file.

If this is a new file, these fields contain the names specified 
in Sample Defaults. 

You can enter a different name or edit the current one.

Bar Code This field enables you to enter bar code information. If bar 
code information is not used, you can use this field to enter 
additional information about the sample; for example, to 
enter the lot number of your sample. 

This field, as well as the Operator and Submitter fields, 
will accept data from a bar code reader.

Mass Enter the sample’s mass. If you are using the Sample Data 
Worksheet, enter the value recorded as Mass of Sample 
After Degas.

The value in this field is used in report calculations; 
therefore, it should be exact. To ensure accuracy, reweigh the 
sample after analysis. If the value is not equal (or very close) 
to the one entered for Mass of Sample After Degas, you 
may want to change the value to Mass of Sample After 
Analysis.

If you use a backfill gas that is different from the analysis gas, the sample’s mass after 
degas will not be equal to its mass after analysis. For example; if you use nitrogen to 
backfill after degassing and helium after the analysis, the sample’s mass can vary as 
much as 0.02 gram.

Type of Data Displays the type of data for the current sample file.If this is 
a new file, choose Automatically collected to have data 
collected automatically, or Manually entered if you plan to 
enter data collected from another source.

Comments Allows you to enter pertinent information about the sample 
or analysis. The information you enter in this window is 
displayed in the report header. 
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Basic Format

The Basic format displays all parts (parameters) of the file on a single dialog. With this format, 
you can quickly create a sample information file using predefined parameter files. You can 
also switch to the Advanced format if a specific parameter requires editing. 

Refer to Basic and Restricted Formats, page 4-5 for step-by-step instructions for creating a 
sample file in the Basic or Restricted format.

Replace All Use this button to replace the values of all parameters of the 
current file with those from an existing one. You can edit the 
values after they have been copied into the current file; 
editing the current files will not affect the file from which 
they were copied.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog. If the dialog contains changes that have 
not been saved, you will be prompted to save them before 
the dialog closes.

Basic Switches the sample editor to the Basic format.

If you are creating a new file, this dialog displays the defaults you specified in Sample 
Defaults. Chapter 8 explains how to establish sample defaults.
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Sample Contains the description of the current sample file.

If this is a new file, this field contains the next sequenced file 
description based on the format specified in Sample 
Defaults. The above dialog shows the sample file number 
because the dollar ($) symbol was included when sample 
defaults were specified.

You can enter a new description or edit the existing one.

Mass Allows you to enter the sample’s mass. If you are using the 
Sample Data worksheet, this is the value recorded for Mass 
of Sample After Degas.

Degas Conditions
Analysis Conditions
Report Options

Each parameter field contains the description of the current 
parameter file.

If this is a new sample file, these fields contain the descrip-
tions of the files chosen as the defaults.

Click on the down arrow to the right of each field to choose 
a different file. File parameters can be viewed or edited by 
switching to the Advanced format.

Replace all Use this button to replace all parameters of the current file 
with those copied from an existing one. A dialog is 
displayed allowing you to choose the file.

Save Saves all parameters of the current file; the dialog remains 
open.

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format, 
allowing you to view or edit parameters of the current file.
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Restricted Format

The Restricted format is used when analysis parameters must remain constant. For example, in 
the pharmaceutical industry where consistency and accuracy are crucial. A password is 
required to enter and exit this format. Refer to Restricted, page 8-5 for additional information 
on the Restricted format.

When you open an existing sample information file or create a new one using the Restricted 
format, all parts of the sample file are displayed in the same manner as the Basic format. Some 
menu functions, however, are disabled and you cannot switch to the Advanced format to edit 
file parameters.

This dialog is identical to the 
Basic dialog except that it does 
not allow you to switch to the 
Advanced format.
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Degas Conditions

This dialog is used for specifying degas conditions and is applicable only if your ASAP 2020 
Chemi is equipped with the SmartVac degas option.

Refer to Degas Conditions, page 4-8 for step-by-step instructions on creating a degas condi-
tions file.

Description Contains the description of the current Degas Conditions file.

If this is a new file, this field contains the name (description) 
you specified as the default. You can enter a new description 
or add to the existing one.

Replace Use this button to replace the current degas conditions with 
those from another file. The Open Degas Conditions File 
dialog is displayed, allowing you to choose the file. 

Evacuation Phase group The options in this group box allow you to specify conditions 
for the evacuation phase of the degassing operation.

Temperature ramp 
rate

Allows you to specify the rate at which the temperature is to 
change while advancing to the target temperature during 
evacuation.

Target temperature Allows you to specify a temperature at which the sample will 
be held for the remainder of the evacuation.
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Evacuation rate Allows you to specify an evacuation rate for initial 
evacuation.

Unrestricted evac.
from

Allows you to specify a pressure at which unrestricted sample 
evacuation will begin.

Vacuum setpoint Allows you to specify the vacuum level to be achieved before 
evacuation begins.

Evacuation time Allows you to specify how long the sample is to be evacuated 
prior to the second state of heating.

Heating Phase group The options in this group box allow you to specify conditions 
for the heating phase of the degassing operation.

Ramp rate Allows you to specify the rate at which the temperature will 
change while advancing to the hold temperature.

Hold temp Allows you to specify a temperature at which the sample is to 
be held during degassing.

Hold time Allows you to specify how long the sample is to be held at 
the specified temperature before beginning to cool down.

Hold pressure If during the temperature ramp the pressure exceeds the value 
you enter in this field, the ramp will be suspended until the 
pressure returns to a safe level.

Backfill sample tube Select this option to have the sample tube backfilled. It is 
recommended that you backfill after degas.
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Analysis Conditions 

Analysis conditions specify the data, or tasks, used to guide the analysis. This section 
describes the analysis conditions options available on the ASAP 2020 Chemi system. An anal-
ysis conditions file may exist as an independent file or as part of the sample information file.

The types of analysis conditions files included as samples with the ASAP 2020 Chemi System 
are described in Appendix E, Default Files and System Files, page E-1.

Refer to Analysis Conditions, page 4-9 for step-by-step instructions on creating an analysis 
conditions file.

Description Contains the description of the current Analysis conditions 
file.

If this is a new file, this field contains the identification spec-
ified in Sample Defaults. You can edit this name.

Replace Use this button to replace the values of the current file with 
those of another; a dialog allowing you to choose the  file is 
displayed. After the values are copied into the current file, 
you can edit them in any way.
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Analysis Termination 
group box

The options in this group box are enabled when you choose 
Automatically collected as the type of data on the Sample 
Information dialog. These options enable you to specify 
analysis conditions for termination of the analysis.

Select Cool to less than 50 ºC (323 K) to cool the sample to 
a temperature less than 50 ºC before the analysis terminates.

Select Backfill sample tube to choose a backfill gas. 

If you use a a backfill gas that is different from the analysis gas, the sample’s mass 
after degas will not be equal to its mass after analysis. For example, if you use 
nitrogen to backfill after degassing and helium after the analysis, the sample’s mass 
can vary as much as a 0.02 gram.

Available Tasks This window lists the tasks available. These tasks are 
disabled when you choose Manually entered as the type of 
data on the Sample Information dialog.

An experiment is defined by the tasks from which it is com-
prised. Tasks are executed in the order in which they are 
sequenced. You do not have to include all the tasks in an 
experiment. 

Choose a task by double-clicking on the task name or 
highlighting the task name and clicking Insert, the task 
dialog is displayed. After you define the task and click OK, 
the task name and task options appear in the Selected Tasks 
window.

The following tasks are available:

• Evacuation
• Flow
• Leak test
• Soak
• Analysis

A description of the dialog for each task is found in 
subsequent sections.

Selected Tasks This window lists the tasks selected (from the Available 
Tasks window) for the system to perform. 
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You cannot enter data if the ASAP 2020 Chemi program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.

Manually Entered 
Analysis Data

The options in this group box are enabled when you choose 
Manually entered as the type of data on the Sample 
Information dialog. These options enable you to enter   
analysis conditions. 

Adsorptive Choose the adsorptive used in the experiment which 
produced the data. Gases available in this list are those 
specified in the Gas Table Defaults dialog (refer to Gas 
Defaults, page 8-14 for more information). 

Temperature Enter the temperature at which the analysis was performed.

Free space Enter the free-space volume determined in the analysis.

Insert Allows you to insert a selected Task from the Available Tasks 
list; displays a pertinent dialog allowing you to enter values.

Remove Removes the selected task.

Edit Displays a dialog pertinent to the selected task, allowing you 
to view or edit the values.
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Evacuation Task Options

To ensure safe operation and reliable results, you should include an evacuation task under the 
following conditions:

• Between tasks using different gases
• Preceding a leak test
• Preceding an analysis

All fields on this dialog are disabled for sample files that have a Complete status.

Backfill gas Allows you to choose a gas for backfilling the sample tube 
prior to evacuation. Make sure the gas selected is either the 
one used in the previous task or helium. Refer to Gas 
Defaults, page 8-14 for information on changing gases.

If you do not want to backfill the sample tube prior to 
evacuation, select [-] (none). 

Evacuation The options in this group box allow you to specify 
conditions during evacuation. All options are disabled 
during analysis or if the analysis is complete.

Fast evacuation Select a fast evacuation for samples that do not fluidize or 
shed particles under evacuation (such as pellets). 

Unrestricted evac 
pressure

Enabled if you do not choose Fast evacuation. This value 
represents the pressure at which unrestricted sample 
evacuation begins.
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Vacuum setpoint Enables you to specify the vacuum level to be achieved 
before evacuation begins.

Evacuation time Enter the number of minutes for preliminary evacuation. 
Preliminary evacuation takes place prior to the free-space 
measurement. 

Temperature The options in this group box allow you to choose 
temperature options during evacuation. These options are 
disabled during analysis or if the analysis is complete.

Enter the temperature during evacuation in the Temperature 
field.

Enter the rate at which the temperature to change (ramp rate) 
in the Heat rate field.
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Flow Task Options

Gas Enables you to choose a gas for the Flow task. The gases in 
this drop-down list are those specified in the Gas Table 
Defaults dialog. Refer to Gas Defaults, page 8-14 for 
information on changing or adding gases.

Temperature Enter the temperature at which the gas is to start flowing. 

Heat rate Enter the rate at which the temperature is to change (ramp 
rate) while advancing to the target temperature.

Time Enter the duration of time the sample spends at the specified 
temperature.
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Leak Test Task Options

Temperature Enter the target temperature during the leak test.

Heat rate Enter the rate at which the temperature is to change (ramp 
rate) while advancing to the target temperature.

Outgas rate Entry in this field allows a system check for leaks or sample 
outgassing before the analysis. The leak test allows sample 
pressure to rise during the test. If the pressure rises more 
than the value in this field, the analysis proceeds but you are 
notified with an error message.

The results of the leak test are printed in the Options Report. 
Leak testing slightly increases analysis time, but it allows 
the program to notify you of any analyses which may 
contain erroneous results.
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Soak Task Options

Gas Enables you to choose a gas for the Soak task. Gases 
available are those specified in the Gas Table Defaults dialog. 
Refer to Gas Defaults, page 8-14 for information on 
changing or adding gases.

Temperature Enter the temperature at which soaking is to begin.

Heat rate Enter the rate at which the temperature is to change while 
advancing to the target temperature.

Time Enter the duration of time the sample is to soak at the 
specified temperature.

Minimum pressure Enter the minimum pressure to which the sample is to be 
exposed during soaking.
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Analysis Task Options

All fields on this dialog, as well as on the subdialogs accessed using the buttons, are disabled 
for sample files that have a Complete status.

Adsorptive This drop-down list allows you to select an adsorptive gas 
for the analysis. The gases listed are those specified in the 
Gas Table Defaults dialog. Refer to Gas Defaults, page 8-14 
for information on specifying adsorptive gases.

Temperature This group box allows you to select temperature options for 
the analysis. These options are disabled during analysis.

Type the analysis temperature in the Temperature field.

Type the rate at which the temperature changes in the Heat 
rate field.

Analysis Data This group box enables you to specify conditions for 
analysis.

Equilibration interval This is the number of seconds between successive pressure 
readings during equilibration. Long equilibration intervals 
tend to lengthen analyses but improve data integrity. Short 
equilibration intervals produce faster analyses but may 
reduce the accuracy of data.
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Relative/Absolute 
target tolerance

The values in these fields are used to determine how close 
the actual pressure must be to each target pressure from the 
pressure table. At lower pressures the relative tolerance 
value is smaller, and at higher pressures the absolute toler-
ance value is smaller.

For example, with relative tolerance = 5% and absolute tol-
erance = 5 mmHg, the relative tolerance at 40 mmHg target 
pressure is 5% of 40 mmHg, or 2 mmHg; 2 mmHg is smaller 
than the absolute tolerance of 5 mmHg, so 2 mmHg is used. 
At 200 mmHg target pressure, the relative tolerance is 5% of 
200 mmHg, or 10 mmHg; in this case, the absolute tolerance 
of 5 mmHg is smaller and is used.

In the above example, a minimum pressure of 40 - 2 = 38 
mmHg must be attained to collect data for a target pressure 
of 40 mmHg. For a target of 200 mmHg, 200 - 5 = 195 
mmHg must be attained.

Unnecessarily tight tolerances lengthen the analysis.

Repeat The options in this group box allow you to specify conditions 
for a repeat analysis.

Repeat analysis Select this option to repeat the analysis. The initial analysis 
measures chemisorption and physisorption activity. The 
repeat analysis measures only physisorption activity. The 
difference between the initial and repeat analysis is the 
chemisorption activity of the sample.

Fast evacuation Select this option for samples that do not fluidize or shed 
particles under evacuation (such as pellets). The check box is 
disabled during analysis.

Unrestricted evac 
pressure

Enabled when Fast evacuation is deselected. This reading is 
the pressure at which unrestricted sample evacuation is to 
begin.

Vacuum setpoint Enables you to specify the vacuum level to be achieved 
before evacuation begins.
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Evacuation time Enter the number of minutes for preliminary evacuation. 
Preliminary evacuation takes place at the start of a repeat 
analysis and at the start of the free-space measurement. 

Pressure Displays the Pressure Table dialog so that you may create or 
edit a pressure table. 

A pressure table is a table of pressure points at which data are 
to be collected and included in a line fit plot. The pressures 
may span the entire range from the lowest absolute value of 
0.0050 to the maximum value of 900.0000 mmHg.

Several analysis conditions files are included with the ASAP 
2020 Chemisorption software and can be found in the params 
subdirectory. Refer to Appendix G, Chemisorption Meth-
ods, for information on the contents of the default analysis 
conditions files. These files (and all other parameter files) can 
be edited. If you want to use any of the files in your analyses, 
it is recommended that you save any changes to the file under 
a different name. 

The pressure table for automatically collected data includes 
the pressure points for data collection and identifies which 
points are used in the line fit plot.

To enter a pressure point in the Pressure (mmHg) field: press 
Ctrl ↓ if you are at the top of the table, Ctrl ↑ if you are at the 
bottom of the table, or click Insert. The program inserts the 
next number based on the existing pressure point sequence. 
You may edit the number.
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Pressure

(continued)

The pressure table must contain a sequence of strictly ascend-
ing absolute pressures. You can enter a maximum of five 
hundred pressure points.

To specify whether a given pressure is included in the line fit 
plot and difference calculations, move the pointer to the 
pressure point and click the mouse pointer on it or press the 
spacebar. An X in the field indicates the calculation is 
selected.

Insert Inserts a row above the selected one; the cursor moves to the 
new line.

Delete Deletes the selected row.

Clear Removes all but one entry from the table; one entry is 
required. A warning message appears requesting 
confirmation before the table is cleared.

Low Pressure Displays the Low Pressure Options dialog, enabling you to 
enter or edit low-pressure options. 

Incremental Dose Mode Select this option to dose the sample successively with a 
specified amount of gas until the first pressure point is 
reached. Because the data points recorded during Incremental 
Dose Mode may define most of the analysis, one point on the 
pressure table can be sufficient and serve as the end point for 
the analysis. This mode measures equilibrium points at 
approximately equal intervals on the volume adsorbed axis. 
Each dose is fully equilibrated and recorded as a data point.

Dose amount The amount of gas added to the sample for each data point 
until the first point on the pressure table is reached.
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Dose delay The amount of time the adsorptive remains in the manifold 
before being dosed onto the sample. This delay enables the 
gas to reach thermal equilibrium with the manifold before 
being dosed onto the sample.

Free Space Displays the Free Space Options dialog so that you can 
specify free-space measurement conditions. 

Measure Select this option to have free space measured automatically 
by the system during analysis. The radio button is disabled 
during analysis. It is also disabled when analysis is complete 
if free space was not measured during analysis. Type the 
sample tube gas capacity in the Estimated free space field.

Enter Select this option to enter free space manually. The option 
may be necessary if the sample retains helium, and 
measurement of pressures below 0.1 mmHg is required. (The 
radio button is disabled during analysis.) Type the sample 
tube gas capacity in the Free space field.

If you change the entered free-space value after the preliminary analysis stage is 50% 
complete, the change does not affect the analysis.
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Report Options

Report options specify the types of reports generated from an analysis or manually entered 
data. They also help you customize details of reports such as axis scale, axis range, and col-
umn headings. A report options file may be created as an independent file, or as part of a 
sample information file.

Refer to Report Options, page 4-11 for step-by-step instructions on creating a report options 
file.

Description Contains the description of the current Report Options file.

If this is a new file, this field contains the description you 
specified as the default. You can enter a new description or 
add to the existing one .

Show report title Select this option to have a title display on your report; the 
adjacent field is enabled allowing you to enter the title.

If this is a new file, the title you specified as the default is dis-
played. Accept the default title or enter a different one. 

If you deselect this option, a title will not display on your 
report(s).
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Show graphic Select this option to have an illustration display above the 
report title. For example, to display your company logo. You 
can use a bitmap (bmp) or an enhanced metafile (emf).

Click Browse to choose the graphic, then enter the height 
and width in the appropriate fields. This image can also be 
edited from the report window.

Replace Allows you to replace the values in the current report options 
file with those from an existing file. A dialog is displayed so 
that you may select the file. Click OK and the values are 
copied into the current file automatically. You can edit the 
values in the new file; it will not change anything in the file 
from which they were copied.

Overlays Displays the Graph Overlay Samples dialog so that you can 
choose the sample files to use in the overlay function.

Click Browse to the right of each field to choose the file; you 
may choose up to eight files.

Click Clear to clear the field of its entry.
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Reports Selected Lists the available reports. Choose a report by double-
clicking on the report name or highlight the report name and 
press the Spacebar. A report is selected when it is preceded 
with a check ().

The following reports are available:

• Isotherm
• Analysis
• Langmuir surface area
• Freundlich
• Temkin
• Options
• Sample Log

Edit Displays an associated dialog for the selected report. Editing 
options for available reports are shown in the following 
sections. 

This button is disabled for the Options and Sample Log 
reports.

Active Metals Displays the Active Metals Table Options dialog allowing 
you to specify the characteristics of up to fifteen elements 
used in your analysis.

Element The active metals appearing on the pull-down list are those 
specified in the Active Metals Table Defaults dialog. You can 
customize the Active Metals Table Options dialog by adding 
active metals listed in Appendix F, page F-1
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Atomic Weight The atomic weight of the element.

Atomic Cross. Sect. Area 
(nm2)

The atomic cross-sectional area of the element.

% of Sample Weight The percentage of the sample weight occupied by the 
element.

Density Lists the element’s density.

Adsorptive Use this button to specify the stoichiometry factors for each 
adsorptive associated with a selected element. The 
adsorptives and stoichiometry factors for the selected element 
appear:

Adsorptive
Gases available are those specified in the Gas Table Defaults 
dialog. Refer to Gas Defaults, page 8-14 for additional 
information.

Stoichiometry Factor
A factor which expresses the ratio between the number of 
active metal molecules and the number of adsorbate 
molecules.

Insert Inserts a row above the current line. 

Delete Deletes the current row.

Clear Removes all but one entry from the table; one entry is 
required. A warning message appears requesting 
confirmation before the table is cleared.
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Isotherm Report Options

The isotherm report indicates adsorption of a gas by a solid held at constant temperature. 

Print tabular report Select this option to have collected data printed in a tabular 
format.

Plot data Select this option to have data plotted as a graph. 

Analysis Includes a line fit plot on the report for the primary analysis. 

Repeat analysis Includes a line fit plot on the report for a secondary analysis. 

Overlay samples Select this option to overlay the current plot with those of 
other samples. Click Overlays on the Report Options dialog 
to choose the sample files.

Plot curve 
Plot points

Use these options to specify in which manner to have the 
data plotted. You can plot data as a curve, points, or both.

X-Axis Scale Enables you to have the x-axis displayed on a logarithmic or 
linear scale.
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Autoscale Options Select Autoscale to have the X- and/or Y-axes automatically 
scaled. Linear X-axes begin at zero, and logarithmic X-axes 
begin at an appropriate value. Y-axes begin at zero. The 
system uses the highest values collected during analysis as 
the ending points for axes ranges. 

From/To fields Enabled when you choose not (deselect) to AutoScale, 
allowing you to specify beginning and ending values for the 
X- and Y-axis ranges. Data collected outside these ranges are 
not included in the plot.

The value entered in the To field must be greater than the 
value entered in the From field.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the volume of gas adsorbed.
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Analysis Report Options

The analysis report consists of a summary page, a tabular report, and a line fit plot.

Print analysis summary Select this option to print a summary of analysis and/or 
difference results. 

Show Analysis results generates a summary of the follow-
ing for the first analysis:

• Percent metal dispersion
• Metallic surface area
• Volume adsorbed
• Slope
• Correlation coefficient

Show difference results generates a summary of the differ-
ences between the following information for the first and 
repeat analyses:

• Percent metal dispersion
• Metallic surface area
• Average difference volume

Print tabular report Select to have analysis data printed in a tabular format.

Plot Data Select this option to produce a graph showing the line fit 
difference between the analysis and repeat analysis. 
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Analysis Includes a line fit plot for the primary analysis. 

Repeat analysis Includes a line fit plot for the secondary analysis. 

Difference Plots the difference between the analysis and repeat analysis 
lines.

Overlay samples Allows you to overlay data from the current sample with that 
of other samples. Click Overlays on the Report Options 
dialog to choose the other sample files.

Crystallite size Allows you to choose the crystallite shape of your sample, or 
to enter one.

Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.

Axis Range These fields are enabled if you deselect AutoScale, allowing 
you to specify beginning and ending values for the X- and Y-
axis ranges. Data collected outside these ranges are not 
included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the volume of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Langmuir Surface Area Report

Print tabular report Select this option to have a tabular report of the plotted data.

Langmuir transform plot Generates a traditional Langmuir surface area plot that is 
used to determine monolayer volume and BET C constant.

Langmuir isotherm plot Uses the Langmuir monolayer volume and constant to 
produce an isotherm.

Overlay samples Select this option to overlay the current type plot with those 
of other samples. Click Overlays on the Report Options 
dialog to choose the other sample files.

Autoscale Options Select these options to have the X- and/or Y-axes automati-
cally scaled. The system uses the highest values collected 
during analysis as the ending points for an axis range.

From/To These fields are enabled if you choose not (deselect) to 
AutoScale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the volume of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Freundlich Report

The Freundlich isotherm is an empirical isotherm that is used to model low-pressure adsorp-
tion data. It can also be applied to model some micropore isotherms.

Specify the monolayer 
capacity

In this field, enter the monolayer capacity of the sample.

Print tabular report Select this option to have a tabular report of the pressure 
points generated.

Freundlich transform plot Plots the linear form of the Freundlich equation.

Freundlich isotherm plot Plots the absolute pressure vs quantity adsorbed. Shows best 
fit line.

Overlay samples Choose this option to overlay data from the current file with 
the same type of data from other samples (files). Click Over-
lays on the Report Options dialog to choose the other files.

Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.
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From/To These fields are enabled if you choose not (deselect) to 
AutoScale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the volume of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Temkin Report

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops lin-
early with increasing coverage.

Specify monolayer capacity In this field, enter the monolayer capacity of the sample.

Specify differential heat of 
adsorption at zero surface 
coverage

Enter the differential heat of adsorption at zero surface 
coverage. This allows inclusion of all Temkin constants.

Print tabular report Select this option to have a tabular report of the pressure 
points generated.

Temkin transform plot Plots a linear form of the Temkin isotherm.

Temkin isotherm plot Overlays the Temkin isotherm with the analysis data. 

Overlay samples Choose this option to overlay data from the current file with 
the same type of data from other samples (files). Click 
Overlays on the Report Options dialog to choose the other 
files.
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Autoscale Options Select these options to have the X- and/or Y-axes 
automatically scaled. The system uses the highest values 
collected during analysis as the ending points for an axis 
range.

From/To These fields are enabled if you choose not (deselect) to 
AutoScale, allowing you to specify beginning and ending 
values for the X- and Y-axis ranges. Data collected outside 
these ranges are not included in the plot.

The X-Axis Range fields show the pressure.

The Y-Axis Range fields show the volume of gas adsorbed.

Valid ranges for these fields are shown in the information bar 
across the bottom of the dialog.
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Options Report

The Options Report is a predefined collection of sample information file parameters printed by 
selecting Options from the Report Options dialog. You cannot edit this report.

If Type of Data is Automatically collected, the following information appears on the report:

Redundant data appear in the Task Summary and the Experiment Log if the instrument is 
performing correctly.

If Type of Data is Manually entered, only the adsorptive gas, sample temperature, and free-
space volume are reported.

Sample Log

The Sample Log report provides the following statistics:

• manual control operations performed during analysis
• information entered using on the sample file editor
• warnings and/or errors that occurred during analysis

Task Summary Lists conditions you specified for each task selected.

Analysis Task Options Details conditions you specified for the analysis task.

Experiment Log Identifies actual conditions under which each task 
transpired.

Leak Test Results Identifies outgas rates and the outcome for each leak test 
performed.
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Collected/Entered Data

The Collected/Entered Data dialog displays after analysis is complete and when your option 
presentation is selected as Advanced. 

• If Automatically collected was selected as the type of data in the Sample Information dia-
log, the Collected Data dialog contains the data points collected during analysis and the 
specified calculation assignments. You can edit calculation assignments during or after an 
analysis.

• If Manually entered was selected as the type of data in the Sample Information dialog, the 
Entered Data dialog contains the manually entered data and calculation assignments. You 
can edit calculation assignments as well as the points in the table during or after an analy-
sis. Insert, Delete, and Clear become enabled allowing you to edit points.

You cannot enter data if the analysis program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.
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List

List enables you to display the following information on one or more sample or parameter 
files:

• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status (sample information files only)
• File name

The List dialog is common to all file types. 

File name If you select only one file from the Files list box, the name is 
copied to this field. If multiple files are chosen, the last one 
selected displays.

Copies Enabled when Printer is selected as the print destination. 
You may print up to four copies.

Destination You may send the list to the printer, the screen, or to a file.

File name (print) Enabled when you select File as the destination. A default 
file name appears. Use the default name or enter another file 
name. If you select multiple files, the information from all 
the files is copied into the file specified in this field.

Title bar displays the 
type of file you have 
chosen.

Does not display for 
parameter files.
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Export

Export copies the isotherm data in sample information files and reformats it in ASCII format. 
Refer to Appendix D, Format of Exported Data, for record descriptions. The data can then 
be imported into other applications accepting ASCII format, such as spreadsheets. 

Select File > Export to display the Export Sample File dialog.

File name The name of the file you choose to export is copied to this 
field. If you choose multiple files, the name of the last one 
selected is displayed.

Settings The options in this group box enable you to choose output 
options.

Copies Enabled when Printer is selected as the print destination, 
allowing you to print up to four copies.

Destination You may export files to a printer, to the screen, or to a file.

File name Enabled when you choose File as the print destination. For 
the exported name, you can:

• Accept the default value where all selected files you 
choose to export will have the same name as those in the 
sample information file with a .ISO extension.
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File name

(continued)

Enabled when you choose File as the print destination. For 
the exported name, you can:

• Accept the default value where all selected files you 
choose to export will have the same name as those in the 
sample information file with a .ISO extension.

For example, the following chart shows the selected files 
and export file names automatically assigned by the system 
when the default value is C:\DATA1\*.EXP:

Selected Files Export Names 

C:\DATA1\SAMP1.SMP C:\DATA1\SAMP1.ISO

C:\DATA1\SAMP2.SMP C:\DATA1\SAMP2.ISO

C:\DATA1\SAMP3.SMP C:\DATA1\SAMP3.ISO

• Enter the name of the file (full path name) receiving the 
ASCII data. The extension does not have to be .EXP.  To 
export more than one file, wildcard characters may be 
entered. For example, the following chart shows the 
selected files and export file names resulting when you 
enter: C:\DATA2\*.TXT:

Selected Files Export Names 

C:\DATA1\SAMP1.SMP C:\DATA2\SAMP1.TXT

C:\DATA1\SAMP2.SMP C:\DATA2\SAMP2.TXT

C:\DATA1\SAMP3.SMP C:\DATA2\SAMP3.TXT
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6.  UNIT MENU

The Unit menu contains the options for the operations that can be performed with the ASAP 
2020 Chemi analyzer. The main menu will contain a Unit menu for each attached analyzer. For 
example, if you have two attached analyzers, the main menu contains two Unit menus. The 
appropriate unit number and serial number display in the title bar of the operational windows. 
The status windows also display in different colors. This feature is especially useful when you 
have more than one analyzer attached to the same computer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 
later in this chapter.

The Unit menu does not display on the menu bar if the analysis program is being used 
for offline data manipulation on a computer other than the one controlling the 
analyzer.

Sample Analysis Starts an analysis. This option is disabled if analyses are in 
progress. Page 6-3.

Analysis Sequence Allows you to schedule a series of analyses. Page 6-7.

Start Degas Allows you to begin the degassing operation on one or two 
samples. Page 6-9.
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Enable Manual Control Allows you to control certain components of the system 
manually. Page 6-10.

Show Instrument Schematic Displays a schematic of the analyzer components. Page 6-14.

Show Status Shows the status window of the operation in progress. Page 
6-15.

Show Instrument Log Displays a log of recent analyses, calibrations, and error 
messages. Page 6-16.

Unit Configuration Displays the configuration of the analyzer. Page 6-18.

Diagnostics Enables you to perform certain diagnostic tests. Page 6-21.

Calibration Enables you to calibrate certain components of the analyzer. 
Page 6-23.

Degas Enables you to perform operations associated with degassing 
the sample. Enabled only if the SmartVac is installed. Page 6-
25.

Service Test Enables you to perform certain troubleshooting procedures. 
This option is enabled only with the direction of a 
Micromeritics service representative. Page 6-30.
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Sample Analysis

When you select this option from the Unit menu, the Analysis dialog is displayed with all 
fields disabled (greyed) and the Start Analysis dialog positioned on top. This allows you to 
select an existing sample file for your analysis or to create a new one.

After a sample file has been designated, the Analysis dialog is fully displayed. The fields now 
contain the values for the selected file or, if creating a new file, the specified defaults. 

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Refer to Show Instrument Log, page 6-16 and Show 
Instrument Schematic, page 6-14 for additional 
information.

Browse Displays the Open Sample Information dialog allowing you 
to choose a different sample file for your analysis.

Sample Displays an identification of the sample file you choose.
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Mass Allows you to enter an accurate value for the sample mass.

Analysis Conditions Displays the name (identification) of the Analysis Conditions 
file for the current sample file.

If this is a new file, this field contains the name you specified 
as the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory (Chap-
ter 8). Some files were also shipped with the analysis 
program. You may choose a different file from this list.

Report Options Displays the name (identification) of the Report Options file 
for the current sample file.

If this is a new file, this field contains the name you specified 
as the default.

The drop-down list contains a list of predefined parameter 
files that were saved to the Parameter Files Directory 
(Chapter 8). Some files were also shipped with the analysis 
program. You may choose a different file from this list.

Report After Analysis Displays the Report Settings dialog so that you may specify 
report output options. If you choose Screen, reports have 
many options for being customized and manipulated.

Report after analysis Select this option to have reports generated automatically 
after analysis. If you do not select this option, you can 
generate the report using the Start Report option on the 
Reports menu.

Copies Enabled when Printer is selected as the destination, allowing 
you to print up to four copies.
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Destination Allows you to have reports printed to the Screen, Printer, or 
to a File. If you choose Screen, many options are available 
for customizing your report.

File name Enabled when you choose File as the destination for report 
output. You can enter a name or accept the default, which is 
the same name as the sample file with an RPT extension. 

Start Begins the analysis; displays an analyzing view of the 
Analysis dialog. A graph will be drawn as data are collected.

Skip Skips the current step of the analysis.

Use the Skip function with caution; the ASAP performs multiple steps for a given task. 
Skipping certain steps may cause corruption of data, instrument damage, or personal 
injury.

Suspend Suspends the analysis.

Resume Resumes a suspended analysis.

Cancel Cancels the analysis.
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Start On this view of the Analysis dialog, this button changes to 
Next when the analysis is finished.

Next Returns you to the first view of the Analysis dialog so that 
you may schedule another analysis.

Close Closes the dialog.
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Analysis Sequence

This option allows you to perform a series of analyses using sample files ready for analysis. 
Sample files cannot be created at the time of analysis when performing sequenced analyses. 
When you select this option, the Analysis Sequence dialog is displayed.

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log
• results

Report Settings Displays the Report Settings dialog so that you can specify 
report output. The options on this dialog are explained in the 
previous section.

Sample File window Contains the files you choose to use with your analyses.

Insert Displays the Select Sequence File dialog so that you can 
choose the sample files to use with your analyses. The file 
you choose is inserted above the line you have selected in the 
Sample File window. This button is not available while 
analyses are in progress. If you need to add a file name to the 
sequence, click Suspend, insert the new file name, then click 
Start to restart the sequence.
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Edit Allows you to choose a different file to replace the selected 
file name.

Delete Deletes the selected file name from the sequence. You cannot 
delete the file name for an analysis in progress because the 
system removes the file name from the sequence as soon as 
the analysis begins. This button is not available while the 
sequence is in progress. Click Cancel to stop the sequence, 
select the file name you want to delete, click Delete, then 
click Start to restart the sequence.

Clear Removes all file names from the sequence. You cannot clear 
the sequence while analyses are in progress. Click Cancel to 
stop the sequence and then click Clear. 

If you weigh the sample after analysis, make sure you enter the new sample’s mass in 
the Sample Information file before starting reports.

Status window Refer to Show Status, page 6-15 for an explanation of this 
window’s contents.

Start Starts the sequence of analyses.

Cancel Stops a sequence in progress. If an analysis is in progress, it 
continues.
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Start Degas

Displays the Automatic Degas Operation dialog, allowing you to choose files and start degas 
operations on one or two samples.

Sample Click Browse to the right of this field to select a sample file 
that will be used with the current sample.

Degas Conditions Displays the description of the degas file that is part of the 
chosen sample file. You can choose a different Degas 
Conditions file from the drop-down list. If you choose a 
different file, the values in the current file will be overwritten 
with the values of the new one.

Clear Clears the sample file from the port assignment. If you plan 
to use another sample file, click Browse to choose the file.

Start Starts the degassing operation.

Cancel Closes the dialog, cancelling any information entered.
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Enable Manual Control

Select this option to control certain components of your system manually. If the instrument 
schematic is not displayed, select Show Instrument Schematic.

When you enable manual control, the color for the valve symbols changes to yellow if closed, 
and green if open. 

Use the mouse pointer to select a component. A component is selected when it is surrounded 
by a thin line. Each component has a shortcut menu displaying the operations available for that 
particular component. These menus may be accessed by right-clicking on the component, or 
by using the shortcut keys Shift + F9.

You can open and close valves, and raise or lower the elevator by using one of the following 
methods:

• access the shortcut menu and select the appropriate action
• double-click on the valve or elevator symbol
• select the valve or elevator symbol and press the spacebar

Valves System valves and their functions are listed in Table 6-1.

Actions:  Open, Close, Pulse

Pulse briefly opens and closes (or vice versa) the valve.Open Closed
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Table 6-1.  System Valves

Valve Description

1 Unrestricted vacuum

2 Restricted vacuum

3 Free-space measurement gas (helium)

4 Restricted analysis gas

5 Unrestricted analysis gas

7 Lower manifold isolation

9 Sample port

CV Vacuum valve, allows evacuation of chemisorption gas inlet 
manifold

CS Supply valve, supplies gas to manifold for chemisorption oper-
ation 

C1 through C6 Gas inlet port valves for chemisorption operation

X Exhaust from sample tube to gas flow meter, located at sample 
port above furnace

PV Vacuum valve, allows evacuation of physisorption gas inlet 
manifold

PS Supply valve, supplies gas to manifold for physisorption 
operation 

P1 through P6 Gas inlet port valves for physisorption operation

Furnace The furnace resides on the elevator. The following illustration 
shows the furnace and its displays

Actions: Set, Raise, Lower, Stop
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Set Displays the Furnace Options dialog allowing you to specify 
a furnace temperature and heat rate.

The temperature and heat rate you enter are displayed to the 
right of the furnace symbol (shown on the previous page).

Raise, Lower, and Stop Allow movement of the furnace on the elefvator.

The furnace is being raised; note position of arrow in 
the center of the furnace symbol.

The furnace is being lowered; note the position of 
arrow in the center of the elevator symbol. 

The furnace is stopped while being raised; it stops in 
the uppermost position.

The furnace is stopped while being lowered; it stops in 
the lowermost position.

Sample Tube The current sample tube temperature is displayed to the left 
of the sample tube.

Sample tube

Sample temperature
6-12                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020 Chemi Enable Manual Control
Manifold Temperature 
Transducers Vacuum Gauge 
Pressure

The group of rectangles on the left side of the schematic 
displays the temperature, the vacuum gauge pressure, and the 
transducers currently installed.

Manifold temperature

Installed transducers

Vacuum gauge pressure
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Show Instrument Schematic

Select this option to display a schematic of the ASAP 2020 Chemi analyzer. The schematic is 
a graphical representation of the plumbing system including system valves, the analysis sta-
tion, and the furnace position. The valves and furnace can be controlled from the schematic 
when Manual control is enabled. Refer to the previous section for an explanation of the com-
ponents displayed on the instrument schematic.

The state of the valves can be determined quickly by color representation even when manual 
control is not enabled:

• Green = open
• White = closed

To change the state of a valve, you must enable manual control.
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Show Status

A status window is shown across the bottom of all operational dialogs as well as the instru-
ment schematic. The Show Status option enables you to show only the status window. This 
frees up your computer screen allowing you to perform other tasks (such as creating or editing 
sample files), while still monitoring the progress of your analysis.

If you have multiple instruments attached to your computer, the status bar for each instrument 
is displayed in a different color. 

Analysis status bar Shows the progression of the analysis. This bar contains three 
stages:

• Preliminary: sample preparation; displays green during 
progression

• Analysis: data are collected; displays blue during progres-
sion

• Termination: the furnace lowers, and the sample is 
cooled and backfilled; displays grey during progression

All stages are displayed in red if the analysis has been 
suspended.

Analysis details The following analysis details are displayed:

Sample: Sample file number
Stage: Stage of the analysis (as in status bar)
Last Point: Last point and number of points requested
P: Pressure of last point
Est. Qty. Ads.: Quantity adsorbed
Run Time: Elapsed time since the start of analysis
Manifold Gas: Current manifold gas

Step details Provides details of the current step of the analysis.
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Show Instrument Log

Displays a log of recent analyses, calibrations, and errors or messages. By default, this infor-
mation is logged for a 7-day period for analyses and a 30-day period for messages and 
calibrations. You may change the time for which this information is retained in the Unit sec-
tion of the ASAP202C.INI file.

Analysis
Calibration
Messages

These options allow you to choose the type of entries 
displayed in the window. For example, select only the 
Calibration check box to display only calibration 
information.

Add Log Entry Enables you to make an entry in the instrument log that 
cannot be recorded automatically through the application 
software. For example, you may change the port filter. The 
field adjacent to the button allows you to enter the operation; 
the button is enabled when you make an entry in the field, 
allowing you to add the entry.

Report Generates a report of the Instrument log.
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Report Allows you to generate the log contents to a specified 
destination; the Log Report Settings dialog is displayed.

Use the Start Date field to specify a date at which to start the 
printout. You can specify a date using one of the following 
methods:

• Press F2 to clear the field so that you can enter a date

• Double-click in the field (or press F4) to display a calen-
dar to choose a date

• Press F3 to insert the current date

The Copies field is enabled when you select Printer as the 
destination, enabling you to print up to four copies. 

Choose the report destination in the Destination field. If you 
choose File as the destination, the File name field is enabled, 
allowing you to enter a name for the printed file (or you may 
accept the default).
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Unit Configuration

Select this option to view the current calibration settings, the date on which calibration was 
performed, and the software and hardware configuration of your system.

Volume Calibration Displays the system, lower, and reference volumes from the 
most recent calibration. It also displays the date and time the 
calibration was completed.

A/D Calibration Displays the following:

• The date and time the manifold temperature was last cali-
brated.

• The date and time the transducer offsets were last cali-
brated.

• The percent of nominal transducer scale in use, and the 
date and time the transducer scale was last calibrated.

• The date and time the vacuum gauge was calibrated.

• The date and time the sample thermocouple was last cali-
brated.
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Configuration Displays the following:

The hardware code specifying the hardware components (for 
example transducers) present in your analyzer. This code is 
provided so the Service Department may quickly identify 
your hardware configuration and provide prompt assistance. 
Hardware codes translate as follows:

E = 1000-mmHg transducer
G = 10- and 1000-mmHg transducers 
H = 1-, 10-, and 1000-mmHg transducers

• The identification number of the port being used to con-
trol the analyzer. 

• The serial number of the attached analyzer (active unit).

Software Versions The software versions of the MIC BIOS, Controller, and 
ASAP 2020 Chemi System software.

SmartVac 
Software Versions

The software versions of the MIC BIOS and SmartVac 
software. This group box is not displayed if the SmartVac is 
not installed.

Features The options currently enabled on your system (for example, 
Micropore or MultiGas).

Gas Displays the Gas Configuration dialog.

This dialog allows you to choose which gases are attached to 
each port of the analyzer. The numbers preceded with P are 
the physisorption gases and the ones preceded with C are the 
chemisorption gases.
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Board ID Displays the Board ID dialog so that you can view the 
statistics of the board contained in the requested slot of the 
computer. For example, this dialog shows statistics of the 
backplane board.
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Diagnostics

This option enables you to clean and verify gas lines when connecting or changing a gas. This 
option also allows you to perform diagnostic tests which your service representative may 
request. The data generated from these tests may be insignificant to you as a user, but can be 
very helpful to your service representative. Your service representative can view the results 
and may be able to resolve the problem, eliminating downtime and repair costs.

These tests generate files to the 2020Chem\Service\userdiag directory. Your service repre-
sentative will request that you E-mail or fax the files to him so that he may examine them. 

When you select Unit [n] > Diagnostics, the Service Test dialog is displayed:

View Allows you to view the current operation, the instrument 
schematic, or the instrument log in the Service Test dialog. 
Operation is the appropriate choice for tests.

Test Contains a list of diagnostic tests. These tests will always 
include the latest revision letter at the end of the test name.

Sequence Displays the test file number. This number is assigned auto-
matically and incrementally sequenced by the software each 
time a test is performed. This also serves as the name of the 
file that is generated to the userdiag directory, and will be 
appended with SVT. For example, the name of the file for 
the test shown in the above dialog is 0006.SVT.
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Report after test Select this option to have a report generated automatically 
after the test; page 6-4 provides an explanation of output 
options.

If you do not select this option, you can still have a report 
generated from the report window.

Cancel Cancels the test.

Next Begins the test; displays the next view of the Service test 
dialog. The second view of the Service test dialog may con-
tain a single pane or two panes, depending on the test 
selected.

Report (field) Contains a list of the reports that will be generated during 
this test.

Item [n] Lists the data in the two panes. Item 1 is the upper pane and 
Item 2, the lower pane.

Report Enables you to generate a report.

Cancel Cancels the test.
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Calibration

The options on this menu allow you to perform system calibrations. Only one calibration is 
enabled and can be performed without direction of a Micromeritics service representative. You 
must contact your service representative for performing other calibrations.

Pressure Zero

Displays the Calibrate Pressure Offset dialog.

This dialog allows you to evacuate the manifold and zero all transducers in the system. 
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Save to File

Use this option to save the current calibration settings to a file; the Select Calibration File dia-
log is displayed.

Load from File

Displays the Select Calibration File dialog (shown above) so that you can load a previously 
saved calibration file

File name Defaults to the next sequence number for calibration files. 
The sequence number consists of: xxx-yyy.CAL, where xxx 
= serial number of unit and yyy = sequence number. For 
example, the number listed in the above dialog represents 
the first calibration file for unit serial number 201.
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Degas

This option on the Unit menu is enabled if your ASAP 2020 Chemi is equipped with the 
SmartVac degassing option. The choices on this menu allow you to select operations for the 
SmartVac degasser.

Enable Manual Control

Select this option to control manually certain components of the degas operation. If the instru-
ment schematic for the SmartVac is not displayed, select Unit > Degas > Show Instrument 
Schematic.

Valves Degasser valves and their function are listed in Table 6-2.

Actions: Open, Close
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         Table 6-2  Degasser Valves

Show Degas Schematic

Displays the schematic (shown in the previous section) for the SmartVac.

Valve Description

D1 and D2 Sample port valves

D5 Vacuum valve

Unnamed Servo valve

D6 Servo isolation valve

D7 Gas inlet port valve

Heaters Actions: Set, Disable

Set displays the Port [n] Heater Settings dialog so that you 
can specify a ramp rate and target temperature. After you 
click OK and close the dialog, the settings are displayed 
directly below the heater symbol.

Disable cancels the settings.

Status window Displays the status of the current degassing operation(s). 
Refer to Show Status on the following page for information 
on the Status window.
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Show Status

This option allows you to monitor the degassing operation.

Sample Displays the sample file being used with the degassing 
operation for each port.

Status Displays the current stage of the degassing operation for each 
port.

Check Allows you to check the outgassing rate of the sample on the 
related port; the following actions occur:

• current degassing step is suspended (on both ports). 
Degassing can be checked after the vacuum setpoint has 
been attained, or during a temperature ramp and hold. If 
you choose this option during any other step, a message 
indicating the SmartVac is not in a valid state is displayed.

• vacuum valves are closed and the vacuum level monitored

• the Status window is displayed (if not already displayed). 
The Status window will indicate that the degas operation 
is being checked and will display the outgassing rate as it 
becomes available.

During the degas check, this button changes to Continue. 
When Continue is clicked, the valves open, the temperature 
ramp or hold continues, and the degassing operation resumes. 
If your outgassing rate indicated that the sample is rid of con-
taminants (minimal pressure increases), you can click Skip to 
advance to the next stage of the degassing operation. For 
example, if you check degassing after the setpoint is attained, 
Skip advances you to the ramping stage.
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Calibrate Pressure Zero

Use this option to evacuate the manifold and zero the transducer.

Stop Skips the current stage of the degassing operation for the port 
in which this button was selected.

Cancel Cancels the degassing operation for the port in which this 
button was selected.

Start Begins the calibration.

Status messages are displayed during this procedure, then 
the dialog closes automatically.
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Calibrate Servo

Use this option to calibrate the servo valve to the manifold pressure transducer. The servo 
valve should always be recalibrated after a pressure calibration has been performed. The Cali-
brate Servo Valve dialog is displayed.

Start Begins the calibration. The servo valve is used to fill and 
equilibrate the manifold. The pressure transducer readings 
are used to calibrate the servo set point. Status messages are 
displayed during this procedure, then the dialog closes 
automatically.

The other calibrations on the Degas menu require direction from a Micromeritics 
service representative.
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Service Test

Various service tests are included in the ASAP 2020 Chemi operating program. These tests can 
be enabled and performed only with the assistance of a trained Micromeritics service represen-
tative. These tests are designed to provide your service representative with instrument 
readouts, as well as to assist him in troubleshooting potential problems and, perhaps, eliminat-
ing unnecessary repair services. This service strategy allows you to conduct expert tests in less 
time than it would take to be trained in servicing the instrument properly.
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7.  REPORTS MENU

This chapter describes:

• how to start reports, page 7-2
• how to close reports, page 7-5
• how to open reports saved from the report window, page 7-5
• how to generate Heat of Adsorption reports, page 7-6
• the appearance of reports, page 7-9
• manipulation tools for onscreen reports, page 7-9

This chapter also contains examples of some of the reports available for the ASAP 2020 
Chemi analysis program beginning on page 7-19.

Description

Listed below are brief descriptions of the options contained on the Reports menu. Detailed 
descriptions follow this section.

Start Report Allows you to generate a report on data for a completed 
sample analysis, a sample analysis that is in progress, or on 
manually entered data. Page 7-2.

Close Reports Closes all open report windows. Page 7-5.

Open Report Enables you to open a report that was saved from the report 
window. Page 7-5.

Heat of Adsorption Allows you to generate a heat of adsorption report. 
Page 7-6.
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Start Report

Select this option to generate a report on a sample analysis; the Start Report dialog is 
displayed.

File name The name you select from the Files list box is copied to this 
field. If you select multiple files, only the last one selected is 
displayed.

Status This drop-down list determines the type of sample files 
displayed in the Files list window.

Date Range Use this button to specify a range of dates in which to display 
sample files.

Settings This group box contains print options.

Copies Enabled when you select Print as the destination; you may 
print up to four copies.
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Destination Displays a drop-down list of output destinations.

Printer generates reports to the default printer.

Screen generates reports to the screen. You can print a paper 
copy from the report window. Using this option allows 
flexibility for manipulating and customizing reports. Refer to 
Onscreen Reports, page 7-9.

File prints tabular reports of the requested file to a text file 
which can be viewed with a text editor or other text file 
manipulation tool.

File name Enabled when you select File as the destination. Allows you 
to enter a name, or you may accept the default.

Files list window Displays a list of the available sample files for the choice 
shown in the Status field.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above 
the Directories list window.
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If you choose a single sample file, the Reports to Generate dialog is displayed. The reports 
selected are the ones you specified in the sample file. This dialog allows you to deselect 
reports or select additional ones.

Double-click on the report(s) to select (or deselect). Alternatively, you can highlight the report 
and press the Spacebar. A report is selected when it is preceded with a check mark. After you 
make your report selection and click OK, the requested reports are sent to the specified 
destination.

If you choose more than one file, this dialog is not displayed. The reports you specified in each 
sample file will be generated.

Check marks indicate 
a report is selected.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select close on each report window. This option is unavailable if reports are being generated.

Open Report

This option enables you to open a report that was saved from the Report window; the Open 
dialog is displayed. 

After you navigate to the directory, select your file, and click Open, your report is displayed in 
the Report window.
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Heat of Adsorption

The isosteric heat of adsorption is an important parameter for characterizing the degree of cat-
alyst surface heterogeneity, providing information about catalyst activity under specific 
chemical reaction conditions. Multiple adsorption isotherms are obtained on the same sample 
using the same adsorptive but at different temperatures to obtain the heat of adsorption.

This option allows you to choose the sample files, define the quantities, and generate a Heat of 
Adsorption report; the Heat of Adsorption dialog is displayed.

Table Contains the files you choose; also lists the quantity 
adsorbed. 

Add Samples Displays the Select Samples dialog so that you can choose 
files. 

Remove Sample Removes the selected sample from the list. If no samples are 
selected, the last one is removed.

Clear Samples Removes all samples from the list.
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Edit Quantities Displays the Edit Quantities Adsorbed dialog so that you can 
specify the range of surface coverage to include in the heat of 
adsorption report.

Quantity Adsorbed 
table

Allows you to enter the points.

Insert Range Displays the Insert Quantity Range dialog.

This dialog allows you to specify the starting and ending 
quantities adsorbed, as well as the number of points to insert 
within the specified range.

Insert Inserts a row above the selected row.

Delete Deletes the selected row.
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Clear Clears the entire table of all entries except one; one is 
required.

Load Table Allows you to import a previously saved table.

Save Table Allows you to save the current table as a file (QNT).

Report Settings The options in this group box allow you to choose report 
criteria.

Show report title Choose this option to have a title display in the header of 
your report; use the adjacent field to enter the title.

Show graphic Allows you to have a graphic appear in your title; for 
example, to show your company logo. You can use a bitmap 
(bmp) or an enhanced metafile (emf). Use the Height and 
Width fields to specify a size.

Copies Enabled when you choose Printer as the destination, 
allowing you to print up to four copies of your report(s).

Destination You can generate reports to the Screen, a Printer, or to a 
File.

File name Enabled when you choose File as the destination, allowing 
you to enter a name (or you can accept the default).

Tabular report Choose this option to have a tabular report generated.

Isostere plot Choose this option to generate a graph showing quantities of 
gas adsorbed versus the temperature.

Heat of adsorption plot Choose this option to have the heat of adsorption data plotted.

Open Enables you to open a previously saved report.

Save Saves the current report.  

Report Generates the report.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics.

• Tabular and graphical reports contain sample and instrument statistics such as date and 
time of analysis, analysis conditions, background data, and so forth.

The headers for these reports also contain notes of any changes to the sample file which 
occur after analysis.

• Summary report headers contain the same type of information displayed in tabular and 
graphical reports with the exception of notes.

Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar, page 7-10
• shortcut menu, page 7-13 
• zoom feature, page 7-17
• axis cross hairs, page 7-18 

When reports are printed to the screen, they are printed in a window like the one shown below. 
Each requested report is listed in the Reports window on the tool bar; they are also indicated 
by selectable tabs across the top of the report header. To view a specific report, select its tab or 
select the report in the Reports window and click Show.
202-42808-01 (Rev E) - Oct 2015                                                  7-9 



Printed Reports ASAP 2020 Chemi
Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report 
has been hidden, it and its associated tab will become visible.

Delete Deletes the selected report. A deletion confirmation dialog is 
displayed since this function cannot be undone. The deleted 
report(s) will have to be regenerated if deleted in error.

Tabs display for each type of report you choose to generate.

Header

Options on 
Tool Bar

Displays graphi-
cal (or tabular) 
data.

List of reports 
requested.
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Hide Hides (removes) the selected report and its tab from the 
report window (greys in the Reports list).

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appropriate 
printer for report output. A list of available reports is 
displayed in the window on the right side of the dialog. 

For convenience in selecting reports to print, buttons are pro-
vided beneath the report window. Or, you can make your 
selection by clicking on the reports. 

Current selects the report displayed in the report window.

Shown selects only the shown reports; any unhighlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All selects all reports, including those that may have been 
hidden.

Clear clears all selections.

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. To specify a name and/or specific reports to save, 
use the Save As button.

Save As Allows you to save all or specified reports from the currently 
open file. The buttons displayed on this dialog function in the 
same manner as the print dialog (explained above).
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Save As

(continued)

Allows you to save all or specified reports from the currently 
open file. The buttons displayed on this dialog function in the 
same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you 
to reopen the file using the button on the Report window tool 
bar.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can specify 
default parameters for report fonts and curve properties.

Font Contains a list of report elements for which the font can be 
edited. Simply highlight the element and click Edit; a font 
dialog enabling you to specify the font and attributes is 
displayed.

Curve The items in this group box enable you to specify a thickness 
for report curves and, when using histograms, the type of fill 
to apply.

Graph border
line thickness

Enables you to specify a thickness for the border of the graph.

Load Loads the last saved defaults.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

Tabular Reports

Save Saves the changes as the defaults. If you do not click Save, 
the changes will apply to the current report set only. The next 
reports will revert to the defaults.

Close Closes the Default Style dialog and applies the changes. If 
you clicked Save, the changes become the defaults. If you 
did not click Save, the changes apply only to the current 
report set. 

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.
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Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.

Hide column Displays a list of all columns, enabling you to select the one 
to hide.

Show column Displays a list of all hidden columns, enabling you to select 
the one to have shown again.

Column font Displays a Font dialog, allowing you to change font 
attributes for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font 
attributes for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.
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Graphs

Autoscale Autoscales all axes of the graph. This option is useful for 
returning to a full view after a zooming operation.

Redraw Sets axis boundaries to its original view. You can also use 
this option to remove cross-hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been hidden.

Hide curve Allows you to hide (remove) unwanted curves.

Edit curve Displays the Curve Properties dialog, allowing you to edit 
curve properties.
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Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can 
be displayed. 

Curve group box Contains options for curves and points. You can edit the 
curve interpolation, the style of curve and/or points, as well 
as the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram group box Allows you to specify the type of fill as well as the color if 
Histogram is chosen as the style for collected data.

Edit axis Displays the Axis Properties dialog, allowing you to edit 
axis properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit 
the placement of the legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and drag 
the mouse cursor (drawing a rectangle) across the area to view; then release the button. The 
enlarged area immediately fills the graph area. You can return to the normal view by right-
clicking on the graph and selecting Autoscale. 

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy Graph Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting Windows 
metafiles. 

Copy Data Copies the data used to generate the graph as a series of tab-
delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the area of the graph.

Right-click in the graph area and select Autoscale or Redraw from the shortcut menu to 
return to the normal view; alternatively, you can click outside of the graph area.

Point of Coordination Y-axis position

X-axis position
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Report Examples

This section contains examples of the types of reports available in the ASAP 2020 Chemi 
analysis program.
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Isotherm Report

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No

Pressure (mmHg)
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Isotherm Plot
CO Pt-Al - First analysis data point CO Pt-Al - Repeat analysis data point
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Analysis Report

The Analysis report provides a summary of analysis statistics, a tabular report, and a line fit 
plot; the line fit plot is shown here.

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No

Pressure (mmHg)
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Line Fit Plot
Selected first analysis data
Selected repeat analysis data
Difference
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Langmuir Surface Area Report

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No

Pressure (mmHg)
00 50 100 150 200 250 300 350 400 450

p/
Q

 (m
m

H
g·

g/
m

m
ol

)

00

2,000

4,000

6,000

8,000

10,000

12,000

14,000

16,000

18,000

20,000

Langmuir Surface Area Plot
CO Pt-Al
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Freundlich Report

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No

log(p)
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Freundlich Plot
CO Pt-Al
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Temkin Report

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No
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CO Pt-Al
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Options Report

This example shows the first page of a 2-page Options Report.

Micromeritics Instrument Corporation

DEMO 2020C V2.00 H Unit 1 Serial #: 1179 Page 1

Sample: CO Pt-Al
Operator: jch

Submitter: PT
File: F:\...\DATA\000-005.SMP

Started: 10/10/2010 1:42:06PM Analysis Gas: CO
Completed: 10/10/2010 11:30:11PM Analysis Temp: 307.1 K

Report Time: 10/29/2010 11:21:53AM Equilibration Interval: 20 s
Sample Mass: 0.8453 g Low Pressure Dose: None

Measured free space: 6.9283 cm³ Automatic Degas: No

Options Report

Task Summary
Task

Number
Task
Name

 
Gas

Temp
(K)

Rate
(K/min)

Time
(min)

Pressure
(mmHg)

    1 Evacuation He   383  10.0    30
    2 Flow H2   373  10.0    10
    3 Flow H2   623  10.0   120
    4 Evacuation   623  10.0   120
    5 Evacuation   308 100.0    10
    6 Leak Test   308  10.0
    7 Evacuation   308  10.0    20
    8 Analysis CO   308  10.0

Task Number: 8
Adsorptive: Carbon Monoxide

Temperature: 308.1 K
Heat rate: 10.0 K/min

Equilibration interval: 20 s
Relative target tolerance: 2.5 %
Absolute target tolerance:   2.500 mmHg

    
Repeat analysis: Yes
Fast evacuation: Yes

Unrestricted evac. pressure: 30.0 mmHg
Evacuation time: 30 min

    
Free space group: Measured

Estimated free space: 7.7000 cm³
    

Incremental dosing: No

Experiment Log
Task

Number
Task
Name

Start
Time

(h:min)

 
Gas

Furnace
 Temp.

 (K)

Sample
Temp.

(K)

 
Time
(min)

 
Pressure
 (mmHg)

    1 EVAC 0:02 Hel 403.5 382.8    30
    2 FLOW 0:53 H2 391.8 372.7    10 777.8066
    3 FLOW 1:07 H2 662.1 622.7   120 778.5252
    4 EVAC 3:36 662.8 622.6   120
    5 EVAC 5:38 308.4 308.7    10
    6 LEAK 6:18 307.9 308.1     1 0.0898
    7 EVAC 6:22 309.6 308.2    20
    8 ANL 6:42 CO 308.5 307.3   184 516.0168
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ASAP 2020 Chemi Description
8.  OPTIONS MENU

The ASAP 2020 Chemisorption program provides various options that enable you to config-
ure the system to your laboratory’s requirements. You can select report formats, enter a default 
sample information file, and enter information to be printed in the free form area of reports. 
These options are selected from the Options menu.

Description

Option Presentation Allows you to display the sample file dialog in Advanced, 
Basic, or Restricted mode. Page 8-3.

Sample Defaults Enables you to enter default sample information file values. 
When the system automatically generates a new sample 
information file name, the file contains the default values. 
Page 8-6.

Active Metals Defaults The Active Metals Table Defaults dialog enables you to 
specify options for the chemisorption elements. Page 8-12.

Gas Defaults The Gas Table Defaults dialog enables you to specify options 
for the adsorptives. Page 8-14.

Units Allows you to choose the types of units to use for 
measurement, pressure, and temperature. Page 8-15.
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Graph Grid Lines Enables you to choose the types of grid lines to display for 
the X- and Y-axes. Page 8-15. 

Parameter Files Directory Allows you to specify a location for the parameter files used 
in the Basic sample file editor. Page 8-16.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 8-16.
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Option Presentation

The sample editing dialogs for the ASAP 2020 Chemi analysis program may be presented in 
three modes: Restricted, Basic, and Advanced. Each format displays sample information and 
menu options differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog similar to 
that of an index card file. You just click on the tab of the file to edit. This format also 
allows you to switch to the Basic mode.

• Basic: displays all parts of the sample file as a single dialog. You select from predefined 
parameter files. This format also allows you to switch to the Advanced mode if editing 
of parameters is needed.

• Restricted: displays in the same manner as the Basic format. Certain menu options, 
however, become disabled and you cannot switch to the Advanced mode. You also must 
enter a password to access and exit this format.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens an associated dialog. For example, if you are using the Advanced format and you 
open or create a sample information file, the following dialog is displayed. 

The Advanced format can be used to edit sample parameters and customize files. 
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Basic

The Basic format presents the sample information file and its parameter files as a single dia-
log. You also have access to all menu options. For example, if you are using the Basic format 
and open or create a sample information file, the dialog is displayed in this manner.

The Basic format is used to quickly create sample information files using previously defined 
parameter files. You also can easily switch to the Advanced format to view or edit details of 
parameter files.
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Restricted

The Restricted format is identical to the Basic format, except that certain options are disabled. 
You also cannot switch to the Advanced format. This format is password-protected and is typ-
ically used in laboratories where analysis conditions must remain constant, for example, in the 
pharmaceutical industry.

When you select Restricted, a dialog prompting you to enter a password is displayed.

You can enter any password to enable the Restricted format. You must enter the same pass-
word to exit the Restricted format. For example, if you enter “password” to enable the 
Restricted format, then you must enter “password” to exit. If you forget the password, open the 
system INI file and navigate to the Private section. The current password is shown immedi-
ately following “OptionPresentationPassword.” Make a note of the password, exit the INI file, 
and enter the password where requested. Deleting the password from the INI file will not dis-
able the Restricted mode; you must enter the password using the Password dialog to exit the 
Restricted format.
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Sample Defaults

Sample defaults are the values you see in the sample information editors when you create a 
new sample file. This option allows you to specify the default values. This feature makes it 
easy for you to apply the same conditions to many samples. 

For efficiency, it is best to specify defaults for materials you most commonly analyze. You can 
always edit the values in the sample file when it is created. 

The analysis program contains one complete default sample information file. When you select 
Open, Sample Information from the Main Menu, a new file with these default values is gener-
ated. Default files for analysis conditions, adsorptive properties, and reports options also are 
included. Details of system default files are found in Appendix E.

Sample defaults can be specified using the Advanced or Basic format. The Advanced or Basic 
format is chosen by selecting Options, Option Presentation from the main menu.

Basic

When you select Sample Defaults while using the Basic format, the Basic Sample Defaults 
dialog is displayed.

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open > 
Sample information.
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Sequence

(continued)

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Do not use characters such as * or ?. 

Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

In the field on the left, you can edit the prompt for Sample. 
For example, you may prefer to use Test or Material.

In the field on the right, specify a format for the sample 
identification.

• Use numbers, letters, or other printable characters, such as 
dashes.

• Maximum number of characters is 42, plus the $ symbol.

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

Lab #25 - 000-002, and so on.

Mass Enter a value that represents the mass of your most com-
monly analyzed material. This value can be edited in the 
sample file at the time of analysis.
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Degas Conditions
Analysis Conditions
Report Options

Each parameter has a drop-down list containing predefined 
parameter files. Several default files are included with the 
analysis program. For files to appear in this drop-down list, 
they must be saved to the Parameter Files directory; the 
default directory is params. Refer to Parameter Files Direc-
tory, page 8-16 for additional information.

Replace all Use this button to replace the current default values with 
those from an existing sample file.

Save Saves the current definition as the defaults.

Close Closes the dialog.

Advanced Switches the sample editor to the Advanced format.
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Advanced

When you select Sample Defaults while using the Advanced format, the Advanced Sample 
Defaults dialog is displayed.

Sequence Allows you to specify a default sequence for the sample file 
name. The number you specify is incrementally sequenced 
each time you create a sample file. It is the number that 
appears in the File name field when you select File > Open > 
Sample information.

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Do not use characters such as * or ?.

Sample Allows you to enter an additional identification that provides 
more information than the sample file name itself. 

In the field on the left, you can edit the prompt for Sample. 
For example, you may prefer to use Test or Material.
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Sample

(continued)

In the field on the right, specify a format for the sample 
identification.

• Use numbers, letters, or other printable characters, such as 
dashes.

• Use up to 42 characters, plus the $ symbol.

• Include the automatically generated file name as part of 
the identification by using the $ symbol where you want 
the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

for the second file:

Lab #25 - 000-002, and so on.

Operator
Submitter
Bar code

These fields enable you to enter defaults for the operator, 
submitter, and bar code information. 

The fields on the left can be edited to display a different 
label for the prompts.

The fields on the right allow you to specify default names or 
titles, and bar code information.

• Include the automatically generated file number/name as 
part of the identification by using the $ symbol where 
you want the name to appear.

• Use up to 43 characters (including the $ symbol) for the 
identification.

• Select Omit adjacent to any field to omit from displaying 
on the sample information dialog.
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Mass Enter a value that represents the mass of your most 
commonly analyzed material. This value can be edited in the 
sample file at the time of analysis.

Type of Data This group box allows you to choose the manner in which 
data are collected. 

Select Automatically collected if you want the ASAP 2020 
Chemi System to collect data during analysis; this is the 
standard setting. Select Manually entered if you plan to 
enter pressure data collected from another source.

Comments Use this window to enter sample characteristics, analysis 
conditions, etc. Anything you type in this window is printed 
in the report header.

Replace all Use this button to replace the current default values with 
those from an existing sample file.

Save Saves the current values as the defaults.

Close Closes the dialog.

Basic Switches the sample editor to the Basic format.
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Active Metals Defaults

This option enables you to specify characteristics of up to twenty elements. You must enter at 
least one element in the table.

Element Displays the element. You may insert or delete as needed. 
Refer to Appendix F, page F-1 for a list of elements. This 
appendix provides a list of elements, their atomic weights, 
cross-sectional area, and density.

Atomic Weight The atomic weight of the element.

Atomic Cross. Sect. 
Area (nm2)

The atomic cross-sectional area of the element.

Density The density of the element.
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Adsorptive Enables you to specify adsorptive options for a selected 
element; displays the Adsorptives dialog for the selected 
element (in this example, cobalt is shown).

Adsorptive Gases shown in the list are the ones specified in the Gas Table 
Defaults dialog. Refer to Gas Defaults, page 8-14 for 
information on adding gases.

Stoichiometry Factor A factor which expresses the ratio between the number of 
active metal molecules and the number of adsorbate 
molecules. This value is used in report calculations but not in 
the analysis itself.

Insert Inserts a row above the selected row, allowing entry of a new 
element to the table.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.
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Gas Defaults

This option enables you to specify the gases that appear in the drop-down list of the Gas Con-
figuration dialog; the Gas Table Defaults dialog is displayed. 

Gas Provides a list of gases; at least one adsorptive gas must be 
present in the table. 

Even though helium may not appear on the list, it is always 
available as a default gas.

Symbol The mnemonic for the adsorptive gas.

Insert Inserts a row above the selected row, allowing entry of a new 
gas to the table.

Delete Deletes the selected row.

Clear Clears the table of all entries except one; one is required.
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Units

This menu command displays the Units Selections dialog which allows you to choose the 
manner in which to display data on dialogs and in reports. 

Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the 
Graph Grid Lines dialog is displayed.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
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Parameter Files Directory

This option allows you to specify a location for the predefined Degas conditions, Analysis 
conditions, and Report options files displayed in the drop-down lists on the Basic and 
Restricted Sample Information dialogs. 

The default directory is params and includes several parameter files supplied with the analy-
sis program. If you specify a different directory, these files will not be included in the drop-
down lists unless you copy (or move) them to the new directory.

To continue using the params directory for parameter files, be sure to save any files you create 
to this directory; otherwise they will not be included in the drop-down lists of the Basic and 
Restricted sample file editors.

 Service Test Mode

Various service tests are included in the ASAP 2020 Chemi operating program. These tests can 
be performed only with the assistance of a trained Micromeritics service representative. When 
you select Service Test Mode from the Options menu, a dialog prompting you to enter a pass-
word is displayed. This password is coded to change on a regular basis. You must contact your 
local service representative to obtain the correct password. You will not be able to perform 
these tests without his guidance. 
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9.  TROUBLESHOOTING AND MAINTENANCE

The ASAP 2020 Chemi System has been designed to provide efficient and continuous service. 
However, to get the best results over the longest period of time, certain maintenance proce-
dures must be followed. This chapter describes recommended maintenance procedures and 
includes troubleshooting information.

Troubleshooting

Most operational problems are caused by leaks (commonly around the sample tube O-ring at 
the analysis port), sample weighing errors, or entry of incorrect system volume for analysis. 
Always check these first when expected analysis results are not obtained. Some common oper-
ational problems and their respective causes and solutions are provided in Table 9-1.

Table 9-1.  Troubleshooting Chart

What Happened Why What To Do

Furnace used for 
analysis cannot be 
raised (or lowered).

Elevator that moves furnace 
stuck in up position, down 
position, or somewhere in 
between.

Check for possible obstruction to 
elevator movement.

Vacuum pump gurgles 
continuously.

Sample tube or cold trap tube 
O-ring or fitting loose.

Tighten fitting. Replace O-ring.

Sample tube cracked. Replace with new sample tube.

No sample tube loaded on a 
selected port.

Install plug or empty sample 
tube.

Gas inlet valve open while 
vacuum valve open.

With manual control enabled, use 
the instrument schematic to close 
gas inlet valve.

Valves cannot be 
operated.

Circuit opened by circuit breaker. Reset breaker (depress breaker 
button) located on the side of the 
instrument (refer to Side Panel, 
page 3-5). If it does not stay in or 
if it continues to trip, contact 
appropriate service personnel.

Cable from computer to the 
instrument is loose.

Make sure the cable is seated 
properly.
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What Happened Why What To Do

Vacuum gauge shows 
reading above 20 
μmHg, even after 
extended pumping 
through unrestricted 
valve with analysis or 
degas ports closed.

Vacuum pump turned off or 
unplugged.

Check pump power plug and 
power switch.

Vacuum pump oil is low, causing 
ineffective evacuation.

Add or change vacuum pump oil. 
Be sure to add oil to proper level 
according to indicator window on 
the pump.

The alumina in the oil vapor trap 
is holding moisture.

Replace or dry the alumina. Refer 
to Replacing the Alumina in the 
Oil Vapor Trap, page 9-11.

Cold trap obstructed by 
condensation.

Clean the cold trap tube. Refer to 
Cleaning the Cold Trap Tubes, 
page 9-17.

Filter in port being used is dirty. Replace filter in port. Refer to 
Replacing the Port Filters, page 
9-4.

Leak in vacuum plumbing. Check and tighten all connections 
in vacuum plumbing, including 
cold traps.
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Preventive Maintenance

Table 9-2 lists the preventive maintenance procedures you should perform to keep your ana-
lyzer operating at peak performance. Instructions for each procedure follow the table.

Table 9-2.  Preventive Maintenance Schedule

Maintenance Required Frequency

Clean the analyzer, page 9-6 As required or every 6 months

Lubricate elevator screw, page 9-4 As required or every 6 months

Replace port filters, page 9-4 Every 30 days

Replace vacuum pump exhaust filter, page 9-6 Annually (heavy use may require more 
frequent maintenance.)

Inspect and change vacuum pump fluid, page 9-8 As required or every 3 months

Replace alumina in oil vapor traps, page 9-11
(if installed) 

As required or every 3 months

Clean cold trap tubes, page 9-17 As required or every 3 months

Calibrate manifold temperature sensor, page 9-16 Every 12 months

Test analyzer for leaks, page I-1 (Appendix I) As required or every 12 months

Perform reference material run As required or every 3 months
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Lubricating the Elevator Screw

Apply a light coat of lithium grease to the elevator screw as needed.

Replacing the Port Filters

A 20-μm filter is located in the analysis and exhaust ports, and in each degas port of the 
analyzer.

Analysis Port

Using a contaminated filter on the analysis port may extend the time required to achieve a vac-
uum at that port. More importantly, the contaminant may adsorb or desorb during analysis, 
affecting the analysis results. A contaminated filter on the analysis port may be detected by a 
leak test (if the contaminant outgasses) or by a free space reading much lower than normal.

Perform the following steps to replace the filters:

1. Make sure the furnace and sample tube or plug are removed. Make sure the analysis port 
(sample valve) is closed.

2. Using a wrench, remove the sample tube fitting from the manifold connector and remove 
the filter and O-ring.

3. Replace the filter and the O-ring. Carefully reassemble the sample tube fitting, filter, O-
ring and manifold connector, and tighten by hand. Then tighten with the wrench to 
prevent leaks when evacuated.

O-ring

Filter

Sample Tube Fitting
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Exhaust Port

1. Using a 9/16-in. wrench, unscrew the filter holder from the exhaust port block.

2. Remove the filter and O-ring by pushing them out from the opposite end of the filter 
holder.

3. Clean the filter holder in acetone or alcohol. The filter may be similarly cleaned or 
replaced with a new filter.

4. Inspect the O-ring; replace if damaged.

5. Reassemble the filter, O-ring and filter holder, and reinstall them in the exhaust port 
block.

Degas Port

If a filter on a degas port is contaminated, the contaminant may adsorb atmospheric gases 
when the port is not plugged (with either a sample tube or a plug), resulting in extended degas-
sing time for samples on that port.

Perform the following steps to replace the filter:

1. Using a wrench, remove the degas port fitting and remove the filter and O-ring. 

2. Replace the filter and the O-ring. Carefully reassemble the sample tube fitting, filter, O-
ring and manifold connector, and tighten by hand. Then tighten with the wrenches to 
prevent leaks when evacuated.

O-ring

Filter

Filter Holder

To avoid degassing problems, the new filter and O-ring must be clean. Do not touch 
them with bare hands.
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Cleaning the Analyzer

Use a clean cloth dampened with isopropyl alcohol, a mild detergent in water, or a 3% hydro-
gen peroxide solution to clean the outside casing of the analyzer. 

Use only a mild detergent in water to clean the shields; do not use isopropyl alcohol. 

Testing the Analyzer for Leaks

Refer to Appendix I, page I-1 for instructions on testing the ASAP 2020 Chemi for leaks.

Replacing the Vacuum Pump Exhaust Filter

The gases used by the ASAP 2020 Chemi System are exhausted by vacuum pumps. If no 
exhaust line is connected, an exhaust filter is installed on the exhaust port of each oil-based 
vacuum pump. The filter minimizes the release of oil vapor. The gases used are diluted sub-
stantially upon being released from the vacuum pumps. However, it may be desirable in some 
locations to provide a fume hood for added protection from hazardous gases and vapors 
released into the work area. Chemisorption instruments are provided with a hose connector 
which may be used to connect the analysis vacuum pump directly to a ventilation system.

Perform the following steps to replace the filter:

1. Using a flat-blade screwdriver, remove the screws from the vacuum pump panel on the 
front of the analyzer, then remove the panel to access the pump.

Do not use isopropyl alcohol to clean the shields. Isopropyl alcohol could damage the 
surface of the shield.

This procedure does not apply, and is not required, for dry vacuum pumps.

Exhaust filters are used on the vacuum pump to minimize the release of oil vapors. 
The gases used are diluted substantially upon being released from the vacuum 
pumps. However, it may be desirable in some locations to provide a fume hood for 
added protection from hazardous gases and vapors released into the work area.
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2. Loosen the wing nut of the clamp at the vacuum pump exhaust port. Swing the clamp 
away from the exhaust port and remove it. 

3. Remove and discard the exhaust filter; do not remove the centering ring.

4. Make sure the centering ring is in place on the exhaust port.

5. Place the new filter on the centering ring.

6. Open the clamp and place it around the flange of the exhaust port and the flange of the 
exhaust filter. Swing the clamp fastening screw toward the exhaust port until it fits into 
the slot in the other half of the clamp. Tighten the wing nut securely by hand.

7. Reinstall the vacuum pump panel.
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Inspecting and Changing Vacuum Pump Oil

The oil in the vacuum pump should be changed every three months, when the efficiency of the 
vacuum pump declines (requiring increased time to reach vacuum levels), or if it becomes dis-
colored. The oil is easily inspected to determine if a change is necessary.

Inspecting the Oil

1. Remove the vacuum pump panel (located on the left front side of the analyzer).

2. View the vacuum pump oil through the oil-level window. The oil level should be midway 
between the indicators on the oil-level window. Oil in good condition is clean, clear or 
light in color, and transparent. 

• Change the oil if it has darkened
• Add oil if it is below the midway level

Changing or Adding Oil

Use oil supplied by Micromeritics, or refer to the manual for the vacuum pump for other 
acceptable oils.

1. Place the analyzer ON/OFF switch in the OFF position.

2. Remove the vacuum pump panel (if not already removed).

1. Unplug the vacuum pump from the power source.

This procedure does not apply, and is not required, for dry vacuum pumps.

Oil-level window

Always drain the vacuum pump while the pump is warm and switched off 
(unplugged).
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2. Loosen the wing nut on the clamp at the top of the oil vapor trap. Swing the clamp open 
and remove the trap from the hose.

3. Grasp the handle on top of the vacuum pump and place it on a work table.

4. Drain the used oil: 

a. Place a waste container under the drain spout.

b. Remove the plug from the drain spout; allow the oil to drain into the waste container.

If you are adding oil, skip this step and continue with Step 5.
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d. Replace the drain plug.

5. Remove the plug from the oil-fill port.

6. Slowly add oil to the port until the level is midway between the indicator lines in the oil-
level window.   

7. Insert the oil-fill plug and turn counterclockwise to tighten.

8. Check the alumina in the oil vapor trap. If most of the pellets are no longer white, replace 
the alumina in the oil vapor trap before reattaching the vacuum pump. Refer to Replacing 
the Alumina in the Oil Vapor Trap, page 9-11 for instructions.

9. Reconnect the vacuum pump hose.

10. Reconnect the power cord to the power source.

11. Allow the pump to run a few hours (overnight if possible) to eliminate air and moisture 
from the fresh fluid and to produce efficient vacuum operations.

Oil-fill port

Midway level

Do not allow oil to rise above the midway position. Doing so may cause oil to splash 
into the oil filter and contaminate it.
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Replacing the Alumina in the Oil Vapor Trap

The activated alumina in the oil vapor trap becomes saturated during use. The alumina should 
be inspected periodically and replaced when most of the alumina pellets are no longer white. 

1. Disconnect the vacuum pump from the analyzer and place it on a work table (refer to 
Changing or Adding Oil, page 9-8, steps 1, 2, and 3 for instructions).

2. Loosen the wing nut on the clamp at the bottom of the oil vapor trap. Swing the clamp 
open and remove the trap.

3. Remove one end fitting from the trap body; dispose of the used alumina in an appropriate 
manner.

4. Wash the trap body with a detergent-based soap. Rinse with water, then with isopropyl or 
ethyl alcohol. Set the trap aside and allow to dry thoroughly.

Do not perform the following procedure on used alumina. The resultant oil vapors may 
cause a fire or an explosion.

  

Exposure of the trap body to oil vapor may cause small cracks on the inside surface of 
the trap body. Under normal circumstances, these cracks will not cause problems or 
leaks.
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5. Prepare fresh alumina as follows:

a. Preheat the oven to 300 °C.

b. Pour approximately 180 grams of fresh alumina into a glass or metal container 
(approximately 250 mL if a graduated beaker is used). Place the container in the oven.

c. Bake the alumina for two hours.

d. Remove the baked alumina from the oven and allow it to cool until lukewarm. A 
desiccator may be used to speed the cooling process.

6. Using a small spatula, gently pry the O-ring from the end fittings of each end of the trap 
body.

7. Inspect the O-rings.

• If dusty, clean with a lint-free tissue.
• If damaged, replace with a new O-ring.

8. Screw one of the end fittings onto the trap body.
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9. Be sure the trap body is dry and the alumina is lukewarm; pour the alumina pellets into 
the trap until they are just below the threads of the trap body.

10. Screw the other end fitting back onto the trap and tighten securely by hand. 

11. Lightly tap both ends of the trap body on the work surface. This will remove any 
remaining dust from the pellets.

12. Inspect the centering ring before placing it back on the intake port. If it appears to have 
flattened, replace it. A flattened centering ring can cause vacuum leaks.

There are two types of centering rings, use the one with the smaller opening at the intake 
port 

Centering Ring
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13. Place the trap on the centering ring.

14. Open the clamp and place it around the flange of the intake port and the flange of the trap. 
Swing the clamp fastening screw toward the intake port until it fits into the slot in the 
other half of the clamp. Tighten the wing nut securely by hand.

15. Reconnect the hose from the analyzer to the oil vapor trap.

a. Inspect the centering ring before placing it on the trap body. If it appears flattened, 
replace it with a new one. A flattened centering ring can cause vacuum leaks. 

Use this type of centering ring for the trap body.

b. Place the clamp around the flange of the vacuum pump hose and vapor trap.
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c. Swing the clamp fastening screw around until it fits into the slot on the other half of 
the clamp. Tighten the wing nut securely by hand.

16. Plug the pump power cord into the power source.

17. Allow the pump to run a few hours (overnight if possible) to eliminate air and moisture 
from the fresh oil and to produce efficient vacuum operations

18. Replace the vacuum pump access panel.
202-42808-01 (Rev E) - Oct 2015                                                9-15 



Preventive Maintenance ASAP 2020 Chemi
Calibrating the Manifold Temperature Sensor

You should calibrate the manifold temperature on an annual basis. This allows you to correct 
for any changes in the manifold temperature sensor that occur with time. 

You will need a small diameter probe, such as a 1/16-in. (1.5-mm) thermocouple, to calibrate 
the manifold temperature sensor.

1. Insert the thermocouple probe into the opening located to the left of the sample port 
connector.

2. Move the thermocouple back and forth until you locate the small opening on the 
underside of the manifold. Push the thermocouple into the opening until the 
thermocouple stops.

3. Allow the temperature gauge reading to stabilize.

4. Select Unit > Calibration > Temperature; the Calibrate Manifold Temperature dialog is 
displayed. 

5. Enter the manifold temperature indicated on the temperature gauge. Click OK to store the 
new value.

6. Remove the thermocouple probe.

Sample Port connector

Right side panel

Thermocouple Probe opening
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Cleaning the Cold Trap Tubes

Oil vapor from the vacuum pumps accumulates in the cold trap. Clean the tubes as follows:

1. Remove the vacuum pump panel.

2. Disconnect the vacuum pump power cord from its power source.

3. Display the [unit] Instrument Schematic and select Enable Manual Control.

4. Open analysis valves in the following order: P1, PS, 5, 7, and 1. Allow the pressure to 
stabilize until around atmospheric. Then, close the valves in the same order as they were 
opened. This step fills the analysis vacuum section before disconnecting.

5. Display the Degas Instrument Schematic and select Enable Manual Control.

6. Open degas valves in the following order: D5 and D7. Allow the pressure to stabilize 
until around atmospheric. Then, close valve D7 and D5. This step fills the degas vacuum 
section before disconnecting

7. Remove the connector nut from the glass tube and inspect the O-ring. Replace the O-ring 
if it is cracked or worn.

8. Carefully slide the glass tube down over the metal tube and remove the glass tube.

9. Rinse the tube with acetone; then dry it. 

10. Reinstall the cold trap tube. Make sure the O-rings are in place.

If the high vacuum pump is installed, wait for it to completely stop (approximately 10 
minutes).

             

O-ring

Connector Nut
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11. Repeat Steps 2 through 6 for the other cold trap.

12. Reconnect the vacuum pump power cord

13. Replace the vacuum pump access panel.
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10. ORDERING INFORMATION

The ASAP2020 Chemi system components and accessories can be ordered using one of the 
following methods: 

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided in this chapter to place your order.

System Components and Accessories

Part Number Item and Description

Peripheral Accessories

202-33008-00 Chemisorption software and operator’s manual

202-33054-00 Vapor Option, factory installed

060-00030-00 FlowPrep 060, degasses up to six samples at up to 400 ºC with flowing 
gas.

061-00030-00 VacPrep 061, degasses up to six samples at up to 400 ºC with either 
flowing gas or by evacuation (evacuation requires a vacuum pump).

021-00000-00 Model 021 LN2 transfer system, for easy filling of sample Dewars; 
includes 47 L Dewar, mobile platform, and pump with 100 cm 
discharge line

System Components

004-25103-00 Ferrule, front, Teflon 1/4 in.

004-25104-00 Ferrule, rear, Nylon 1/4 in.

290-25846-00 Copper tube, for gas inlet, 1/8 in. diameter, 6 ft. long

290-25846-01 Copper tube, for gas inlet, 1/8 in. diameter, 16 ft. long

201-25818-00 Gas inlet line assembly, stainless steel, 1/8 in. diameter, 6 ft. long

201-25818-01 Gas inlet line assembly, stainless steel, 1/8 in. diameter, 16 ft. long

004-25549-00 Reducer, brass; 1/8 in. tube x 1/4 in. tube, accepts 1/8 in. tube, 
connects to 1/4 in. swage fittings

004-25318-00 Reducer, stainless steel; 1/8 in. tube x 1/4 in. tube, accepts 1/8 in. tube, 
connects to 1/4 in. swage fittings
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004-62230-58 Gas pressure regulator, CGA 580 fitting (Ar, He, Kr, N2), 30 psig

Part Number Item and Description

004-62230-35 Gas pressure regulator, CGA 350 fitting (CO, H2), 30 psig

004-62230-54 Gas pressure regulator, CGA 540 fitting (O2), 30 psig

004-62230-32 Gas pressure regulator, CGA 320 fitting (CO2), 30 psig

004-62230-326 Gas pressure regulator, CGA 326 fitting (N2O), 30 psig

004-62230-705 Gas pressure regulator, CGA 705 fitting (NH3), 30 psig

004-33601-00 Expansion Kit; adds an additional outlet to the gas regulator, includes 
fittings and instructions

004-33602-00 Pressure Relief Kit; prevents excessive gas pressure in the event of 
regulator failure (not to be used with noxious gases)

202-33053-00 Dewar option kit; includes 4-liter, stainless-steel Dewar, stainless-steel 
cold trap, and elevator adapter

003-26043-00 Heating mantle with type K thermocouple, 450 ºC maximum, 24 V 

230-25808-00 Heating mantle clip

004-54609-00 Brush, for cleaning sample tube

004-54609-01 Brush, for cleaning exhaust tube

240-25853-00 Sample tube funnel

240-14855-00 Sample tube rack

280-32800-00 Sample tube support, assists sample weighing

248-31702-00 Insulator disk, for oven

004-16825-00 Reference material, chemisorption

202-25903-00 Mat, rubber; for front shelf

250-25608-00 Valve gasket, Kel-F, for analysis manifold

250-25627-00 Valve plunger, Buna-N seal, for analysis manifold

250-25628-00 Valve spring, for Buna-N plunger

202-42808-00 Operator’s manual

Vacuum System Components

062-00000-11 Vacuum pump, oil-sealed, with built-in anti-suckback valve, 100/120 
VAC; includes hose kit 

062-00000-23 Vacuum pump, oil-sealed, with built-in anti-suckback valve, 220/240 
VAC; includes hose kit 
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062-33002-00 Activated alumina oil vapor trap, for one vacuum pump

Part Number Item and Description

004-16003-01 Vacuum pump oil, 1 liter

200-25879-00 Vacuum pump oil funnel

004-27040-00 Vacuum pump exhaust filter

004-16830-00 Activated alumina, 500 grams, for oil vapor trap

004-25652-00 O-ring, size 217, for oil vapor trap
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Sample Tube and Components

Part Number Item and Description

004-25465-00 A O-ring, size 010, Kalrez; for sample tube exhaust port fitting

004-27041-00 B Port filter, 20 μm, 1/4 in. diameter

004-25474-00 C O-ring, size 013, Kalrez for sample tube fitting

260-25843-00 D Ferrule, 1/2 in. stainless steel

260-28804-00 E Sample nut

240-32000-00 F Stopper, for 1/2 in. sample tube

240-32000-00 G Cap (stopper), for 1/4 in. sample tube

202-61001-00 H Sample tube, quartz, use with temperatures up to 1100 ºC

004-32164-01 I Wool, quartz, use with quartz sample tubes to constrain sample

004-25673-00 J O-ring, size 008, Kalrez for exhaust port filter

004-27056-00 K Exhaust filter, 20 μm, 3/16 in. diameter

275-25803-00 L Ferrule, 1/4 in. stainless steel

201-25822-00 M Exhaust nut

004-61701-02 N Filler rod, quartz

004-25465-00      O O-ring, size 010, Kalrez, for sample port filter

 O
B

C

D

E

F

GH

I

J

K

L

M

N

A
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Cold Trap Tube and Components

A

B

C

Part Number Item and Description

004-25469-00 A O-ring, Buna-N, size 014

004-25979-00 B Nut, cold trap

004-61063-00 C Tube, 1/2 in. OD stem, cold trap
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ASAP 2020 Operator’s Manual Appendix A
A.  FORMS

This appendix contains the following form:

• Sample Data Worksheet

Copy and use this form as needed.
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ASAP Chemi Series Sample Data Worksheet

This form is provided to assist you in obtaining an accurate sample mass for report calculations. You may 
use the After Degas value (Step 5) or the After Analysis value (Step 7), provided they are close to the 
same. 

Compare the sample mass obtained after analysis (Step 7) with the sample mass after degas (Step 5). 
These two values should be close in range. If a significant difference is noted, analysis problems may 
exist or the sample may have been improperly degassed.

Sample tube:_____________________              Sample: ____________________________________

Before Degas:

1. Mass of empty sample tube ________ (g)

2. Mass of sample tube plus sample ________ (g)

3. Mass of sample (Step 2) – (Step 1) ________ (g)

After Degas:

4. Mass of sample tube plus sample ________ (g)

5. Mass of sample (Step 4) – (Step 1) ________ (g)

After Analysis:

6. Mass of sample tube plus sample (g) ________ (g)

7. Mass of sample (Step 6) – (Step 1) ________ (g)
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B.  ERROR MESSAGES

Error messages are listed numerically. If the Action response instructs you to contact your 
service representative, record the error message and make backup copies of any files involved 
in the operation.

2200 and 2400 Series

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message)

2430- Error accessing file (file name), error code = (number). 

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: Start Report failed to execute the report subsystem (which is a sepa-
rate process).

Action: Restart the computer. If the problem persists, reinstall the application 
(this will not affect any of your sample files). If the problem continues, 
contact a Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) — Subset # (number) wrote wrong amount of data.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to a diskette, CD, or 
network directory, delete them from the hard disk, and then try the 
operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Program files (sample information, analysis conditions, or report 
options) have been added to this directory by some function other than 
this application.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a minute.

Click No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2436- Path specification (path name) is invalid.

2437-  File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.

2440- Subset not found.

2441- Seek within file failed.

2442- Bad header in subset file.

2443- Subset owner denied access.

2444- Not a valid file format.

2445- Subset wrote the wrong amount of data.

2446- Error reading data.

2447- Error writing data.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter.

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the disk is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.
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2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. (file name)

2453- Attempt to append MICATTR.DIR in read only mode. (file name)

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories: list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your DOS or Win-
dows manual and re-enter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application’s 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.
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2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message. 

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be stopped.

Action: Wait a few minutes before attempting to exit the application again.

Cause: You attempted to exit the application while the analyzer was perform-
ing an operation.

Action: Rather than exiting the application you may choose to minimize it.
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2460-  Fatal Communications error on (unit n).

2461- No instruments are in operation. This application will unconditionally 
terminate.

2461- No instruments are in operation. This application will unconditionally 
terminate.

Cause: Repeated attempts to maintain communication with the analyzer have 
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the status light is 
not blinking. 

If these checks are okay, exit the analysis program and then restart the 
application. If this error persists, contact your service representative.

Cause: At least one analyzer must be active for the application to operate. The 
initialization of the analyzers configured with the Setup program has 
failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the analyzer has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the analyzer, contact your ser-
vice representative.

Cause: At least one analyzer must be active for the application to operate. The 
initialization of all of the analyzers configured with the Setup program 
has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the analyzer power switch is in the ON position. If the 
application continues to fail in its attempts to initialize the analyzer, 
contact your service representative.
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2471-  Unit n - S/N; nn has an invalid communications port specified. It cannot be 
initialized.

2474-  (Unit n) Communications port COM (port number) specified in the program 
control files is already in use. Unit cannot initialize.

2475-  (Unit n) Communications port COM (port number) specified in the program 
control files cannot be accessed. Unit cannot initialize.

2476-  Unit startup failed. Cannot initialize the communications port.

Cause: The communications port specified for this analyzer during installation 
(or configuration) is invalid.

Action: Use the setup program to change the analyzer configuration.

Cause: The communications port assigned to the indicated unit is in use by 
another program.

Action: End the program using the busy port or use the Setup program to 
change the communications port assigned to this program.

Cause: The operating system has prevented the application from accessing the 
communications port.

Action: Review the hardware configuration of the computer, ensure that no 
other application is using the port. Contact your service representative 
if you continue to receive this error message.

Cause: The communications port specified during installation is invalid.

Action: Use the setup program to change the analyzer configuration. Contact 
your service representative if you continue to receive this error mes-
sage.
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2477- (Unit n; Serial nn) did not properly initialize.

2478-  Error copying sequential data segment.

2479-  (Unit n; Serial nn) The instrument is busy performing an operation of which this 
application is unaware. Do you want to cancel? (Yes, No)

2480- File (file name) cannot be analyzed. It is currently being edited.

Cause: The software was unable to initialize the analyzer.

Action A: Run the Setup program and ensure that a valid port is specified; if not, 
specify a valid one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact your Micromeritics service representative if you continue to 
get this message.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, use a utility such as ScanDisk. Contact your service repre-
sentative if you continue to receive this error message.

Cause: During initialization of the application, the status of the analyzer was 
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process, allowing the analyzer to 
reset and continue with initialization.

Click No to cancel the initialization process.

If you continue to get this message, verify that files in the application 
directory structure are not being changed or removed.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog box.
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2481- Error accessing the sample information file (file name).

2482- File cannot be opened for writing. It is already in use.

2483-  An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C:  A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You are attempting to open a file that is currently being used (either by 
this application or another).   

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: You attempted to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.
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2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis.

2485- The service test file has an invalid status and cannot be used for this analysis.

2486- Cannot construct (name) report type. Program will terminate.

2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

Cause: You attempted an analysis using a sample file that contains unsaved 
changes.

Action: Select Yes to save the changes and continue with the analysis. 

Select No to abort the analysis and return to the sample file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace 
All to copy parameters from the file you originally selected.

Cause A: You may not have full rights to the application’s folders and files.

Action A: Contact your system administrator and have him grant you full rights.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.
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2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing dia-
log box.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII (.INI) file containing initialization and system options 
information cannot be found. The .INI file may have become cor-
rupted. The application cannot operate without this file.

Action: Use the Setup CD to uninstall the ASAP 2020 Chemi application. 
When you uninstall the application, only the application files are 
deleted; data files remain intact.

After the uninstall operation is complete, reinstall the application.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.
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2494- Value is out of the valid range.

2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your service representative if you continue to receive this error 
message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your service rep-
resentative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative if you continue to receive this error 
message.
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2504- Cannot create output file for sample (sample name).

2505- Error Logger cannot be initialized!  Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this error message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog 
box. Install the device using the Control Panel, Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.
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2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been cancelled.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.
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2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, click Accept.
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2518- Analysis data are not suitable for smoothing. Smoothing has been disabled.

2519- Data sets with fewer than 11 data points cannot be smoothed. Smoothing has 
been disabled.

2520- No data points available for reporting.

2521- Unable to program controller.

2522- Invalid controller application file.

Cause: The Analysis data contains volume adsorbed values that are less than 
or equal to zero.

Action: No action required; this is a status message only.

Cause: Primary or repeat data with less than eleven data points cannot be 
smoothed. This message may refer to the number of points in the repeat 
analysis if it is selected for reporting.

Action: No action required; this is a status message only.

Cause: You requested a report for a data file which contained no data points 
relevant to the report.

Action: The affected report will not be produced. If the data file contains no 
points, select another file for the report. If the data file contains points, 
verify that you selected a sufficient number of points for the report on 
the Collected/Entered Data dialog.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the ASAP 2020 analysis program.
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2523- Programming the controller failed.

2524- CRC check failed on programming controller.

2525- Unknown error programming controller.

2526- Controller download was not successful.

2527- Controller CRC error on boot block.

2528- Controller DRAM error.

2529- Controller Com1: error.

2530- Controller Com2: error.

2531- Controller debug port error.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the ASAP 2020 connected to the 
computer, select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
B-18                                                    202-42808-01 (Rev E) - Oct 2015



Appendix B ASAP 2020 Chemi
4000 Series

4000- Memory Allocation Error.

4003- Error Converting Pressures.

4004- Error Computing Volume Adsorbed.

4006- Report Type Not Found.

4007- Error Processing Report.

4008- Report requested on sample file with no data points.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You selected a file for reporting which contains no collected data.

Action: Select another file which contains collected data and restart the report.
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4009- Error, No Reports Selected.

4011- Analysis gas in sample file does not match analysis gas in unit.

4015- Error creating export file for sample <sample file name>.

4016- Sample (file name) has no data for export.

Cause: You attempted to generate reports for a sample that has no reports 
selected in its report options.

Action: Select the reports in the sample’s report options and save the sample 
file.

Cause: You attempted to start an analysis using a sample information file in 
which the analysis gas specified does not match the analysis gas 
entered in the unit configuration.

Action: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration dialog. 

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory 
exists. Ensure that the target diskette is not full or write protected. The 
target disk drive may be damaged or inoperative. Verify that other files 
may be created on the same drive. Contact your service representative 
if you continue to receive this error message.

Cause: The file selected for export has a status of No Analysis. No export file 
will be created.

Action: Select a file which contains analysis data.
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4017- Damage to the instrument will result if the sample has not been manually evac-
uated. Have you evacuated the sample?

4020- Disabling this option may damage the instrument. Are you sure that the sample 
should not be backfilled?

4023- The file (sample file) cannot be prepared for analysis. It is open for editing and 
contains errors.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog box. The sample tube is normally at atmo-
spheric pressure when an analysis is started, and it must be backfilled 
before the analysis begins to prevent sample material from being 
drawn into the manifold.

Action: If you have manually evacuated the sample tube, select Yes. If you 
have not, select No and then either perform a manual evacuation or go 
to the Sample Backfill Options dialog box and select Backfill sample 
at start of analysis.

Cause: You did not select Backfill sample at start of analysis on the Sample 
Backfill Options dialog. The sample tube is normally at atmospheric 
pressure when an analysis is started; it must be backfilled before the 
analysis begins to prevent sample material from being drawn into the 
manifold.

Action: If you want to manually evacuate the sample prior to the start of the 
analysis, select Yes. Otherwise, select No, go to the Sample Backfill 
Options dialog, and select Backfill sample at start of analysis.

Cause: You attempted an analysis using a sample file that is being edited and 
has invalid values in one or more of its fields.

Action: Enter valid values into the fields that have errors, save the changes, and 
close the dialog box.
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4024- Backfill gas in sample file does not match any gas in unit.

4025- There is no Helium attached to the unit. 

Cause: You selected a backfill gas that is not included in the gas configuration.

Action: Make sure that gas selections match the gases that are attached to the 
instrument. Choose one of the gases as the backfill gas, or edit the sam-
ple file and choose one of the existing gases as the backfill gas.

Cause: A measured free space has been requested but helium does not appear 
to be available.

Action: Make sure the helium cylinder is attached to the unit at its designated 
port.
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6200 Series

6201- Communications port (port name) specified in the program control files is not a 
valid device. Unit cannot initialize.

6202- No serial number available. Unit cannot initialize.

6203- File cannot be opened for editing. It is already in use.

6204- File cannot be opened for writing. It is already in use.

Cause A:  The communications port assigned to this program cannot be made 
available for proper communications.

Action A: Run the Setup program, select Change analyzer setup, and enter the 
correct port information. If the message continues, contact your service 
representative.

Cause B: The program’s control file was manually modified, and an invalid com-
munications port was specified.

Action B: Use the Setup program to change the communications port assigned to 
this program.

Cause: The program control file does not contain a serial number for the unit.

Action: Run the Setup program, select Change analyzer setup, and define the 
serial number for the instrument.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.
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6211- The gas selected for the (task name) task is different than the gas selected for 
the preceding (task name) task. Do you wish to insert an evacuation task in 
between? 

6212- A leak test is specified without a preceding evacuation. Do you wish to insert 
an evacuation task?

6213- The maximum allowed number of tasks is selected. Delete some tasks before 
proceeding.

6214- An analysis task is specified without a preceding evacuation. Do you wish to 
insert an evacuation task? 

6215- The Selected Tasks list contains adjacent tasks using different gases. Do you 

Cause: A task in the Selected Tasks list uses a different gas than the previous 
or next task. Mixing gases may be dangerous.

Action: Select Yes to evacuate the sample before introducing the new gas. 
Select No to exclude evacuation between the two tasks.

Cause: By inserting or deleting a task in the Selected Tasks list on the Anal-
ysis Conditions dialog box, you left a leak test task without a preceding 
evacuation task. The leak test will fail if the sample pressure exceeds 
0.5 mmHg.

Action: Select Yes to evacuate the sample between the two tasks. Select No to 
exclude evacuation

Cause: You attempted to insert more than twenty tasks.

Action: You may specify no more than twenty tasks in one sample file. If more 
preparation steps are required, use two sample files. The first sample 
file should contain only preparation tasks; the second file should con-
tain any remaining preparation tasks and an analysis task.

Cause: You inserted or deleted a task in the Selected Tasks list of the Analysis 
Conditions dialog box, leaving the analysis task without a preceding 
evacuation task.

Action: Select Yes if you want the system to automatically insert an evacuation 
task. Selecting No causes the analysis to produce incorrect results.
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still wish to save this file?

6216- The selected task has already been executed. It may not be changed or deleted.

6217- New tasks may only be inserted following task (number).

6218- An analysis task may not be inserted while an experiment is in progress.

Cause: You attempted to save a sample file in which one task in the Selected 
Tasks list uses a different gas than the previous/next task. Mixing gases 
may be dangerous.

Action: Select No if you do not want to save the file. Return to the Analysis 
conditions dialog and insert an evacuation task between all flow, soak 
and analysis tasks which use different gases.

Cause: You attempted to edit or delete a task after it was already performed.

Action: Edit or delete a task not yet performed.

Cause: You attempted to insert a task before the task currently being executed.

Action: Insert new tasks following the task currently being executed.

Cause: You attempted to insert an analysis task in the Selected Tasks list for a 
sample file which is currently being processed by the analyzer.

Action: If you want to insert an analysis task, first cancel the experiment in 
progress. Then delete the tasks which had executed up to the time of 
the cancellation, insert an analysis task, and restart the experiment
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6219- No new tasks may be inserted. Analysis is complete.

6220- Tasks may not be deleted after an experiment has been started.

6221- Error opening file (file name) for conversion.

6222-  (Unit {number}) (gas name) required by task (number) is not configured on the 
selected unit.

Cause: You attempted to insert a new task for a sample file which is currently 
being processed by the analyzer. All tasks have been processed and the 
analyzer is performing the termination sequence.

Action: Construct a new sample file containing the tasks and submit it for pro-
cessing.

Cause: You attempted to delete a task after the sample file was submitted for 
processing.

Action: Reduce the duration of the task to minimum value.

Cause: A file error occurred while the system was attempting to open a MIC-
MOS chemisorption data file and convert it to the ASAP 2010C file 
format. The disk drive is malfunctioning.

Action: Contact your service representative.

Cause: You attempted to start an analysis which requires a gas not entered in 
the unit configuration information. The analysis is canceled.

Action: Select Unit [n] > Unit Configuration to display the Unit Configura-
tion dialog. Click Gas to display the Gas Configuration dialog; then 
specify the valve to which the required gas is connected.
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6223- Sample has no Analysis Task entry. Do you wish to proceed with the analysis?

6224- Sample has no pressure table entries. Do you wish to proceed with the 
analysis?

6225- The Selected Tasks list contains adjacent tasks using different gases. Do you 
still wish to close this file? (yes, no)

6226- (gas symbol) required for backfilling the sample at the end of the analysis is 
not configured on the selected unit.

Cause: You are attempting to analyze a sample file with no analysis task entry.

Action: Select Yes to proceed with the analysis; all preparation tasks are per-
formed but no data points are collected. Select No to cancel the anal-
ysis.

Cause: You attempted to start an analysis using a sample file for which no 
pressure table was specified.

Action: Select Yes to proceed with the analysis; all preparation tasks and the 
free space measurement are performed, but no data points are col-
lected. Select No to cancel the analysis; enter a pressure table for the 
sample.

Cause: You attempted to close a file that has adjacent experiment tasks which 
specify different gases. Incompatible gases may be mixed during sam-
ple preparation.

Action: Select No if you do not want gases to be mixed on the sample. Select 
Yes to return to the Analysis conditions dialog box and add evacuation 
tasks if necessary.

Cause: The gas specified for use in backfilling the sample at the end of the 
experiment is not configured on the instrument.

Action: Select Unit > Unit Configuration to display the Unit Configuration 
dialog. Click Gas to display the Configuration Gas Options dialog;  
select the gas inlet port to which the required gas is connected.
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6230- The Active Metals Table Options dialog does not specify a stoichiometry factor 
for the adsorptive (gas name) of the element (metal name). One (1.0) was sub-
stituted for this value in the calculations.

6231- No element in the Active Metals Table Options has a “% of Sample Weight” 
value greater than zero. Metallic Dispersion and Metallic Surface Area will no 
be calculated.

6232- Line Fit Plot cannot be produced: Fewer than two data points were selected for 
inclusion in the calculations.

Cause: You specified a non-zero percent of sample weight for an element in 
the Active Metals Table of the sample report options but you did not 
specify a stoichiometry factor for the adsorptive used in the analysis.

Action: The calculation proceeds with the default value and the program pro-
duces a report. Edit the sample information file to include the correct 
value and run the report again.

Cause: All elements in the Active Metals Table of the sample report options 
have the value zero entered for the percentage of sample weight.

Action: The calculations proceed and the program produces an incomplete 
report. Edit the sample information file to include the correct value and 
run the report again

Cause A: You selected fewer than two data points for inclusion in the line fit plot 
calculation. The plot requires at least two data points to be produced.

Action A: Edit the sample information file to select the data points used in the 
calculation. 

Cause B: The second temperature entered while calibrating the sample thermo-
couple differs from the first by less than 75 ºC and will produce an 
unsatisfactory calibration.

Action B: Select Yes to use the entered value. Select No to repeat the second tem-
perature measurement.
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6234- Leak test failure - the observed outgas rate of [VAC0] [VAC-U] exceeds the limit 
of [VAC0] [VAC-U].

6235- Leak test failure in task (number): The sample was not fully evacuated prior to 
the test.

6236- Pressure exceeded [PR0] [PR-U] while flowing (gas).

6237- (Unit {number}) Analysis canceled in task (number): Time limit exceeded while 
attempting to reach temperature (number).

Cause: The outgas rate specified in the leak test criteria was exceeded.

Action: Check sample tube fitting to ensure that it is securely attached to the 
port. Then start the analysis again.

Cause: The sample was at a pressure greater than 0.5 mmHg at the start of the 
leak test. A leak test can not be performed unless the sample has been 
fully evacuated.

Action: Insert an evacuation task immediately before the leak test. If an evac-
uation task is already present, ensure that the evacuation is being per-
formed at the same temperature as the test and that the duration of the 
evacuation is adequate.

Cause: The pressure in the manifold exceeded the indicated maximum, while 
flowing gas over the sample.

Action: Verify that the exhaust line is not plugged or restricted. Reduce the 
pressure of the flowing gas at the tank regulator. Resume the experi-
ment while monitoring the manifold pressure and flow rate. Adjust the 
regulator pressure to achieve the flow rate with a manifold pressure of 
less than the indicated maximum.

Cause A: The furnace has malfunctioned.

Action A: Refer to Chapter 9, Troubleshooting and Maintenance, to diagnose 
the malfunction and correct it, or contact your service representative.

Cause B: The pressure within the cooling line is too low.

Action B: Increase the pressure of the cooling gas to between 10 and 20 psi.
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6238- Furnace is not in the raised position. This is not the recommended operating 
configuration. Do you wish to proceed with the analysis?

6248- The selected task is currently executing. It may not be changed or deleted at 
this time.

6249- The sample file (number) is already present in the sequence.

Cause: The elevator holding the furnace is not in the fully raised position. 
Unless a custom furnace or Dewar is being used, it is not the correct 
operating position.

Action: Select No to stop the analysis initialization; then correctly position the 
furnace. Select Yes if you are using custom equipment and are certain 
it is installed correctly.

Cause: You attempted to edit or delete a task which is currently in operation.

Action: None required for this task. For future reference, you must suspend the 
analysis to edit or delete a task.

Cause: You attempted to insert a sample file that is already in the sequence.

Action: Create or choose another file.
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6500 Series

6500- Failed to evacuate manifold to VAC SET in (number of) seconds. Calibration 
canceled.

6501- The 1000 mmHg transducer offset exceeds recommended limits:  %8.4f

6502- The 10 mmHg transducer offset exceeds recommended limits:  %8.5f

Cause A: The vacuum set point is set too low.

Action A: Reset VAC SET point to 5.0 mmHg. If the VAC SET point is already at 
5.0 mmHg or above, the vacuum gauge may need servicing.

Cause B: Leak in manifold.

Action B: Locate the leak and repair it. Refer to Chapter 9, Troubleshooting 
and Maintenance. Restart calibration.

Cause C: Valve failure.

Action C: Identify the leaking valve. Contact your service representative.

Cause: The Pressure Gauge Calibration operation showed the transducer offset 
exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message 
occurs again contact a Micromeritics service representative.

Cause: The Pressure Gauge Calibration operation showed the transducer offset 
exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message 
occurs again contact a Micromeritics service representative.
202-42808-01 (Rev E) - Oct 2015                                                      B-31 



ASAP 2020  Chemi Appendix B
6503- The 1 mmHg transducer offset exceeds recommended limits:  %8.6f

6504- Unable to write the calibration file (name).

6505- Unable to read the calibration file (name).

6506- Calibration file for (file name) is invalid.

6509- The sample has an invalid status and cannot be used for degassing.

Cause: The Pressure Gauge Calibration operation showed the transducer offset 
exceeds the recommended limit.

Action: Repeat the Pressure Gauge Calibration operation, if this message 
occurs again contact a Micromeritics service representative.

Cause: A Save to File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists contact a Micromeritics service representative.

Cause: A Load from File operation failed.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk).  If the problem per-
sists contact a Micromeritics service representative.

Cause: A Load From File operation failed due to invalid information in the 
file.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk).  If the problem per-
sists contact a Micromeritics service representative.

Cause: A file selected for degassing has a status other then No Analysis or 
Prepared.

Action: Select a different file.
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6510- Error evacuating.

6511- Error dosing.

6512- Error calibrating the servo.

6513- Error waiting for pressure to drop.

6514- Problem encountered dosing to target [PR2] [PR-U], last pressure = [PR4] [PR-
U], elapsed time = [0]:[0].

Cause: An evacuation error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: A dosing error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: An error occurred while calibrating the servo valve.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: A pressure error occurred during a degas operation.

Action: If the problem persists, contact a Micromeritics service representative.

Cause: Dosing during an analysis did not come within the allowed range of the 
target.

Action: Check that the outlet stage of the gas regulator is within specification. 
If the problem occurs frequently contact a Micromeritics service rep-
resentative.
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6515- The furnace reports an error. Sample temperature control during an analysis 
will not be possible.

6516- (Unit [number]) Analysis canceled: Sample pressure greater than (pressure) 
mmHg is not allowed.

6517- (Unit [number]) Analysis canceled: Total volume dosed greater than (volume) 
cm3 is not allowed.

Cause: An error occurred while the system was setting the target temperature 
of the furnace. The software will not be able to control the sample tem-
perature.

Action: The furnace controller has malfunctioned. An error code of one (1) 
indicates that the furnace controller is not responding to any com-
mands. An error code of two (2) implies that the furnace controller is 
responding but the responses are garbled. Contact your service repre-
sentative.

Cause: An absolute pressure greater than (pressure) mmHg was attained dur-
ing Low pressure dosing (either fixed dose mode or incremental dose 
mode).

Action: The analysis was canceled. All previously collected data were stored.

Cause A: More than (volume) cm3 has been dosed onto the sample, possibly due 
to leaks in the system.

Action A: Perform leak checks on the system. Refer to Appendix F, Testing for 
Leaks.

Cause B: The amount of sample you used may be too large. Multiply the max-
imum value from the Volume Adsorbed column of the Isotherm Report 
by the sample weight. If the result exceeds (volume) cm3, the amount 
of sample is too large.

Action B: Reduce the amount of sample.
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6518- (Unit [number]) Analysis canceled: Pressure of (pressure point) mmHg exceeds 
the maximum manifold pressure of (pressure point) mmHg.

6520- Unit (number): Power failure detected.

6521- Transducer overrange detected.

Cause: An absolute pressure greater than (pressure) mmHg was attained that 
exceeded the specified maximum manifold pressure. 

Action: The analysis was canceled. All previously collected data were stored. 
Change the maximum manifold pressure value in the Adsorptive Prop-
erties file.

Cause: A power failure occurred in the specified unit, and any analyses in 
progress were terminated.

Action: If the program was running and an Uninterruptible Power Supply 
(UPS) was attached, data points were collected and stored in the sam-
ple file. If enough data points were not collected, create another sample 
information file and start a new analysis.

Cause: The transducer in the specified unit has detected a pressure equal to or 
greater than 1000 mmHg. The exhaust port on the sample tube may be 
blocked.

Action A: Inspect for and clear any blockage.

Action B: Observe caution when operating the analyzer manually. If the problem 
persists contact a Micromeritics service representative.
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6522- Analysis canceled: Time limit exceeded while evacuating manifold. 

6523- Analysis canceled: Time limit exceeded while evacuating sample (unrestricted).

6524- Analysis canceled in task (number):  Time limit exceeded while evacuating 
sample (restricted).

Cause A: Maximum manifold evacuation time was exceeded before the vacuum 
set point was achieved. Vacuum pump may be turned off.

Action A: Turn on vacuum pump switch. Then restart the analysis.

Cause B: The vacuum pump oil level is low. 

Action B: Check the vacuum pump oil level and add more oil if necessary. Then 
restart the analysis.

Cause C: The manifold is contaminated or leaking.

Action C: Correct the problem. Refer to Appendix F, Testing for Leaks. Then 
restart the analysis.

Cause: The maximum time for evacuating the sample through the unrestricted 
valve was exceeded. Possible causes are a leak in the sample tube fit-
ting or a crack in the sample tube. 

Action: Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Then restart the analysis.

Cause: The maximum time allowed for evacuating the sample through the 
restricted valve was exceeded.

Action: Check the sample tube and the sample tube fitting to ensure that the 
tube is securely attached to the port. Verify that the sample is properly 
degassed. Then start the analysis again.
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6526- Time limit exceeded while backfilling manifold to [PR4] [PR-U] with (gas).

6527- Analysis suspended: Time limit exceeded while dosing manifold to (target 
pressure point) mmHg with (gas name).

6528- Low pressure gauge offset too high - [PR4] [PR-U].

6529- Master pressure gauge offset is too high - [PR1] [PR-U].

Cause A:  The maximum time was exceeded before the target pressure point was 
reached. The gas regulator may be set too low or turned off.

Action A:  Set the gas regulator to 10 psig (0.7 bar). Then resume the analysis.

Cause B: The gas bottle is empty.

Action B: Connect a new gas bottle. Then resume the analysis.

Cause A: The maximum time was exceeded before the target pressure point was 
reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to 10 psig (0.7 bar). Then resume the 
analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle. Then resume the analysis.

Cause: A check of the 1000 mmHg gauge’s offset during an automatic oper-
ation indicated it was too high.

Action: If this message occurs repeatedly, contact a Micromeritics service rep-
resentative.

Cause: A check of the 10 mmHg or 1 mmHg gauge’s offset during an auto-
matic operation indicated it was too high.

Action: If this message occurs repeatedly contact a Micromeritics service rep-
resentative.
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6530- Volume calibration canceled due to failure (code [0]).

6531- The gas configuration file for %s is invalid.

6532- The analyzer is currently running the 2020 Physisorption software. Do you want 
to reset it?

6533- The analyzer is currently running the 2020 Chemisorption software. Do you 
want to reset it?

6534- Instrument (unit number) is not calibrated.

Cause: A problem occurred during volume calibration.

Action: Contact a Micromeritics service representative.

Cause: The contents of the gas configuration file are not valid.

Action: Confirm there is sufficient free space on the media receiving the file 
and that the media is not corrupted (run ScanDisk). If the problem per-
sists, contact a Micromeritics service representative.

Cause: The analyzer is under the control of the 2020 Physisorption software.

Action: Selecting Yes will reset the analyzer and download the 2020 Chemi-
sorption control software.

Cause: The analyzer is under the control of the 2020 Chemisorption software.

Action: Click Yes to reset the analyzer and download the 2020 Physisorption  
software.

Click No to continue running the 2020 Chemisorption software.

Cause: Calibration information for various analyzer components are missing.

Action: Run the application setup program and reinstall calibration information 
for the specified unit.
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6535- Problem encountered evacuating.

6537- Error reading SmartVac ADC. 

6538- Power failure detected. The sample is in an unknown condition. A run termina-
tion will be performed for safety.

6539- Error overheating  Current = (no.), Target = (no.), Limit = (no.)

Cause: Evacuation during the manifold dosing operation did not come within 
the allowed range of the target.

Action: Check that the outlet stage of the gas regulator is within specification. 
If the problem occurs frequently, contact a Micromeritics service rep-
resentative.

Cause: There was a problem reading one of the signals on the SmartVac board.

Action: Exit the application, turn off the power switch on the analyzer, then 
turn the power back on. Restart the application and the degas opera-
tion. If the problem persists, contact your service representative.

Cause: A total power failure occurred (a UPS was not connected) while an 
analysis was in progress.

Action: Allow the analysis to terminate.

Cause A: The heating mantle is reporting a higher temperature than expected.

Action A: Ensure that the heating mantle and thermocouple cables are plugged in 
fully on the port(s).

Cause B: An internal failure of the degas system may have occurred.

Action B: Unplug the heating mantle power connector; do not unplug the ther-
mocouple. Allow the heating mantle to cool down (approximately 15-
30 minutes). Then exit the analysis program and turn off the analyzer. 
Wait a couple of minutes, then turn the instrument on and restart the 
program. If the problem recurs, contact your Micromeritics service 
representation.
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6540- Error thermocouple unplugged  Current = (no.), Target = (no.)

6541- Error: SmartVac is not in a valid state to check degas.

Cause: The heater was enabled, but the thermocouple was unplugged.

Action: Plug in the thermocouple and try again.

Cause: You clicked Check but the sample was not in an appropriate state. You 
can only check the degassing operation after the vacuum setpoint has 
been attained, or during a temperature ramp or hold.

Action: Wait until an appropriate time during the degassing operation, and 
check the degassing operation again.
B-40                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020  Chemi Appendix C
C.  CALCULATIONS

This appendix contains the calculations used in the ASAP 2020 Chemi program.

Free Space

Free-space volumes are calculated using the following equations:

where:

P1 = system manifold pressure before dosing helium onto sample (mmHg)
P2 = system manifold pressure after dosing helium onto sample (mmHg)
TSTD = standard temperature (273.13 K)
T1 = system manifold temperature before dosing helium onto sample (K)
T2 = system manifold temperature after raising Dewar and equilibrating with 

helium (K)
VLOW = lower manifold volume (cm3)

VFS = volume of free space (cm3 at standard temperature)

VFS

VLOW

T1

-------------
P1

P2

----- 1–× TSTD×=
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Volume Adsorbed

For the Ith dose:

where:

NgasI = total amount of gas dosed into sample tube after Ith dose (cm3 STP)

NadsI = amount of gas adsorbed after equilibrating Ith dose (cm3 STP)
PSTD = standard pressure (760 mmHg)

Psys1I = system manifold pressure before Ith dose of gas onto sample (mmHg)

Psys2I = system manifold pressure after Ith dose of gas onto sample (mmHg)

PsamI = sample pressure after equilibrating Ith dose of gas onto sample (mmHg)

Tsys1I = system manifold temperature before Ith dose of gas onto sample (K)

Tsys2I = system manifold temperature after Ith dose of gas onto sample (K)
Wsam = weight of sample (g) 
VI = amount of gas adsorbed per gram of sample (cm3/g STP) 

NgasI NgasI 1– VLOW

Psys1I

Tsys1I

----------------
Psys2I

Tsys2I

----------------–×
TSTD

PSTD

-----------×+=

NadsI NgasI Psam PSTD VFS×÷–=

VI

NadsI

Wsam
---------------=
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Equilibration

Equilibration is reached when the pressure change per equilibration time interval (first 
derivative) is less than 0.01% of the average pressure during the interval. Both the first 
derivative and average pressure are calculated using the Savitzky-Golay1 convolution method 
for polynomial functions. The equations below are those used to compute weighted average 
and first derivative, respectively, for the 6th point of an 11-point window.

where the numerical constants are from the Savitzky-Golay1 convolution arrays, and

PAVG = average pressure (mmHg)
PCHG = change in pressure (mmHg)

PI = Ith pressure reading taken at equilibrium intervals (mmHg)

After equilibration has been reached, if the user-entered minimum equilibration time from the 
Low Pressure Options dialog box has not elapsed, the equilibration continues until the entered 
time has elapsed.

If the user entered a non-zero maximum equilibration time from the Low Pressure Options 
dialog box, and this time period has elapsed before equilibration has been reached, the 
equilibration ends as if equilibration had been reached, and the point is collected.  

1. Savitzky, A. and Golay, M.J.E., Anal. Chem. 36, 1627 (1964).

PAVG

36 P11 P1+( )– 9 P10 P2+( ) 44 P9 P3+( ) 69 P8 P4+( ) 84 P7 P5+( ) 89 P6( )+ + + + +

429
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

PCHG

5 P11 P1–( ) 4 P10 P2–( ) 3 P9 P3–( ) 2 P8 P4–( ) P7 P5–( )+ + + +

110
-------------------------------------------------------------------------------------------------------------------------------------------------------------=

If a non-zero value that is too small is entered for the maximum equilibration time, 
the points are collected before equilibration is reached. 

 If PAVG is greater than 0.995 times the current Po, equilibration will not take place 
until the Minimum equilibration delay for P/Po 0.995  has expired, in addition to the 
standard equilibration criteria.
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Data Smoothing

Introduction

The data smoothing feature of the chemisorption program was developed to cope with noise 
and drift of pressure readings at very low pressures - usually at pressures well under 1 mmHg 
and very low gas volumes adsorbed. Data smoothing in the chemisorption program requires 
eleven points to satisfy the technique employed. However, most chemisorption analyses are 
performed with fewer than eleven points and at pressures higher than 1 mmHg, and so the 
data smoothing option is turned off by default. It may be enabled if required.

Technique

The analysis information consists of absolute pressure and volume adsorbed data pairs (P,V). 
In order to account for negative transducer shift, all coordinate pairs are scanned for points 
with pressures less than or equal to zero. If such points exist, then all pressure data are shifted 
by an amount large enough to convert the smallest pressure to a nominally small positive 
value.

After examination of the low pressure data is complete, the entire data set is subdivided into 
equally spaced intervals along the volume axis and corresponding pressures for these volumes 
are interpolated. The pressure data are smoothed by passing them through an eleven-point 
Blackman2 convolution array. Once the smoothing is complete, the volume adsorbed values 
from the original data set are used to interpolate back to the corresponding smoothed analysis 
pressures. This amended set of data, consisting of the original volume adsorbed values and 
the fully smoothed pressure values, forms the isotherm data from which all subsequent report 
data are based. Coefficients for the Blackman convolution array are given below.

PSMOOTHED = (0.0029918)PI-5 + (0.020005)PI-4 + (0.0618580)PI-3 +

(0.1250300)PI-2 + (0.1850900)PI-1 + (0.2100500)PI +

(0.1850900)PI+1+ (0.1250300)PI+2+ (0.061850)PI+3 +

(0.0200050)PI+4+ (0.0029918)PI+5

where

PSMOOTHED = Ith smoothed pressure 

PI      = pressure coordinate from the Ith equally spaced data point

Five data points are constructed on both the left and right ends to allow the filter to operate.

2. Blackman, R.B. and Tukey, J.S., “The Measurement of Power Spectra,” Dover (1958).
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Stoichiometry Factor

The calculated stoichiometry factor is a weighted average. It is dependent on both the indi-
vidual stoichiometry factor and number of moles of each active metal.

where

SFCALC = calculated stoichiometry factor 
SF1 = stoichiometry factor for first metal 
SF2 = stoichiometry factor for second metal 
SF3 = stoichiometry factor for third metal 
SFn = stoichiometry factor for nth metal 
%weight1 = % of sample weight for first metal 
%weight2 = % of sample weight for second metal 
%weight3 = % of sample weight for third metal 
%weightn = % of sample weight for nth metal 
WATOMIC1 = atomic weight of first metal (g/mole) 
WATOMIC2 = atomic weight of second metal (g/mole) 
WATOMIC3 = atomic weight of third metal (g/mole) 
WATOMICn = atomic weight of nth metal (g/mole)

SFCALC

%weight1 SF1×
WATOMIC1

----------------------------------------- %weight2 SF2×
WATOMIC2

----------------------------------------- %weight3 SF3×
WATOMIC3

----------------------------------------- … %weightn SFn×
WATOMICn

-----------------------------------------+ + + +

%weight1
WATOMIC1

------------------------ %weight2
WATOMIC2

------------------------ %weight3
WATOMIC3

------------------------ … %weightn
WATOMICn

------------------------+ + + +
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=
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Metal Dispersion

The metal dispersion is the percentage of the active metal available for interaction with the 
adsorbate.

where

%MDISP = metal dispersion (%) 
V = (cm3/g STP) If %MDISP is being calculated from analysis data, then V is  

the volume intercept derived from the best line fit of the points selected 
for line fit. If %MDISP is being calculated from difference data, then V  is 
VDIFF)  

SFCALC = calculated stoichiometry factor 
%weight1 = % of sample weight for first metal 
%weight2 = % of sample weight for second metal 
%weight3 = % of sample weight for third metal 
WATOMIC1 = atomic weight of first metal (g/mole) 
WATOMIC2 = atomic weight for second metal (g/mole) 
WATOMIC3 = atomic weight of third metal (g/mole) 
V = volume intercept derived from the best line fit to the volume differences 

between the selected points of the first analysis and the repeat analysis

*The volume one mole of gas occupies (cm3 STP/mole of gas)

%MDISP
100% 100%×

22414*
-----------------------------------

V SFCALC×
%weight1
WATOMIC1

------------------------ %weight2
WATOMIC2

------------------------ %weight3
WATOMIC3

------------------------+ +
----------------------------------------------------------------------------------------×=
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Metallic Surface Area

The metallic surface area per gram of sample is the total active metal surface area available 
for interaction with the adsorbate.

where

Msa = metallic surface area (m2/g sample) 
V = (cm3/g STP)) 

If Msa is being calculated from analysis data, then V is the volume 
intercept derived form the best line fit of the points selected for line fit by 
the user. If Msa is being calculated from difference data, then V is the 
average of the volume differences (VDIFF) for the points selected for line 
fit. 

AAREA = effective area of 1 active metal atom (m2/atom) 
SFCALC = calculated stoichiometry factor 
VDIFF = difference in volume between the first analysis and the  repeat analysis

*The volume one mole of gas occupies (cm3 STP/mole of gas)

Assuming that all species of metals disperse evenly, the metallic surface area per gram of 
metal is

where

Nsa = metallic surface area (m2/g metal) 
Msa = metallic surface area (m2/g sample) 
%weight1 = % of sample weight for first metal 
%weight2 = % of sample weight for second metal 
%weight3 = % of sample weight for third metal

Msa
6.023 1023×

22414*
------------------------------ V SFCALC AAREA×××=

Nsa Msa
100%

%weight1 %weight2 %weight3+ +
-------------------------------------------------------------------------------------⋅=
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Freundlich Isotherm

The Freundlich isotherm has the form:

where 

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
C = temperature-dependent constant
m = temperature-dependent constant

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Taking the log of both sides yields:

Q
QS

------ CP1/m=

Q QSCP1/m=

Qlog  QS C
1
m
----  Plog+log=
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Temkin Isotherm

The Temkin isotherm has the form,

where

Q = quantity of gas adsorbed
QS = quantity of gas in a monolayer
q0 = the differential heat of adsorption at zero surface coverage
A0 = a0 exp {-q0/RT}, where α0 and a0 are adjustable constants

In terms of quantity adsorbed,

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight 
line with slope RTQS/q0 and intercept (ln A0) RTQS/q0α.

Q
QS

------ RT
q0α
--------- A0P( )ln=

Q
RTQS

q0α
-------------- A0  

P
Po
------- 
 ln+ln=
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D.  FORMAT OF EXPORTED DATA

This appendix details the format and meaning of data in unreduced reports. Each record is ter-
minated by a carriage return and line feed. Character strings are delimited by double 
quotation marks.

Record position indicates the relative position of a record within a group. The different types 
of counter records indicate those sections of the file having a variable number of records; 
counter records specify the number of entries (types of information) contained in a table.

Record 
Position Information Conveyed Form

1 Sample ID quoted string
(50 characters)

2 Submitter ID quoted string
(40 characters)

3 Operator ID quoted string
(40 characters)

4 Bar code quoted string
(40 characters)

5 Sample mass floating point

6 Type of data
0 = Automatically collected
1 = Manually entered

integer

7* Count of data points integer

(Each entry for this counter appears on one line, 
separated with a comma.)

Pressure value
Elapsed time
Quantity dosed
Repeat Pressure value
Repeat Elapsed time
Repeat Volume dosed
Line fit flag

0 = no
1 = yes

floating point
integer
floating point
floating point
integer
floating point
integer

(All the repeat measurements are not valid if a pressure was 
skipped on the second analysis. Invalid entries have a zero value 
for the pressure, elapsed time, and volume dosed.)
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E.  DEFAULT FILES AND SYSTEM FILES

The following tables describe the default files provided with the ASAP 2020 Chemi software. 

Table E-1.  Default Sample Information Files

Table E-2.  Default Report Options Files

File Description

100.SMP ZSM-5 NH3 at 100 C

150.SMP ZSM-5 NH3 at 150 C

250.SMP ZSM-5 NH3 at 250 C

300.SMP ZSM-5 NH3 at 300 C

350.SMP ZSM-5 NH3 at 350 C

50.SMP ZSM-5 NH3 at 50 C

75.SMP ZSM-5 NH3 at 75 C

CO.SMP CO after H2

PTCO_08.SMP PTCO_08 - Pt. Alumina, Tube C1

SC0018.SMP Pt. Alumina, Fixed Dose CO

SC0019.SMP Pt. Alumina, Fixed Dose CO, 1st Run, No repeat

SC0020.SMP Pt. Alumina, Fixed Dose CO, 2nd Run, No repeat

SC0022.SMP Ag Method #3

SC0023.SMP Ag Method #3

SC0028.SMP Nickel Method 4

SC0036.SMP 0.5% pt p2 m2 un2 3rd run

SC0038.SMP 0.5% pt p2 m2 un2 1st run

File Description

FULL.RPO Full: includes Isotherm, Analysis, and Options.

PT_CO.RPO Report options for platinum-alumina sample.
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Table E-3.  Default Analysis Conditions Files

Table E-4.  Other Files Created by the ASAP 2020 Chemi Program

File Description

AG_O2.ANC Silver using oxygen.

NI_H2.ANC Nickel surface area using hydrogen.

PD_H2.ANC Palladium surface area using hydrogen.

PD_TITR.ANC Palladium surface area using hydrogen-oxygen titration.

PT_CO.ANC Platinum or palladium using carbon monoxide.

PT_H2.ANC Platinum surface area using hydrogen.

PT_TITR.ANC Platinum surface area using hydrogen-oxygen titration.

File Description

*ASAP202C.INI ASCII file containing initialization information used during pro-
gram startup as well as system options information.

*ASAP202C.SMP Binary file containing 2020 Chemi sample defaults.

GASDATA.MDB Material database containing the default Active Metals Table and 
the default Gas Table.

(serial number).SST Binary file containing 2020 Chemi instrument status information 
and calibration data.

Do not attempt to edit this file. Personal injury or 
damage to the ASAP 2020 could result because the 
operator may be given erroneous status information.

ASAP202C.LOG ASCII file containing a recorded log of all error messages displayed 
on the screen.

*(serial number).LOG Binary log file for analyzer with serial number contents acces-
sible using the Show Instrument Log option on the Unit menu.

*You should back up these files periodically to ensure data integrity. You may want to store 
each backup set on a separate media device so you have access to different versions of the 
files. For example, ASAP202C.SMP contains the default sample information. Any time the 
sample defaults are changed, an updated ASAP202C.SMP is created. Keeping version back-
ups of this file on a separate media device allows restoration of any version needed.
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F.  ATOMIC WEIGHTS AND CROSS-SECTIONAL 
AREAS FOR SELECTED METALS

Metal Symbol Atomic Weight
(g/mole)

Cross-Sectional 
Area

(sq nm)

Density
(g/mL)

chromium Cr 51.996 0.0635 7.19

cobalt Co 58.933 0.0662 8.9

copper Cu 63.546 0.0680 8.96

gold Au 196.967 0.08696 18.9

hafnium Hf 178.490 0.0862 13.3

iridium Ir 192.220 0.0769 22.4

iron Fe 55.847 0.0613 7.89

manganese Mn 54.938 0.0714 7.43

molybdenum Mo 95.940 0.0730 10.2

nickel Ni 58.710 0.0649 8.8

niobium Nb 92.906 0.0806 8.57

osmium Os 190.220 0.0629 22.6

palladium Pd 106.400 0.0787 12.0

platinum Pt 195.090 0.0800 21.4

rhenium Re 186.207 0.0649 21.0

rhodium Rh 102.906 0.0752 12.4

ruthenium Ru 101.070 0.0613 12.4

silver Ag 107.868 0.0869 10.5

tantalum Ta 180.947 0.0800 16.6

thorium Th 232.038 0.1350 11.7

tin Sn 118.710 0.1082 4.54

tungsten W 183.850 0.0741 19.3

vanadium V 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51
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G.  CHEMISORPTION METHODS

This appendix describes the preparation steps for standard methods of chemisorption. These 
procedures, which have been developed over a number of years, are recommended starting 
points for creating other methods. Methods 1 and 2 require a repeat analysis. Methods 3 and 4 
do not. 

For each of the methods, the recommended vacuum set point is 5 μmHg, and the recom-
mended temperature increase rate is 10 ºC per minute.

Samples are evacuated to the vacuum set point, and evacuation continues for the specified 
TIME.

FLOW (soak) = ramp up to the specified TEMPERATURE, and then continue flowing (soak-
ing) for the specified TIME.

TIME = total time below the vacuum set point that the sample spends at the specified TEM-
PERATURE or PRESSURE.

Method 1 Prepares the sample for carbon monoxide as the analysis gas. 
Procedure is given for platinum.

Method 2 Prepares the sample for hydrogen as the analysis gas. Procedures 
are given for platinum, palladium, and nickel.

Method 3 Prepares the sample for oxygen as the analysis gas: usually used 
with silver.

Method 4 Prepares the sample for hydrogen-oxygen titration. Procedures 
are given for platinum and palladium.
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Method 1 - Carbon Monoxide Analysis of Platinum

Preparation 

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-1.  Carbon Monoxide Analysis of Platinum

Analysis 

Gas: Carbon monoxide
Temperature: 35 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min

Free space: Measure
Incremental dosing: No
Line Fit: Enabled for all pressure points
Pressure table (mmHg): 200, 250, 300, 350, and 400

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Flow oxygen 100 5

3 Flow oxygen 10 350 30

4 Evacuate 350 15

5 Evacuate 10 100 15

6 Flow hydrogen 100 5

7 Flow hydrogen 10 350 120

8 Evacuate 350 30

9 Evacuate 10 35 30

10 Analysis 35
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Method 2 - Hydrogen Analysis 

Method 2 contains three subsets of instructions for hydrogen analysis. The metals analyzed are 
platinum, palladium, and nickel.

Platinum

Preparation 

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-2.  Hydrogen Analysis of Platinum

Analysis

Adsorptive: Hydrogen
Temperature: 35 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min*

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Flow oxygen 100 5

3 Flow oxygen 10 350 30

4 Evacuate 350 15

5 Evacuate 10 100 15

6 Flow hydrogen 100 5

7 Flow hydrogen 10 350 120

8 Evacuate 350 30

9 Evacuate 10 35 30

10 Analysis 35
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Free space: Measure
Incremental dosing: No
Line fit: Enabled for all pressure points
Pressure table (mmHg): 75, 110, 140, 170, and 200

*Experience may indicate the need for a longer evacuation time.
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Palladium

Preparation

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-3.  Hydrogen Analysis of Palladium

Analysis

Adsorptive: Hydrogen
Temperature: 100 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min

Free space: Measure
Incremental dosing: No
Line fit: Enabled for all pressure points
Pressure table (mmHg): 120, 155, 190, 225, and 260

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Flow oxygen 100 5

3 Flow oxygen 10 350 30

4 Evacuate 350 15

5 Evacuate 10 100 15

6 Flow hydrogen 100 5

7 Flow hydrogen 10 350 120

8 Evacuate 350 30

9 Evacuate 10 100 30

10 Analysis 100
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Nickel

Preparation 

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-4.  Hydrogen Analysis of Nickel

Analysis 

Adsorptive: Hydrogen
Temperature: 35 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min

Free space: Measure
Incremental dosing: No
Line fit: Enabled for all pressure points
Pressure table (mmHg): 100, 150, 200, 250, and 300

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Evacuate 10 450  5

3 Flow hydrogen  450 120

4 Evacuate 450  30

5 Evacuate 10  35  30

6 Analysis  35
G-6                                                    202-42808-01 (Rev E) - Oct 2015



ASAP 2020 Chemi Appendix G
Method 3 - Oxygen Analysis of Silver

Preparation 

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-5.  Oxygen Analysis of Silver

Analysis 

Gas: Oxygen
Temperature: 170 ºC
Line fit: Enabled for all pressure points
Repeat analysis: No
Pressure table (mmHg): 40, 67, 93, and 120

Task 
Number

Action Temperature
(ºC)

Time*
(minutes)

1 Evacuate 100 30

2 Flow O2 100 10

3 Ramp temperature while flowing O2 170 10 º/min

4 Hold temperature while flowing O2 170 60

5 Evacuate 170 30

6 Flow H2 170 60

7 Evacuate temperature <10 mmHg 170 30

8 Analysis 170

*Time for evacuation is the number of minutes below set point at the specified temperature.
  Time for gas flow is the number of minutes at the specified temperature.
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Method 4 - Hydrogen-Oxygen Titration 

Method 4 contains two subsets of instructions for hydrogen-oxygen titration. The metals ana-
lyzed are platinum and palladium.

Platinum

Preparation

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-6.  Hydrogen-Oxygen Titration of Platinum

Analysis

Adsorptive: Hydrogen
Temperature: 35 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: No
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Flow oxygen 100 5

3 Flow oxygen 10 350 30

4 Evacuate 350 15

5 Evacuate 10 100 15

6 Flow hydrogen 100 5

7 Flow hydrogen 10 350 120

8 Evacuate 350 30

9 Evacuate 10   35 30

10 Flow oxygen   35 60

11 Evacuate   35 30

12 Analysis   35
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Free space: Measure
Incremental dosing: No
Line fit: Enabled for all pressure points
Pressure table (mmHg): 75, 110, 140, 170, and 200
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Palladium

Preparation 

Rate of temperature increase = 10 ºC per minute
Vacuum set point = 5 μmHg

Table G-7.  Hydrogen-Oxygen Titration of Palladium

Analysis 

Adsorptive: Hydrogen
Temperature: 35 ºC
Heat rate: n/a

Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg

Repeat analysis: No
Fast evacuation: No
Unrestricted evac pressure: 30 mmHg
Evacuation time: 30 min

Free space: Measure
Incremental dosing: No
Line fit: Enabled for all pressure points
Pressure table (mmHg) 120, 155, 190, 225, and 260

Task 
Number

Action Ramp Rate
(ºC/min)

Temperature
(ºC)

Time
(minutes)

1 Evacuate 10 100 30

2 Flow oxygen 100 5

3 Flow oxygen 10 350 30

4 Evacuate 350 15

5 Evacuate 10 100 15

6 Flow hydrogen 100 5

7 Flow hydrogen 10 350 120

8 Evacuate 350 30

9 Evacuate 10 100 30

10 Flow oxygen 100 60

11 Evacuate 100 30

12 Analysis 100
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H.  FLOWMETER CONVERSION FACTORS

The gas flowmeter on the front panel displays the gas flow rate for air in standard cubic centi-
meters per minute (sccm). You must divide the displayed gas flow rate by a conversion factor 
from the table below to obtain the actual flow rate for gases other than air.

Table H-1. Flowmeter Conversion Factors

Example: Oxygen is flowing through the meter at a displayed rate of 30 sccm (air). The 
actual flow rate is:

30 ÷ 1.05 = 28.6 sccm

Example: You require a helium flow rate of 40 sccm. In this case, multiply the required 
flow rate by the conversion factor as follows:

40 x 0.37 = 14.8 sccm (air) 

Adjust the gas flow until the gas flowmeter displays 14.8 sccm.

Gas Factor

Air 1.00

Argon 1.18

Butane 1.42

Carbon dioxide 1.23

Carbon monoxide 0.98

Cyclopropane 1.21

Ethane 1.02

Helium 0.37

Hydrogen 0.26

Isobutane 1.42

Methane (natural gas) 0.75

Neon 0.83

Nitrogen 0.98

Nitrous oxide 1.23

Oxygen 1.05

Propane 1.23

Sulfur hexafluoride 2.25
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I.  TESTING FOR LEAKS

Introduction

This appendix contains general instructions for testing the ASAP 2020 Chemi and the Smart-
Vac degasser (if installed) for leaks. If the analyzer successfully performs a blank tube analysis 
using nitrogen, you do not need to test for leaks. 

These procedures may be performed individually or sequentially. Record pressure readings on 
the Valve Test Data Sheet included at the end of this appendix. After you finish testing for 
leaks, replace any leaking valves.

You will need the following items to perform tests:

• Stopwatch
• Valve Test Data Sheet (included in this appendix)
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Testing Individual Valves

Analysis Valves

This procedure removes differential pressure from all valves in the analysis system and estab-
lishes that there are no leaks in the analysis system. It should be performed before testing for 
individual valves.

1. Ensure that the analyzer is idle.

2. Close the regulator outlet valve for each gas supply line to the analyzer.

3. Attach a clean, empty sample tube to the analysis port.

4. Select Unit > Show Instrument Schematic, then Unit > Enable Manual Control. (For 
clarity, this illustration shows only the valve portion of the schematic.) Table I-1 lists 
descriptions of the analysis valves.

5. Close all valves.

6. Open valve CV, then open valves C1, C2, C3, C4, C5, and C6.

7. Wait 30 minutes.

8. Close valves C1, C2, C3, C4, C5, C6, and CV.

9. Open valves CS, 5, 1, 2, and 7.

10. Open valve 9.

11. Evacuate the system to below 10 μmHg, then continue evacuation for 30 minutes.

Ensure that a Po tube is installed on the Po port and a plug is inserted into the vapor 
inlet.
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Table I-1. Analysis Valve Descriptions

Valve X

1. Close valves 1 and 7.

2. Take a pressure reading; record it as P1 for valve X.

3. Wait 10 minutes and take another pressure reading; record it as P2 for valve X.

4. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve X. This value should be less than 0.5 μmHg/min.

Valve Description

1 Unrestricted vacuum

2 Restricted vacuum

3 Helium inlet port

4 Restricted analysis gas

5 Unrestricted analysis gas

7 Lower manifold isolation

9 Sample port

CV Vacuum valve, allows evacuation of chemisorption 
gas inlet manifold

CS Supply valve, supplies gas to manifold for 
chemisorption operation 

C1 through C6 Gas inlet port valves for chemisorption operation

X Exhaust from sample tube to gas flow meter, 
located at sample port above furnace

PV Vacuum valve, allows evacuation of physisorption 
gas inlet manifold

PS Supply valve, supplies gas to manifold for 
physisorption operation 

P1 through P6 Gas inlet port valves for physisorption operation
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Valve 9

1. Close valve 9.

2. Open valve X.

3. Take a pressure reading; store it as P1 for valve 9.

4. Wait 10 minutes and take another pressure reading; record it as P2 for valve 9.

5. Subtract P1 from P2 and divide the difference by 10; record the value as the 1st 
outgassing rate for valve 9. This value should be less than 0.5 μmHg/min.

Chemi Gas Inlet Manifold

1. Open valves 1, 2, 5, 7, CS, and CV.

2. Evacuate to below 10 μmHg, then allow evacuation for 15 minutes.

3. Close valves 1, 2, and CV.

4. Take a pressure reading; record it as P1 for the chemi gas inlet manifold.

5. Wait 10 minutes and take another pressure reading; record it as P2 for the chemi gas inlet 
manifold.

6. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for the chemi gas inlet manifold. This value should be less than 10 μmHg/min.

Valves C1 through C6

1. Open the regulator outlet valve for the gas connected to port C1.

2. Take a pressure reading; record it as P1 for valve C1.

3. Wait 10 minutes and take another pressure reading; record it as P2 for valve C1.

4. Subtract P1 from P2 and divide the difference by 10; record this value as the outgassing 
rate for valve C1. This value should be less than 0.7 μmHg/min.

5. Repeat Steps 1 through 4 for each gas inlet port (C2 through C6) to which a gas is 
attached. Record the values on the Valve Test Data Worksheet in the spaces provided.

6. Close valves 5 and CS.

7. Open valves 1 and 2.

Leak testing for physisorption-related valves and the degas manifold are explained in 
Appendix D of the ASAP 2020 physisorption operator’s manual.
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Valve Test Data Sheet

Make a copy of this form to record pressure readings and outgassing rates when leak-testing 
system valves. 

VALVE(s) P1
(1st pressure reading)

P2
(2nd pressure reading)

OUTGASSING RATE

Analysis Valves

X

9

Chemi Gas Inlet 
Manifold

C1

C2

C3

C4

C5

C6
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repeat, 5-22
sequence, 4-25
single, 4-24
temperature, 5-21
termination, 5-14

Analysis conditions files, 5-13
creating, 4-9
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Analysis report, 5-32
example of, 7-21

Analysis Sequence command, 6-7
Analysis tasks, 5-14

Analysis, 5-21
Evacuation, 5-16
Flow, 5-18
Leak test, 5-19
selected, 5-14
Soak, 5-20

Analyzer
adding another, 2-21

changing setup, 2-26
cleaning, 9-6
moving from one PC to another, 2-22
removing, 2-25
turning on and off, 2-14

ASCII format, 5-42
Atomic cross-sectional area, 5-29

for metals, F-1
Atomic weight, 5-29

for metals, F-1
Autoscale, 5-33

onscreen graphs, 7-15
Axis

coordinates, viewing, 7-18
properties, editing, 7-16

Axis range, 5-31, 5-33

B
Backfill gas, 5-7, 5-14

evacuation, 5-16
Basic format, 8-4

creating sample information files, 4-5, 5-8
specifying default values, 4-1, 8-6

Blue words, defined, 1-1

C
Cables, connecting, 2-10
Calculations, C-1

equilibration, C-3
Freundlich isotherm, C-8
Temkin isotherm, C-9
volume adsorbed, C-2

Calibrate Manifold Temperature dialog, 9-16
Calibratio

files, reinstalling, 2-27
Calibration

temperature, 9-16
Caution, defined, 1-1
Chemisorption methods, G-1

carbon monoxide analysis of platinum, G-2
hydrogen analysis of nickel, G-6
hydrogen analysis of palladium, G-5
hydrogen analysis of platinum, G-3
hydrogen-oxygen titration of palladium, G-10
Hydrogen-oxygen titration of platinum, G-8
oxygen analysis of silver, G-7

Circuit breaker, valve, 9-1
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Cleaning
analyzer, 9-6
sample tubes, 4-13

Clear button, 5-24
Close Reports command, 7-5
Cold trap, 1-2, 3-4

tubes, cleaning, 9-17
tubes, installing, 2-10

Collected Data dialog, 5-40
Columns, editing on onscreen reports, 7-13
Comments window, using, 8-11
Computer

power input, 2-6
requirements, 1-6

Configuration, system, 6-19
Conventions

file name, 3-10
operator manual, 1-1

Creating
Analysis conditions files, 4-9, 5-13
Degas conditions files, 4-8, 5-11
Report options files, 4-11, 5-26
Sample information files, 4-5, 5-5

Cross hair, axis, 7-18
Cryogens, handling, 4-23
Curve, editing, 7-15

D
Damaged equipment, 2-1
Data

automatically collected, 5-40
choosing type, 8-11
copying, 7-17
isotherm, exporting, 5-42
manually entered, 5-15, 5-40
selecting display options, 8-15

Date Range push button, 5-4
Default files

analysis conditions, E-2
report options, E-1
sample information, E-1

Degas command, 6-25
Degas conditions files, 5-11

creating, 4-8
listing statistics, 4-27
specifying defaults for, 4-3

Degas system
port connectors, 3-3
replacing port filter, 9-5

Degassing sample, 4-18
Delete button, 5-24
Destination, 5-41
Dewar

cold trap, installing, 4-22
precautions, 4-22

Diagnostics command, 6-21
Directories, 4-5
Dose

amount, 5-24
delay, 5-25

E
Electrical requirements, 1-6
Elevator, 1-2

raising and lowering, 6-12
Enable Manual Control command, 6-10
Entered Data dialog, 5-40
Equilibration

calculations, C-3
interval, 5-21

Equipment
damage and loss, 2-1
description, 1-2
returns, 2-2

Error messages, B-1
2200 and 2400 Series, B-1
2500 series, B-13
4000 series, B-19
6200 series, B-23
6500 series, B-31

Evacuation, 5-16
backfill gas, 5-16
heat rate, 5-17
task, 5-16
temperature, 5-17
time, 5-17, 5-23

Exiting the analysis program, 3-8
Export command, 5-42
Export data, 4-28, 5-42

format used, D-1

F
Fast evacuation, 5-16, 5-22
File

listing statistics, 3-8
opening, 3-8
printing to, 7-3
See also Sample information file

File menu, 5-1
Export command, 5-42
List command, 5-41
Open command, 5-3

File name, 3-10
included as part of file description, 8-7, 8-10

Flow
Index-2                                                                                                                                                                                     202-42808-01 
(Rev E) - Oct 2015



ASAP 2020 Chemi                                                                                                                 Index
gas, 5-18
temperature, 5-18
time, 5-18

Flow Task Options dialog, 5-18
Flowmeter conversion factors, H-1
Forms, A-1
Free space, 5-25

calculations, C-1
estimated, 5-25
gas, 1-6
measurement, 5-25

Freundlich report, 5-35
calculations, C-8
example of, 7-23

Furnace
analysis, 1-2
attaching, 2-9
cooling, 3-2
raising and lowering, 6-12
thermocouple connector, 3-2

G
Gas

backfill, 5-7
bottles, 1-2
defaults, 8-14
flow meter, 3-2
outlet pressure, 2-12
regulators, 2-11
requirements, 1-2, 1-6

Gas Table Defaults dialog, 8-14
Graph

copying, 7-17
editing onscreen, 7-15
grid lines, 8-15
legend, editing, 7-16

Graph Grid Lines command, 8-15
Graph Grid Lines dialog, 8-15
Graph overlay, 5-27

using, 4-29
Graphic, showing in report header, 5-27
Grid lines, 8-15

H
Heat of Adsorption report, 7-6
Heating mantle connector, 3-3
Heating mantle, installing, 4-19
High vacuum pump, 3-3

indicators, 3-4
specifications, 1-4

Histogram, editing, 7-16

I
Insert button, 5-24
Instrument log, showing, 6-16
Isosteric heat of adsorption, 7-6
Isotherm data, 5-42

exporting, 4-28
Isotherm report, 5-30

example of, 7-20

L
Langmuir report, 5-34

example of, 7-22
Leak test, 5-19

blank tube analysis (nitrogen), I-1
data sheet for recording values, I-5
heat rate, 5-19
task options, 5-19
temperature, 5-19
Valves P1 through P6, I-3, I-4
Valves PS, 5, and 7, I-4

Legend, reports, 7-16
Line voltage selection, 2-6
Links, 1-1
List command, 5-41
Log report, 6-16
Logo, displaying in report header, 5-27
Lost equipment, 2-1
Low pressure button, 5-24
Low Pressure Options dialog, 5-24

M
Main menu, 3-11
Manifold temperature

calibrating, 9-16
calibration statistics, 6-18
reading on schematic, 6-13
transducer, 1-5

Manual control, 6-10
Manually entered data, 5-15
Minimum pressure, 5-20
Monolayer capacity, 5-35

N
Nickel, hydrogen analysis, G-6
Note, defined, 1-1

O
Oil vapor trap, 2-3

replacing alumina, 9-11
Onscreen report, 7-9
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editing, 7-13
See also  Report

Open command, 5-3
Open Report command, 7-5
Open Sample Information File dialog box, 4-5, 4-6
Operator, specifying, 8-10
Operator’s manual

conventions, 1-1
Option presentation

Advanced format, 8-3
Basic format, 8-4
Restricted format, 8-5

Option Presentation command, 8-3
Options menu, 8-1

Active Metals Defaults command, 8-12
Gas Defaults command, 8-14
Graph Grid Lines command, 8-15
Option Presentation command, 8-3
Parameter Files Directory command, 8-16
Sample Defaults command, 8-6
Service Test command, 8-16
Service Test Mode command, 8-16
Units command, 8-15

Options report, 5-39
example of, 7-25

Ordering information, 10-1
Outgas rate, 5-19
Overlay samples check box, 5-30, 5-34

P
Palladium

hydrogen analysis, G-5
hydrogen-oxygen titration, G-10

Parameter File Directory Selection dialog, 8-16
Parameter files, 5-5

creating, 4-8
directory, 8-16
listing file statistics, 4-27
specifying default values for, 4-3, 8-9

Parts, ordering, 10-1
Password

Restricted format, 8-5
Service tests, 8-16

Percentage of sample weight, 5-29
Platinum

carbon monoxide analysis, G-2
hydrogen analysis, G-3
hydrogen-oxygen titration, G-8

Port filter
analysis port, 9-4
degas, 9-5
exhaust port, 9-5

Ports

analysis, 1-2
gas connection, 3-5
Sample preparation (degas), 1-2

Power
indicator, 3-1
switch, 3-6

Preparing samples, 4-13
Pressure

gas outlet, 2-12
measurement, 1-4

Pressure button, 5-23
Pressure table, 5-23
Preventive maintenance schedule, 9-3

R
Regulators, gas, 1-2
Removing an analyzer, 2-25
Repeat analysis, 5-22
Replace push button, 5-11, 5-13
Report after analysis, 6-4
Report Options dialog, 5-26
Report options files, 5-26

creating, 4-11, 5-26
listing statistics, 4-27
specifying defaults for, 4-3

Report Settings dialog, 6-4
Reports

analysis, 5-32
available, 4-12
closing, 3-8, 7-5
destination, 4-26
examples of, 7-19
Freundlich, 5-35
generating, 4-26, 7-2
graphs, editing onscreen, 7-15
header, 7-9
Heat of Adsorption, 7-6
isotherm, 5-30
legend, editing, 7-16
onscreen, 7-9
onscreen, shortcut menus for, 7-13
opening, 7-5
options, 5-39
Sample log, 5-39
saving in other formats, 7-12
starting, 3-8
Tabular, editing onscreen, 7-13
Temkin, 5-37
title, editing, 7-17
Tool bar, 7-10
types available, 5-28
zoom feature, 7-17

Reports menu, 7-1
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Close Reports command, 7-5
Heat of Adsorption, 7-6
Open report command, 7-5
Start Report command, 7-2

Reports to Generate dialog, 7-4
Restricted format, 8-5

creating sample information files, 4-5, 5-10
password, 8-5

Returned Materials Authorization (RMA), 2-2

S
Sample

degassing, 4-18
determining mass of, 4-16
mass, 5-7
monolayer capacity, 5-35
preparing, 4-13
transfer to analysis port, 4-21
weighing, 4-16

Sample Analysis command, 6-3
Sample Data Worksheet, A-1
Sample defaults, 8-6

specifying for Advanced format, 4-3, 8-9
specifying for Basic format, 4-1, 8-6

Sample information file, 5-5
creating, 4-5, 5-5
exporting isotherm data, 4-28
listing file statistics, 4-27
specifying default values for, 4-1

Sample Log report, 5-39
Sample thermocouple, 3-2, 6-18
Sample tube

cleaning, 4-13
temperature, 6-12

Saturation pressure port, 3-4
Schematic

accessing shortcut menus, 6-10
manual control, 6-10

Select X-axis scale, 5-30
Sequencing analyses, 4-25
Service, 9-3
Service Test command, 6-30
Service Test Mode command, 8-16
Setup program

adding an analyzer, 2-21
changing an analyzer setup, 2-26
moving an analyzer from one PC to another, 2-22
reinstalling analysis program, 2-20
reinstalling calibration files, 2-27
removing an analyzer from the computer, 2-25
uninstalling the analysis program, 2-28
using for other functions, 2-18

Shortcut keys

for instrument schematic, 6-10
Shortcut menu

accessing, 3-8
for graphs, 7-15
for tabular reports, 7-13

Show Instrument Log command, 6-16
Show Status command, 6-15
Silver, oxygen analysis, G-7
Soak

gas, 5-20
heat rate, 5-20
temperature, 5-20
time, 5-20

Soak Task Options dialog box, 5-20
Software

installing, 2-15
installing upgrade, 2-20
uninstalling, 2-28
version, 6-19

Specifications, 1-4
SmartVac degas system, 1-5

Start Degas command, 6-9
Start Report command, 7-2
Start Report dialog, 7-2
Statistics, listing file, 5-41
Status window

degassing operations, 6-27
for analyses, 6-15

Stoichiometry factor, 5-29
Submitter, specifying, 8-10
System

options, 8-1
turning on and off, 2-14
valves, 6-11

T
Target tolerance

absolute, 5-22
relative, 5-22

Tasks, 5-14
Analysis, 5-20
Evacuation, 5-16
Flow, 5-18
Leak test, 5-19
Soak, 5-20

Temkin report, 5-37
calculations, C-9
example of, 7-24

Temperature
calibrating, 9-16
Flow task, 5-18
Leak test, 5-19
manifold, 6-13
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sample tube, 6-12
Soak task, 5-20

Title Properties dialog, 7-17
Tool bar, reports window, 7-10
Transducers, 6-13
Transferring sample to analysis port, 4-21
Troubleshooting, 9-1

U
Unit Configuration command, 6-18
Unit menu, 6-1

Analysis Sequence command, 6-7
Degas command, 6-25
Diagnostics, 6-21
Enable Manual Control command, 6-10
Sample Analysis command, 6-3
Service Test command, 6-30
Show Instrument Log command, 6-16
Show Status command, 6-15
Start Degas command, 6-9
Unit Configuration command, 6-18

Units command, 8-15
Units Selections dialog, 8-15
Units, selecting, 8-15
Unrestricted evacuation pressure, 5-16, 5-22

V
Vacuum pump

changing or adding oil, 9-8
exhaust filter, replacing, 9-6
high, 3-3
inspecting oil level, 9-8
panel, 3-2
replacing alumina in oil vapor trap, 9-11
window, 3-2

Vacuum system, 1-4
Valves

failure, 9-1
Leak testing, I-1
system, 6-11
testing for leaks, I-1
X valve, 3-1

Volume adsorbed calculations, C-2
Volume calibration, 6-18

W
Warning, defined, 1-1
Weighing sample, 4-16

X
X-axis range, 5-31
X-valve, 3-1

Y
Y-axis range, 5-31

Z
Zoom feature, 7-17
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